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ABOUT THE GUIDE

This section provides a brief description of the scope, the audience, the references, concepts and the
organization of the user guide and conventions incorporated into the user guide. The topics in this section
are organized as follows:

. Scope of the Guide

. Intended Audience

. Documentation Accessibility

) Related Information Sources

° How This Guide is Organized

° Conventions Used

ScoPE OF THE GUIDE

The objective of this user guide is to provide a comprehensive working knowledge on Oracle Financial
Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack, Release
8.0.3.1.0. This user guide is intended to help you understand the key features and functionalities of
Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
(Oracle Financial Services Data Foundation (OFSDF) Interface with Lombard Risk for US FED) release
8.0.3 and details the process flow and methodologies used.

INTENDED AUDIENCE

Welcome to Release 8.0.3.1.0 of the Oracle Financial Services Regulatory Reporting for US Federal
Reserve — Lombard Risk Integration Pack User Guide.
This guide is intended for:

e Regulatory Reporting Analyst who bears the responsibility to verify and submit the results.
He/She is also entrusted to maintain the dimensional values across multiple reporting
requirements, maintain results area structure of Oracle Financial Services Data Foundation.

+ Data Analysts, who clean, validate, and import data into the Oracle Financial Services Download
Specification format, and ensure that data is populated in the relevant tables as per the
specifications and executions required for regulatory reporting.

e System Administrator (SA), instrumental in making the application secure and operational and
configures the user roles providing necessary access to users.

DOCUMENTATION ACCESSIBILITY

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website
at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
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ACCESS TO ORACLE SUPPORT

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

RELATED INFORMATION SOURCES

In addition to this user guide you can refer to the following documents in the OHC documentation library:

e Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk
Integration Pack Installation Manual Release 8.0.3.1.0

e Oracle Financial Services Data Foundation User Guide Release 8.0.3
¢ Oracle Financial Services Data Foundation Installation Manual Release 8.0.3

e Oracle Financial Services Analytical Applications Infrastructure User Guide Release 8.0.3
(present in this - OHC documentation libaray)

How THIS GUIDE IS ORGANIZED

The OFSDF Interface with Lombard Risk for US FED User Guide includes the following topics:

e Chapter 1: Introduction

e Chapter 2: Getting Started

e Chapter 3: Requlatory Reporting (REG REP) Solution Data Flow
e Chapter 4: OFSAA Features

e Chapter 5: Executing Run through Run Management
e Chapter 6: Integrating OFSAA Processing Applications with OFS REG REP USFED
e Chapter 6: Metadata Export Utility

e Chapter 7: Report Submission

e Chapter 8: Maintenance

e Chapter 9: Troubleshooting Guidelines

CONVENTIONS USED

Table 1 lists the conventions used in this guide.

Table 1: Conventions Used in this Guide

Convention | Meaning

Italics Names of books, chapters, and sections as references

Oracle Financial Services Software X
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Convention | Meaning

Bold ¢  Object of an action (menu names, field names, options, button names) in a
step-by-step procedure

¢ Commands typed at a prompt

e  User input

Monospace e Directories and subdirectories
¢ File names and extensions

e Process names

e Code sample, including keywords and variables within text
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1 Introduction

This chapter provides an understanding of the Oracle Financial Services Data Foundation (OFSDF)
Interface with Lombard Risk for US FED application and its scope. It includes:

e Overview

e OFSAA Regulatory Reporting Architecture
e Scope

1.1 Overview

Regulatory reporting and financial services have evolved to be an inseparable combination. It has
worsened since the 2008 financial crisis. Today, banks and financial institutions need to file hundreds of
regulatory reports. For the U.S. Federal Reserve alone, institutions must file multiple submissions of
FFIEC 101, call reports, stress testing reports, and so on. Reporting requirements increase rapidly in
number and complexity for banks operating regionally or globally, where they must file in multiple
jurisdictions.

The OFS REG REP US FED solution enables financial services organizations to manage and execute
regulatory reporting in a single integrated environment. It automates end-to-end processes from data
capture through submission with industry-leading solutions. It leverages Oracle Financial Services
Analytical Application (OFSAA) and Oracle Financial Services Data Foundation (OFSDF) for managing
analytical application data. The AgileREPORTER in Regulatory Reporting (REG REP) Solution enables
firms to automate the final mile of the reporting process. It provides pre-built integration to Lombard Risk
Reporting, eliminating the need for further manual intervention. The solution ensures data integrity
allowing banks to focus more time on analyzing and gaining new business insight from their growing
stores of data instead of preparing data and reports with the sole objective of meeting submission
deadlines.

1.2 OFSAA Regulatory Reporting Architecture

OFSAA . Enterprise

Data Sources Staging Reporting

Loans and
GL Data Leases
Off Balance
Account Data Sheet products Analytical Engines OFSAA Results
e ; q Management Reportin|
e ——— | Regulatory Capital Calculations 3 (2 8

X Derivatives ALLL, Fair Value, Economic Capital Customer Summary
Trading Data _ | Calculations

Capital Data | Stress Executions | Account Summary
Currency Data
Mgmt Ledger Transactions Summary

Master Data

OFSAA — Analytical Application Infrastructure

Figure 1: Regulatory Reporting (REG REP) Solution Architecture
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This interface connects the Oracle FSDF to Lombard Risk. As one can see in Architecture figure above,
Data flows from OFSAA to Lombard Risk.

OFSDF is an analytical data warehouse platform for the Financial Services industry. OFSDF combines an
industry data model for Financial Services along with a set of management and infrastructure tools that
allows Financial Services Institutions to develop, deploy, and operate analytical solutions spanning key
functional areas in Financial Services, including:

1. Enterprise Risk Management

2. Enterprise Performance Management

3. Customer Insight

4. Financial Crime and Compliance Management

OFSDF is a comprehensive data management platform that helps institutions to manage the analytical
data life cycle from sourcing to reporting and business intelligence/BI using a unified, consistent platform
and toolset.

AgQileREPORTER is a forms and workflow tool that enables both creation and submission of regulatory
returns. AgileREPORTER addresses the financial reporting requirements of both domestic and
international banks and financial institutions by automating compliance with mandated reports to central
banks, regulatory agencies. AgileREPORTER works easily with multiple sources of information as it
standardizes data elements and automates regulatory report production in prescribed templates with the
associated workflow for automatic submission. It is Reliable and efficient infrastructure to compile,
generate and submit regulatory reports. It collects data from a wide universe (not just OFSAA Results). It
provides automated repeated manual adjustments, variance analysis and validation checks. It provides
features to explain and justify a number quickly, including links to OBIEE.

The solution provides a pre-built interface or integration between FSDF and AgileREPORTER. With this
integration end user can automate end to end reporting process covering data preparation to last mile of
reporting.

1.3 Scope

Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
covers the following regulatory reports for specified release as mentioned in the table:

Table 2: Scope

Report Report Name Released Version
FR Y-9C Consolidated Financial Statements for Holding Companies 8.0.1
Financial Statements for a Bank Holding Company Subsidiary
FR Y-20 Engaged in Bank-Ineligible Securities Underwriting and Dealing 8.0.1
FR Y-15 Banking Organization Systemic Risk Report 8.0.1
FFIEC 009 Country Exposure Report 8.0.1
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Report Report Name Released Version

FFIEC 009 A Country Exposure Information Report 8.0.1
Financial Statements of U.S. Nonbank Subsidiaries of U.S.

FRY-11 Holding Companies 8.0.1
Abbreviated Financial Statements of U.S. Nonbank

FRY-11S Subsidiaries of U.S. Holding Companies 8.0.1
Financial Statements of Foreign Subsidiaries of U.S. Banking

FR 2314 Organizations 8.0.1
Abbreviated Financial Statements of Foreign Subsidiaries of U.S.

FR 2314 S Banking Organizations 8.0.1

FR Y-14A Capital Assessments and Stress Testing - Annual 8.0.1
Parent Company Only Financial Statements for Large Holding

FR Y-OLP Companies 8.0.1
Consolidated Reports of Condition and Income for a Bank with

FFIEC 031 Domestic and Foreign Offices 8.0.2
Consolidated Holding Company Report of Equity Investments in

FR Y-12 Nonfinancial Companies 8.0.1
Consolidated Reports of Condition and Income for a Bank with

FFIEC 041 Domestic Offices Only 8.0.3

FR 2052 A Complex Institution Liquidity Monitoring Report 8.0.3
Financial Statements of U.S. Nonbank Subsidiaries Held by

FR Y-7N Foreign Banking Organizations 8.0.3
Abbreviated Financial Statements of U.S. Nonbank Subsidiaries

FRY-7TN S Held by Foreign Banking Organizations 8.0.3
Weekly Report of Selected Assets and Liabilities of Domestically
Chartered Commercial Banks and U.S. Branches and Agencies of

FR 2644 Foreign Banks 8.0.3
Report of Transaction Accounts, Other Deposits, and Vault Cash

FR 2900 (Commercial Banks) 8.0.3

FR Y-14Q Schedule M.1 — Balances 8.0.3

FR Y-14Q Schedule K — Supplemental 8.0.3

FR Y-14Q Schedule A — Retail 8.0.3

FR Y-14Q Schedule H — Wholesale Risk 8.0.3

FR Y-14M Capital Assessments and Stress Testing Report - Monthly 8.0.3
Regulatory Capital Reporting for Institutions Subject to the

FFIEC 101 Advanced Capital Adequacy Framework 8.0.3
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The following table lists the detailed scope.

Table 3: Detailed Scope

SI. No. Report Code | Schedule Code Schedule Name
1 FR 2314 (F)ipg?ncigﬁsotr?;ements of Foreign Subsidiaries of U.S. Banking
2 FR 2314 Schedule IS Income Statement (calendar year-to-date)
3 FR 2314 Schedule IS-A Changes in Equity Capital
4 FR 2314 Schedule IS-B Changes in Allowance for Loan and Lease Losses
5 FR 2314 Schedule BS Balance Sheet
6 FR 2314 Schedule BS-A Loans and Lease Financing Receivables
7 FR 2314 Schedule BS-M Memoranda
8 FR 2314S GPg.r%\gaﬁggﬁon%r;cri“a;laSﬂt;tliments of Foreign Subsidiaries of
9 FR 2052A Complex Institution Liquidity Monitoring Report
Weekly Report of Selected Assets and Liabilities of Domestically
10 FR 2644 Chartered Commercial Banks and U.S. Branches and Agencies
of Foreign Banks
11 FR 2900 Report of Transaction Accounts, Other Deposits, and Vault Cash
12 FDIC 8020 Statement of Deposits
13 FR V-7N E?ra;?;ri]agiaall(tiirgeonrtsacr)]fizuatiso.nl\;onbank Subsidiaries Held by
14 FR Y-7N Schedule IS Income Statement
15 FRY-7N Schedule IS-A Changes in Equity Capital
16 FRY-7N Schedule IS-B Changes in Allowance for Loan and Lease Losses
17 FR Y-7N Schedule BS Balance Sheet
18 FRY-7N Schedule BS-A Loans and Lease Financing Receivables
19 FR Y-7N Schedule BS-M Memoranda
20| FRY-INS Held by Foreign Barking Organizatons.
21 FR Y-9C Consolidated Financial Statements for Holding Companies
22 FR Y-9C Schedule HI Consolidated Income Statement
23 FRY-9C Schedule HI-A Changes in Holding Company Equity Capital
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SI. No. Report Code | Schedule Code Schedule Name

20 |FRYaC | schedulenrs | SraeOfs md Recoieres on ome v Lessesand
o5 FR Y-9C Schedule HI-C E(i)sszzgezregated Data on the Allowance for Loan and Lease
26 FRY-9C Schedule HC Consolidated Balance Sheet

27 FRY-9C Schedule HC-B Securities

28 FR Y-9C Schedule HC-C Loans and Lease Financing Receivables

29 FR Y-9C Schedule HC-D Trading Assets and Liabilities

30 FR Y-9C Schedule HC-E Deposit Liabilities1

31 FRY-9C Schedule HC-F Other Assets

32 FRY-9C Schedule HC-G Other Liabilities

33 FRY-9C Schedule HC-H Interest Sensitivity

34 FR Y-9C Schedule HC-I g:ﬁw?$rgi_;§lat6d Underwriting Activities (Including

35 FRY-9C Schedule HC-K Quarterly Averages

36 FR Y-9C Schedule HC-L Derivatives and Off-Balance-Sheet Items

37 FR Y-9C Schedule HC-M Memoranda

38 FR Y-9C Schedule HC-N Past Due and Nonaccrual Loans, Leases, and Other Assets
39 FR Y-9C Schedule HC-P é—ﬁé;rclézmily Residential Mortgage Banking Activities in Domestic
40 FR Y-9C Schedule HC-Q gzz(ia;s and Liabilities Measured at Fair Value on a Recurring
41 FR Y-9C Schedule HC-R Regulatory Capital

42 FR Y-9C Schedule HC-S Servicing, Securitization, and Asset Sale Activities

43 FRY-9C Schedule HC-V Variable Interest Entities

44 FR Y-9LP E?)rnigggig?pany Only Financial Statements for Large Holding
45 FR Y-9LP Schedule PI Parent Company Only Income Statement

46 FR Y-9LP Schedule PI-A Cash Flow Statement

47 FR Y-9LP Schedule PC Parent Company Only Balance Sheet

48 FR Y-9LP Schedule PC-A Investments in Subsidiaries and Associated Companies

49 FR Y-9LP Schedule PC-B Memoranda

Oracle Financial Services Software

16




OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack

User Guide, Release 8.0.3.1.0

SI. No. Report Code | Schedule Code Schedule Name
Financial Statements of U.S. Nonbank Subsidiaries of U.S.

50 FRY-11 Holding Companies

51 FRY-11 Schedule IS Income Statement (calendar year-to-date)

52 FRY-11 Schedule IS-A Changes in Equity Capital

53 FRY-11 Schedule IS-B Changes in Allowance for Loan and Lease Losses

54 FR Y-11 Schedule BS Balance Sheet

55 FR Y-11 Schedule BS-A Loans and Lease Financing Receivables

56 FR Y-11 Schedule BS-M Memoranda

57 FR Y-11S Abbrewated_FmanuaI St_atements of U.S. Nonbank Subsidiaries
of U.S. Holding Companies
Consolidated Holding Company Report of Equity Investments in

58 FRY-12 i : .
Nonfinancial Companies

59 FR Y-12 Schedule A Type of Investments

60 FRY-12 Schedule B Type of Security

61 FRY-12 Schedule C Type of Entity within the Banking Organization

62 FRY-12 Schedule D Nonfinancial Investment Transactions During Reporting Period

63 FR Y-14A Capital Assessments and Stress Testing - Annual

64 FR Y-14M Capital Assessments and Stress Testing Report - Monthly

65 FR Y-14M Schedule A1 Domestic First I-_|en Closed-end 1-4 Family Residential Loan
Data Dictionary: Loan Level Table
Domestic First Lien Closed-end 1-4 Family Residential Loan

66 FRY-14M Schedule A2 Data Dictionary: Portfolio Level Table

67 FR Y-14M Schedule B.1 Domestic Home Equity Loan and Home Equity Line Data
Dictionary: Loan/Line Level Table

68 FR Y-14M Schedule B.2 Domestic Home Equity Loan and Home Equity Line Data
Dictionary: Portfolio Level Table

69 FR Y-14M Schedule C.1 Address Matching Loan Level Data Collection: Data Table

70 FR Y-14M Schedule D.1 Domestic Credit Card Data Collection Data Dictionary: Loan
Level Table

71 FR Y-14M Schedule D.2 Domestic Credit Card Data Collection Data Dictionary: Portfolio
Level Table

72 FR Y-14Q Schedule A.1 International Auto Loan

73 FR Y-14Q Schedule A.2 US Auto Loan
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SI. No. Report Code | Schedule Code Schedule Name
74 FR Y-14Q Schedule A.3 International Credit Card
75 FR Y-14Q Schedule A.4 International Home Equity
76 FR Y-14Q Schedule A5 International First Lien Mortgage
77 FR Y-14Q Schedule A.6 International Other Consumer Schedule
78 FR Y-14Q Schedule A.7 US Other Consumer
79 FR Y-14Q Schedule A.8 International Small Business
80 FR Y-14Q Schedule A.9 US Small Business
81 FR Y-14Q Schedule A.10 Student Loan
82 FR Y-14Q Schedule H Wholesale Risk
83 FR Y-14Q Schedule H.1 Corporate Loan Data Schedule
84 FR Y-14Q Schedule H.2 Commercial Real Estate Schedule
85 FR Y-14Q Schedule K Supplemental
86 FR Y-14Q Schedule M.1 Balances
87 FR Y-15 Banking Organization Systemic Risk Report
88 FR Y-15 Schedule A Size Indicator
89 FR Y-15 Schedule B Interconnectedness Indicators
90 FRY-15 Schedule C Substitutability Indicators
91 FRY-15 Schedule D Complexity Indicators
92 FRY-15 Schedule E Cross-Jurisdictional Activity Indicators
93 FRY-15 Schedule F Ancillary Indicators
94 FR Y-15 Schedule G Short-Term Wholesale Funding Indicator
95 FR Y-20 Financial _Statements _fo_r a Bank I-_|9Iding Comp_any Subsidiar_y
Engaged in Bank-Ineligible Securities Underwriting and Dealing
96 FFIEC 009 Country Exposure Report
97 FEIEC 009 Schedule C, Claims on an Immediate Risk Basis
Part |
98 FEIEC 009 ggtlteltljule C, Claims on an Ultimate Risk Basis and Memorandum Items
99 FFIEC 009 Schedule L Foreign-Office Liabilities
100 FFIEC 009 Schedule O Off-Balance-Sheet Items
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SI. No. Report Code | Schedule Code Schedule Name
101 FFIEC 009 Schedule D Claims from Positions in Derivative Contracts
102 FFIEC 009A Country Exposure Information Report
103 FEIEC 031 ggzqsgslit?:;enddi%?ggsn cgfﬁggslition and Income for a Bank with
104 FFIEC 031 Schedule RI Income Statement
105 FFIEC 031 Schedule RI-A Changes in Bank Equity Capital.
106 FEIEC 031 Schedule RI-B _Charge-offs and Recoveries on Loans and Leases and Changes
in Allowance for Loan and Lease Losses
107 FEIEC 031 Schedule RI-C Eéiigegregated Data on the Allowance for Loan and Lease
108 FFIEC 031 Schedule RI-D Income from Foreign Offices
109 FFIEC 031 Schedule RI-E Explanations
110 FFIEC 031 Schedule RC Balance Sheet
111 FFIEC 031 Schedule RC-A Cash and Balances Due from Depository Institutions
112 FFIEC 031 Schedule RC-B Securities
113 FEIEC 031 Schedule RC-C, Loans and Leases
Part |
114 FEIEC 031 Schedule RC-C, Loans to Small Businesses and Small Farms
Part Il
115 FFIEC 031 Schedule RC-D Trading Assets and Liabilities
116 FFIEC 031 Schedule RC-E Deposit Liabilities
117 FFIEC 031 Schedule RC-F Other Assets
118 FFIEC 031 Schedule RC-G Other Liabilities
119 FFIEC 031 Schedule RC-H Selected Balance Sheet Items for Domestic Offices
120 FFIEC 031 Schedule RC-I Assets and Liabilities of IBFs
121 FFIEC 031 Schedule RC-K Quarterly Averages
122 FFIEC 031 Schedule RC-L Derivatives and Off-Balance-Sheet Items
123 FFIEC 031 Schedule RC-M Memoranda
124 FFIEC 031 Schedule RC-N Past Due and Nonaccrual Loans, Leases, and Other Assets
125 FFIEC 031 Schedule RC-O Other Data for Deposit Insurance and FICO Assessments
126 FEIEC 031 Schedule RC-P (1)—ﬁ4ifclégmily Residential Mortgage Banking Activities in Domestic
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SI. No. Report Code | Schedule Code Schedule Name
127 FEIEC 031 Schedule RC-Q gzztiests and Liabilities Measured at Fair Value on a Recurring
128 FEIEC 031 g;rr]teldule RC-R, Regulatory Capital Components and Ratios
129 FEIEC 031 Schedule RC-R, Risk-Weighted Assets
Part Il
130 FFIEC 031 Schedule RC-S Servicing, Securitization, and Asset Sale Activities
131 FFIEC 031 Schedule RC-T Fiduciary and Related Services
132 FFIEC 031 Schedule RC-V Variable Interest Entities
133 FEIEC 041 ggnmsgslitciiftggi(l:?{eespgr;lsyof Condition and Income for a Bank with
134 FFIEC 041 Schedule RI Income Statement
135 FFIEC 041 Schedule RI-A Changes in Bank Equity Capital
137 FEIEC 041 Schedule RI-C E(i)sszgegéregated Data on the Allowance for Loan and Lease
138 FFIEC 041 Schedule RI-E Explanations
139 FFIEC 041 Schedule RC Balance Sheet
140 FFIEC 041 Schedule RC-A Cash and Balances Due from Depository Institutions
141 FFIEC 041 Schedule RC-B Securities
142 FFIEC 041 Schedule RC-C Loans and Lease Financing Receivables
143 FFIEC 041 Schedule RC-D Trading Assets and Liabilities
144 FFIEC 041 Schedule RC-E Deposit Liabilities
145 FFIEC 041 Schedule RC-F Other Assets
146 FFIEC 041 Schedule RC-G Other Liabilities
147 FFIEC 041 Schedule RC-K Quarterly Averages
148 FFIEC 041 Schedule RC-L Derivatives and Off-Balance-Sheet Items
149 FFIEC 041 Schedule RC-M Memoranda
150 FFIEC 041 Schedule RC-N Past Due and Nonaccrual Loans, Leases, and Other Assets
151 FFIEC 041 Schedule RC-O Other Data for Deposit Insurance and FICO Assessments
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SI. No. Report Code | Schedule Code Schedule Name

152 FEIEC 041 Schedule RC-P 1—4 Family Residential Mortgage Banking Activities in Domestic
Offices

153 FEIEC 041 Schedule RC-Q gzztiests and Liabilities Measured at Fair Value on a Recurring

154 FFIEC 041 Schedule RC-R Regulatory Capital

155 FFIEC 041 Schedule RC-S Servicing, Securitization, and Asset Sale Activities

156 FFIEC 041 Schedule RC-T Fiduciary and Related Services

157 FFIEC 041 Schedule RC-V Variable Interest Entities
Regulatory Capital Reporting for Institutions Subject to the

158 FFIEC 101 Advanced Capital Adequacy Framework
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2 Getting Started

This chapter provides an understanding of the pre-requsites, general and data preparation assumptions
and logging into the application. It includes:

e Prerequisites

e Assumptions
e Logging in to the OFSDF Interface with Lombard Risk for US FED

e QOrganization of the Interface for User Roles

e Metadata Browser

OFSDF interface with Lombard Risk for US FED allows you to perform the following activities:

e Manage Data Loading and Transformation from various source systems to staging, processing,
and results.

e Manage relevant OFSAA metadata for regulatory reporting purpose. This includes creating,
modifying, and viewing the metadata used in reporting.

¢ View the report metadata for mapping.
e Drill down from AgileREPORTER to OFSAA results area.

2.1 Prerequisites
The prerequisites are:

e Oracle Financial Services Analytical Applications Infrastructure (AAl) is deployed and configured.
¢ Oracle Financial Services Data Foundation is deployed and configured.
e Processed data required for reports as per the release scope.

e Ensure that the report templates for AgileREPORTER RPforFED_v1.6.1.6.zip is available in the
AgileREPORTER.

e Ensure that AgileREPORTER version 1.14 is installed.

¢ Knowledge of working with regulatory reports.

2.2 Assumptions

OFSDF interface with Lombard Risk for US FED is a reporting application and it does not perform any
risk/stress calculations. Following listed are the assumptions for the application:

e Textual and other related portions of reports like person details, contact details, Yes / No choices
must be updated on Report Portal directly and FSDF does not have placeholder for it.

e Data provided is post reconciliation to ensure that accuracy of data being reported (non-

prescribed by regulators) are performed in OFSAA using various components — General Ledger
(GL) reconciliation.
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e Validity checks such as edit checks, cross-validation checks and so on prescribed by regulator
are performed within the AgileREPORTER.

e All monetory amounts are expected to be positive in number, except valuation outputs which can
be positive or negative. Rules are constructed assuming the negative sign of valuation amounts
wherever applicable.

e The application populates few specific dimension tables, known as seeded / sample tables as
part of the installation script. Since they are used in the metadata, changes in data values have
impact on the overall functioning.

e All percentage data are expected in decimal format meaning 9% must be provided as 9 and not
0.09.

e For a data provided as of date, such as last day of the quarter of the reporting year: Quarterly and
Year to Date (YTD) report for the given date displays same value for those measures which are
of as of date in nature. For example, Annual and Quarterly Balance Sheet and BASEL reports
generated as of 31-MAR show same values for all measures such as Account Balance.

e Account Balances such as End of Period Balances are expected to be provided as Net of
(without) Unearned Income.

e In FR2052 A, for PIDs 1.0.9 and 0.0.22 there is no OOTB rule provided by OFSAA to identify
these PIDs. The accounts which must be reported under PIDs is purely Reporter’s Discretion. So
a Custom Rule can be built by the user to report these PIDs.

e Reporting currency identification in FR2052 A must be done by populating setup_master table, in
which V_COMPONENT_CODE = "ENTITY_REPORTING_CD' that is defaulted to ‘N’, must be
changed to ‘Y’ if the Reporting entity has greater than $700 billion in total consolidated assets and
greater than $10 trillion in assets under custody.

o Data load for FR Y-14M Report must include all the loans closed from the previous month.

2.3 Logging in to the OFSDF Interface with Lombard Risk for US FED

After the application is installed and configured, to access the OFSDF Interface with Lombard Risk for US
FED application you need to log into OFSAAI environment using the OFSAAI login page.

To access application follow these steps:
1. Enter the OFSAAI URL in your browser. The OFSAAI login page is displayed.
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ORACLE Firuncial Services Analytical Applications

Language Us-English v

User ID |

Password

[Logn | ORACLE
Version 8.0.1.0.0
Copyright @ 1993, 2015 Oracle andfor its affiiates. All rights reserved.

Figure 2: OFSAAI Log in

2. Select the desired language from the Language drop-down list.

3. Enter your User ID and Password. When you log into OFSAAI, the first screen is dsplayed.
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Figure 3: Landing Page
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2.4 Organization of Interface for User Roles

This section explains the various features used by a analyst. It describes the organization of the user
interface and provides step-by-step instructions for navigating through the application to carry out these
activities.

Data Analysts are expected to perform the following activities:
1. Marking Run as Final
2. Executing Batch to Refresh Derived Entities
3. Dirill Down from AgileREPORTER to OFSDF
Reporting Analyst are expected to perform the following activities:
1. Drill Down from AgileREPORTER to OFSDF
2. Using Metadata Browser to check Schedule Wise metadata

3. Using Metadata Browser to check metadata usage across schedules

2.4.1 Marking Run as Final

Various applications provide data for regulatory reporting. You must mark specific executions for
regulatory reporting as final run.

Bl v X v | usengishv | OFsAD ¥

ORACLE Financial Services Analytical Applications

Objest System Configuration & Identity My Inbox

Select Applications Financial Services Data Foundation » Run Management > Run Management

Financial Services Data Foundation

4 @ Financial Services Data Foundation
» B Data Model Management
» B 0ata Management Framework
» [E unifies naiytical Wetadata
» B Ruie Run Framework
4 B Run Management
B3 Run Management

» [ operations
» B settings

&8 Wetadata Browser

v

» Search
Segment FSDFSEG v

Run Type

l

4 List of Runs

No Records 1o Display.

S01t000f 0

| B & |

Figure 4: Run Management Summary Screen
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{2 Run Execution Summary - Windows Internet Explorer =) = =

Run Execution Summary
Run Neme US FED Runs Run ID 1485798454268
Run Type BASELINE RUN

BEECR B|® 1to1of1

FIC MIS DATE Execution Status Execution Date Time of Execution

08/30/2013 COMPLETE 08/13i2018 11:48:30 5454265 _Desaription

# Reporting Flag Details

Figure 5: Run Management Summary Screen

2.4.2 Executing Batch to Resave Derived Entities

To execute the batch to refresh derived entities, follow the below steps:
1. Navigate to Financial Services Data Foundation - Operations = Batch Execution

2. Select the batch <<INFODOM>> USFED_FFIEC031_RESAVEDE to resave all the DEs used in
FFIECO031.

3. Similarly “<<INFODOM>>_USFED_FR2314_RESAVEDE”,
“<<INFODOM>> USFED_ FRY11_RESAVEDE” can be used to resave DEs related to 2314,11
respectively.

Oracle Financial Services Software 26



OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack

User Guide, Release 8.0.3.1.0

Figure 6: Batch Maintenance Screen

4. Monitor status of the batch using Batch Monitor link.

5. The batches available for this release are:

a.

batch_resave_de_usfed_ffiec031

This batch saves the Derived Entities of FFIEC 031 report.
batch_resave_de usfed fr2314

This batch saves the Derived Entities of FR 2314 report.
batch_resave_de usfed fryll

This batch saves the Derived Entities of FR Y-11 report.
batch_resave_de_usfed fry2052a

This batch saves the Derived Entities of FR 2052A report.
batch_resave_de usfed fry2644

This batch saves the Derived Entities of FR 2644 report.
batch_resave_de_usfed_fry2900

This batch saves the Derived Entities of FR 2900 report.
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g. batch_resave de_usfed_fdic_8020

This batch saves the Derived Entities of FDIC 8020 report.
h. batch_resave_de_usfed_ fry9C

This batch saves the Derived Entities of FR Y-9C report.
i. batch_resave_de_usfed fryl4m

This batch saves the Derived Entities of FR Y-14M report.
j- batch_resave_de_usfed fryl4q H1H2

This batch saves the Derived Entities of FR Y-14Q_H1H2 report.

2.4.3 Logging to AgileREPORTER to Retrieve the Returns

The Retrieve Return functionality in AgileREPORTER fetches data from OFSAA derived entities and
embeds them on AgileREPORTER templates. This runs the decision table process in Lombard Risk. You
can view the relevant OFSAA data on various schedules of the AgileREPORTER using this functionality.

Lombard Risk Dashboard XBRL Checker hi rpadmin #* @
Show Deleted Returns Delete Retum Log 1) Create Newr 3 Import adjustments Export To Regulator Format 4 Export ) Retrisve Reum
Regulator: WORKFLOW STATUS
ENTITY  RETURNS VERSION REFERENCE DATE JOB STATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION ~ MODIFIED MODIFIED BY
US FED Reserve M LVXAE
us EFIEC031 4 3010972013 Q ) Update NO ATTESTATION NEEDED 120092016 11:2159  RPADMIN &l

Entity

5 us EFIEC041 4 30/09/2013 ® {3 Update  NO ATTESTATION NEEDED

14/09/2016 12:01:45  RPADMIN

[ 1]

us ERYSC 2 30/09/2013 (R) €y Update  NO ATTESTATION NEEDED 03/09/2016 11:41:04  RPADMIN

[ 1}

Form
1 15 v
Al M 1 . F
Retrieve Return
Available date Entity
Al :

Reference Date

Form

Log level
Normal

Figure 7: Retrieve Returns Page

2.4.4 Report Verification - Drill Down from AgileREPORTER to OFSAA Results Area

Drill down functionality enables the user to view the accounts included in the aggregation. Following these
steps to drill down from AgileREPORTER to OFSAA:

1. Loginto the AgileREPORTER.
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Lombard Risk

Automated regulatory compliance

Highly scalable for global volume processing capability enables AgieREPORTER to be extended for
other business units and geographies as business requirements evolve:

AgileREPORTER® [l

Usemame

Password

Lombard Risk

Figure 8: AgileREPORTER Login page

2. The user can view the list of reports in the main page. Click any report name in the Returns
column, for example, FRY9C.

Lombard Risk | Dashboard

Available date
Al v

ENTITY  RETURNS ¢

us EFIEC031

us EFIEG041

Reguiztor
US FED Reserve v
Entity
Us M
Us ERY9C
Form
Al v

Show Deleted Retumns Delete Return Log & Create New B3l import adjustments
WORKFLOW STATUS
VERSION &  REFERENCEDATE & JOB STATUS UPDATE  APPROVAL
LVXAE
4 30/09/2013 [r]@} {3 Update NO ATTESTATION NEEDED
4 30/09/2013 [r]@} {3 Update NO ATTESTATION NEEDED
2 30092013 Q0 {3 Undale NO ATTESTATION NEEDED

1 5 v

Job Manager XBRLChecker - himpadmin = 3% @

~ Export To Regulator Format ) Bxvort

Retrieve Retum

EDTIONS ~ TRANSMISSION ~ MODIFIED & MODIFIED BY %

12/09/2016 11:21:59  RPADMIN |
14/09/2016 12:01:45  RPADMIN |
08/09/2016 11:41:04  RPADMIN |

3. The schedule list is displayed in the

Schedule HC-E.

Figure 9: AgileREPORTER Main Page

left hand side. Click any schedule name, for example

A\ show Import Log

Include Current years P&L

Lombard Risk  FRYSC v2 USFEDReseve/US 30092013

~ Adjustments

Type "Yes" or "No” into the box below (defauit v

filg— eeeee e

No Atiestation Needed

~ ExportToFile = ExportToRegulatorFormat  gf) Live Validation | g Validate Now  ~ Workfow

Editions | 08/09/2016 11:41:04 #8 - (O i instances 1 -0

Show Scale a

Advanced Approaches.
Is the reporting institution an advanced
approaches institution?

{1 for Yes, 0 for No)

Exit Parallel Run

Has the reporting institution completed
parallel running?

(1for Yes, 0 for No)

Grandfathered unitary and insurance
SLHC

Is the reporting institution a grandfathered
unitary SLHC or insurance SLHC that is
not required to file HC-R?

(1 for Yes, 0 for No)

Special Rounding

institutions with 10 bin and more in assets
is enabled (1 for Yes. 0 for No)

Indicates if the special rounding for reporting

BHCs, SHC or covered SLHC

Is the reporting institution a BHCs, SHC or
covered SLHC as defined by the final capital rule?
(1 for Yes, 0 for No)

that are reported in item 24 during the transition

Any adjustments to additional tier 1 capital related to changes in the fair value of liabities

Bil T Mil | Thou

() Edtione

Pages

o
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o
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Cover

SchHI (1014
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Sch HI (3 of4
Sch HI (4 of4

SchHIA
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Notes to Income Stmt (1 of 3)
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Figure 10: AgileREPORTER Page Displaying List of Schedules
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4. Click any cell to drill down.

Show impont Log - Agsiments = Export To Fle ) Live Vi asdate Now * Wondow et Sources
3 & Export To A S akdaton &1 V N Wondh Retum S
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Figure 11: AgileREPORTER Schedule Details Page

5. Figure 12 displays drill down for the first cell in Column A. The OFSAA icon is displayed. It
provides information about the amounts against different MDRM codes here. In the figure, the
first MDRM code — BHCB 2210 indicates the amount of deposits held by the bank that are of non-
interest bearing variant. Click the cell, and the OFSAA icon, to view how this cell was populated

from OFSAA results. You are redirected to the OFSAA drill down page.

Edtions 11192015 131159
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o
a
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"
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Figure 12: AgileREPORTER Drill Down
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6. This cell is populated from the derived entity mentioned in the grid header DE — Deposit Liabilities
— Schedule HC-E. The value in the derived entity grid 333,220.00 must match with that of the cell
in the report. Derived entity is an aggregate built on top of OFSAA results model to serve

regulatory template requirements.

It is built using dimensions, measures and business

processors. The dimensions that participates in determining the cell value is displayed with data.
Click the derived entity link in the grid header.

Data Lineage

- Darived Entity ; Bl Deposi Lishilities - Schedule HG-L (1)

Figure 13: Data Trace Browser/ OFSAA Report Drill-down Screen

7. Derived entity details are displayed in the Metadata Browser within the page. Scroll to view
complete details such as Datasets, Hierarchies, Measures and so on. Click the measure value in
the derived entity row, for example 333,220.00.

Data Lineage

by BLo Beooail Labilities o Schedube HCOL 511

Deisls.  Foadaics o Trad
Darrved Enisty Properbes (3)
tare
el Typsh
Agrepase Fag
[CE R

Depends on (13) /3

Darived Eatity

Jamp o Page

Hisrunciry

Lon Dalacce BLY - Deocaiy
Bosvevenas

ERER Al

Figure 14: Derived Entity MDB View
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8. Double-click any figure in the screen to drill-down to the fact tables. The below grid displays the
detailed granular rows of fact data that comprises the derived entity aggregate. The number
333220 is now seggregated down to 10 records with different balances. Scroll to the right in
second grid to view measure values.
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v
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Hon Inteve s beanng dapowt Log lalince BOY - Degopds
Gegqraplry - Branch Counbng Degonis Type Hierarchy Degository spiiybogn Mag - DO§ Entty Typp Mevarghv
Higrprchy Borrowsngy
- o
p
©)
* Datasel:DE - Dgpopil Lisbilties - Schadyle HC-E (LL] ..
Band Short [ SOraien Ensay Typg e BNOLGY Banch D gCription Lgsl Enbity Cods: Broducs Mames EHM DE00S It VDE JERCNIN Esn Ligin DE R NpHON Band Surreoste Key Cphereyr (os
& Ba s 5. s e Basews
Back subsdanes - Demacd deposty. Daseire
Btk sutddanes 5 &V’ Seaiil e
Bach subddared L a STy Haweire
gl AT sy s
L% L - L Demand depoats e
T eatd Seponls Hawewre
i
Figure 15: Drill Down Page
9. Click Attribute Selector icon on the header of the second grid.
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Figure 16: Drill Down Attribute Selector 1
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10. Expand Data Origin Dimension and select Data Source name. Click OK.
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Figure 17: US FED Drill Down Attribute Selector 2

11. If account number is required, scroll and expand the account dimension. Select account
number/contract code and click OK. Data source and account / contract code is displayed in the
drill down grid.
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Figure 18: Drill Down - Granular
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2.5 Metadata Browser

This section helps you to navigate through Metadata Browser and guides you in tracing the source of the
metadata. The Metadata Browser function allows you to view and analyze all aspects of the metadata
used in the OFSAAL. It provides extensive browsing capabilities of metadata, helps in tracking the impact
of changes to metadata, and trace through to the source of originating data.

Metadata Browser (Object and Application View) provides common repository of metadata objects
created in OFSAAI and applications hosted in OFSAAI. Using this view, you can identify the usage of
base objects in higher level objects and the mapping of Objects to Application, thus enabling traceability.
It also allows you to view the data flow and the work flow of the application and understand the usage of
objects within the application.

The new visualization of Metadata Browser (MDB) supports Application view and Object view. In
Application view, you can browse through the metadata created using the applications hosted in OFSAAI.
In object view, you can view the metadata created in OFSAAI.

To access the Metadata Browser (Object and Application View), your role must be mapped to the
SCR_MDB function.

Analysts review the metadata used for a particular report schedule to verify the data. Data verification
may require looking for metadata used in given schedule or it can be schedules in which particular
metadata is used. Data Analysts and Reporting Analysts perform the report verification. Metadata refers
to business measures, hierarchies, data sets, derived entities used for a given schedule.

To use MDB for schedule wise metadata, and to use MDB for metadata wise schedule follow the below
steps.

1. To use MDB for schedule wise metadata, for a given schedule, identify the metadata used.

a) User can verify the data for related data elements in results using this information.
Navigate to path Objects 2 OFSAA Data Model 2 Reporting Metadata 2 Reports.
The Left Hand Side (LHS) displays the list of reports. For example, Figure 19 refers to
HC-E Schedule of FRY9C report.

Datads | Stasstcs | AustTrab

= Depends on (1)

aaaaaaaaa

s pudppooooooouoooooooo

i E

8

Figure 19: MDB - Reporting Metadata - Schedule View 1
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b) Click the object view FRY-9C-HC-E. The Report Details page is displayed.
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Figure 20: MDB - Reporting Metadata - Schedule View 2
You can view the below information in the Details tab:

e Reporting Elements: This section displays the line items in report with regulatory
references.
e Depends On: This section displays the metadata used in a given schedule.

c) Click any Reporting Element. For example, BHCB2210. The following page is displayed.
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Figure 21: MDB - Reporting Metadata - Schedule View 3

You can view the following information in this page:

e Reporting Element Properties: It provides information on line items or cell
references in regulatory reports.
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Table 4: Fields and their Descriptions in Reporting Element Properties

Fields

Description

Derived

Provides information on whether the cell is derived / computed using
other elements.

Confidentiality

Refers to regulator specific interpretation. For MDRM codes, it
indicates whether the MDRM codes is confidential for disclosure within
a specific report.

Notes

Refers to regulator specific interpretation. For MDRM codes, this field
provides a detailed description of a given cell reference.

Start Date

Refers to regulator specific interpretation. For MDRM codes, this field
refers to the effective date of particular cell reference in case.

End Date

Refers to regulator specific interpretation. For MDRM codes, this field
refers to the effective end/ sunset date of particular cell reference.

e Dimension Filters:

This section displays the dimensions and node value filters used

to derive a particular cell.

e Depends on: This section displays all the hierarchies (dimensions, filters) and
business measure used for arriving at a particular cell/ MDRM code.

Starting from a common metadata used across applicaiton, you may want to know the list of

reports/ derived entities this metadata has used. Let us take an example of measure. To use
MDB for metadata wise schedule, for each metadata, identify the schedules in which it is used.
Follow these steps to identify the schedules:

a) To view the measures,

navigate to path Objects 2 OFSAA Data Model = Business

Metadata = Measures. The LHS displays the list of measures. For example, Figure 22
refers to Eop Balance RCY - Deposits Borrowings.

CRACLE

Metadata Browser

Applications (0)

Measure

Jump 1o Page.

Rizporting Element
Rzperting Element

Figure 22:

MDB - Business Metadata - Measure View 1
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You can view the below information in this page:

e Measure Properties: It provides information on properties of Business measures.
For example aggregation function, Measure Data Type, Business Exclusions, Filter
and Rollup Type.

e Depends on: This section displays all the object names and their types, such as
Entities, Columns and so on.

Follow these steps to view the derived entities used in a given schedule:

Note: The similar steps as below are applicable for other metadata such as Business Metadata
(Hierarchies, Measures, Variables and so on) and Derived Metadata (Dimensions, Filters and so
on).

a) To view the schedule wise derived entities, navigate to path Objects 2 OFSAA Data
Model = Derived Metadata - Derived Entities. The LHS displays list of Schedules.
For example, Figure 23 displays the derived entities used in Schedule HC-E:

Metadata Browser Last Executed Date : 17-H0v-2015 120929 User: mdfuser Connected To : OFSFSDFNFD.

ORACLE

Derived Entity

Ootats  Statsics | Augn Trad
 Derived Entity Properties. {3} »

1 Jump 1o Page s
Onject Type
essure

Hierarchy

1 Jump to Page =

Raporting Element

Figure 23: MDB - Business Metadata - Measure View 2

You can view the following information in this page:

e Derived Entity Properties: It provides information on properties of derived entities,
such as Source Type, Aggregate Flag, and Materialized View.

e Depends on: This section displays all the object names and their types, such as
Measure, Hierarchy, and so on.
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3 Regulatory Reporting (REG REP) Solution Data Flow

This chapter provides an understanding of the data flow. It explains what happens within data flow and
how various processing aspects are integrated with the overall data flow.

It includes:

e Data Preparation

e Mapping of Results to Line Items in Reporting

e AgileREPORTER: Submission

3.1 Data Preparation

This section explains the input data preparation from OFSAA. It includes:

e Assumptions for Data Preparation

e Run/Execution Expectations

e Projection Data

e Data Flow from Sources Systems to Staging Area

e Data Flow from Staging to Results Area

e Data flow from Staging to Processing Area

e Data Flow From Processing to Results Area

e Dimension Tables/Entities

3.1.1 Assumptions for Data Preparation

1. REG REP is a reporting solution, which uses data from underlying fact tables directly for
reporting. The end user is expected to prepare the load for the required data in reporting area
accordingly. Although this has a thin processing layer to reclassify to regulatory dimensions and
bands, all the processing measures are expected to be from respective applications and provide
as required.

2. ltis integrated with results area of the respective processing application, and any change in the
underlying processing can disturb the REG REP data sourcing.

3. Baseline and stress data must be populated with appropriate codes. Inaccurate mappings may
can lead to inaccurate results. For details please refer to Relationship between Run and Stress.

4. For usage of consolidation dimension (which has values like Actual, Budged, Forecast, and so
on), all historical data is expected to be tagged as actual for the purpose of reporting vintage
data, as per report requirements. For projection data, for a given run and Projection Period
(quarter/year), only one set of data is expected to be stored.

5. All processing reporting requirements requiring cashflows, integration package expects bucketed
cash flow as a input (meaning a time bucket for cash flow and cash flow amount is expected as
input).
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3.1.2 US FED RUN CHART

Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
provides the US FED RUN Chart listing the tasks required for population of data for US FED Reports.
This covers the following tasks:

e Set up table population

e Stage Dimension Load

e Seeded Dimension Data Population

e Common data Population

e Common Tasks like Exchange Rate Population

e US FED Specific Data Population and Transformation
e Derived Entity Refresh

Download the US FED 8.0.3.1.0 RUN Chart from the MOS.

3.1.3 Run/Execution Expectations

Run refers to execution. It is assumed that at different time periods, different combination of parameters,
and different data require different executions. From a reporting perspective, as required by regulators,
RRDF application requires data for the following executions:
1. Current Data / Execution
a. Reporting month end data
b. Projection Data
2. Historical (trend/vintage) Data
a. Yearly
b. Quarterly
3. Stressed Data

3.1.3.1 Relationship between Run and Stress

The REG REP application for example in FRY 14 Annual, picks up reporting data based on the Reporting
Run that populates the underlying Fact Table(s). Reporting Run is a flag, which must be marked as "Y' in
a DIM_RUN table so that, the OBIEE reporting layer selects a particular run execution.

In this application, a Run comprises:

a. Baseline Run: The Bank Holding Company (BHC) may have multiple runs. The run used for
reporting is marked with a Reporting Flag = Y. This is the Baseline run for a given reporting
date. It is referred to as Baseline because the values that it represents are not stressed and the
BHC may use these base values for stressing them according to various scenarios. A history of
such runs accumulated over period of time provides historical runs. For more information on
updating the reporting flag, refer section Updating Reporting Flag.
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b. Stress Run: Stress runs hold data, which are stressed by a certain percentage/basis point over
the Baseline figures. The BHC expects these figures to reflect the business/risk position under
predetermined business scenarios/economic conditions.

c. Identification of Baseline and Stress run occurs from STRESS DIMENSION.

In this application, the required stress runs are tagged to a Baseline run. If the BHC performs several
stress runs, the relevant runs which are intended for reporting are identified and tagged with a reporting
Baseline run using the V_RUN_ID in the DIM_RUN.

DIM RUN stores n_run_skey / v_execution_id, which are execution specific for every run definition which
is v_run_id. Therefore, the run definition can remain constant over a period of time and different
executions provide different outputs due to underlying data changes.

DIM_STRESS conveys the stress definition. Additionally, it links the original run Definition (v_run_id) and
Stressed run ID (v_stressed_run_id). You must refer to the DIM_RUN table to get expected run execution
of these runs definitions pertaining to a particular date / n_mis_date_skey.

The same fact table stores both the Baseline data and the Stressed data, uniquely identified through
Scenario codes (and Run skeys).

Refer to the Business Metadata.xls present in the installer package for details on different Fact tables
used for related reports.

3.1.4 Projection Data

The following points provide information on the projection data:

1. Baseline run also populates projected date data.
2. This application requires projected data at two levels - Quarterly and Annual.

3. The DIM_CONSOLIDATION table is used to identify the projections. It contains the codes for
projected quarters and years as required by the templates.

4. In the Fact tables, projection data is referred with respective Consolidation codes (scenario code
for FCT_MGMT_REPORTING). BHC must populate the data accordingly.

5. In the following example, FQ1 means Financial Quarter 1, FY1 means Financial Year 1 and so on.

Table 5: Projection Data Example 1

CEmeelE e Consolidqtion Reporting Line Scenario EOP Balance
Code Description
100 Actual 100 BSL 426,367
400 FQ1 100 BSL 608,618
401 FQ2 100 BSL 870,502
402 FQ3 100 BSL 567,736
403 FQ4 100 BSL 846,196
404 FQ5 100 BSL 775,027
410 FY1 100 BSL 470,092
411 FY2 100 BSL 473,880
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Coueslivauen Consol!da_\tion Reporting Line Scenario EOP Balance
Code Description
412 FY3 100 BSL 942,034
413 FY4 100 BSL 497,889
414 FY5 100 BSL 807,813

Note:

For Movement measures data is not carried from one reporting period to another. For example,
Profit or Loss. Where General ledger balances such as loan outstanding are carried forward from
one year to another, profit and loss is period specific.

Therefore, unlike End of Period (EoP) balance, movement values for quarter actuals must be
derived for reporting. For a historical data, net sales for quarter 3 is the difference between sales
figure as of end of quarters 2 and 3. You do not need to provide this difference as a download.
Movement data for actual is identified through different runs and the respective values is summed
up.

Only those records, whose corresponding runs fall between the fiscal month start date and end
date of the reporting quarter are selected for summation. Each Run has an associated date, and
runs can be performed daily. Assuming that runs are performed daily in a given quarter (90 days),
REG REP sums up data points across all 90 days to arrive at a quarter end movement figure.

Table 6: Projection Data Example 2

Code Pr;)é(:,icc:)t:d ReE?nr;ing Scenario Run ID Date P'Ar‘?]i?)ztr?td Movement

100 Actual 100 BSL RUNID001 | 10-Oct-13 300,000
100 Actual 100 BSL RUNIDO002 15-Nov-13 100,000

900,000
100 Actual 100 BSL RUNIDO03 | 20-Nov-13 300,000
100 Actual 100 BSL RUNID004 | 30-Dec-13 200,000
400 FQ1 100 BSL - - -- 608,618
401 FQ2 100 BSL -- -- -- 870,503
402 FQ3 100 BSL -- -- -- 567,736
410 FY1 100 BSL -- -- -- 470,093
411 FY2 100 BSL - - - 473,881
412 FY3 100 BSL -- -- -- 942,035

¢ However, when projection of net sales for quarter 2 next year is to be performed, no derivation is
required. Projections data for said quarter can be directly downloaded in the respective Fact
table(s) for reporting.
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3.1.5 Data Flow from Source Systems to Staging Area

The staging area is populated with data from various data sources, such as GL data, Account data,
Customer data, Trading data, Currency data, and Master data. Refer to Data Integration Hub (DIH) User
Guide in OHC Documentation Library for details. DIH enables to load the data from the source systems to
the OFSAA staging tables, through logical interfaces, known as Application Data Interfaces (ADI). DIH
provides a set of User Interfaces (Ul), which is used to define and maintain External Data Descriptor
(EDD), Application Data Interfaces, and map the EDDs and ADIs through connectors.

3.1.6 Data Flow from Staging to Results Area

This section details the pass through data, transformed data and classification.

3.1.6.1 Pass Through Data

Pass through data refers to the static data that is pre-processed and flows to the results area directly. The
Common Staging Area (CSA) model represents the data entry point into the FSDF. CSA provides a
simplified, unified data sourcing area for inputs required by analytical applications and engines. It consists
of over 400 tables and nearly 9000 columns organized into distinct subjects.

The staging area is a physical data model, which is deployed using the Analytical Application
Infrastructure, which manages it. The design of the staging area data model is to allow efficient data
loading for analytics. It thus has crucial differences from a general-purpose repository of
operational/transactional data across a bank.

The staging area acts as the single source of data, and contains unified data requirements for various
banking areas such as Loans and Losses, Off balance Sheet products, Securities, Derivatives, Capital
Data, Management Ledger and General Ledger. Common example of this category includes various
monetary amounts, dates and so on.

3.1.6.2 Derived / Transformed Data and Reclassifications

OFSDF Interface with Lombard Risk for US FED requires specific hierachies and dates to be transformed
and reclassified to regulator specific values.

Table 7: Data Transformation Example

Source Hierarchy Target Hierarchy

ISSUER TYPE = | INSTRUMENT RISK FACTOR = | INSTRUMENT DIM REG INSTR

US GOVT/FED INTEREST RATE DERIVATIVE TYPE = | CLASSIFICAITON = US
SPOT GOVT SECURITIES

PROPERTY TYPE | LTV Ratio <2 DIM REG PRODUCT

= 1-4Units CLASSIFICAITON

For example, data from banks has attributes such as issuer type and bank instrument type. However,
these values are bank specific, and must be converted or reclassified to regulatory specific set of value
such as DIM REG INSTR CLASSIFICATION as mentioned above.
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Reporting derived entities use this reclassified dimensions. Some of the reclassifications are performed in

the resp

ective application area.

For example, DIM BASEL PRODUCT TYPE. This reclassification is performed in Basel application
processing and available for reporting directly.

Other transformations include various bands such as time to remaining maturity, time to next repricing

date, an

3.1.6.3

d so on.

Re-classified to Regulatory Classifications

After transformation, the regulatory data is reclassified as follows:

Table 8: Data Reclassification Example 1

Source

Target

DIM PROPERTY TYPE | LTV Band Ratio

DIM REG PROD CLASSIFICAITON

1TO4UNITS >2 1-4FAMCONLOAN

Table 9: Data Reclassification Example 2

FCT REG ACCOUNT SUMMARY

Account Number | REG PROD Classification Residual Maturity Band Delinquency Band

1-4FAMCONLOAN 1

3

The sample reclassifications performed to transform the existing hierarchies to regulatory specific
hierarchies are:

Regulatory Product Classification

Regulatory Instrument Classification

Regulatory Deposit Classification

Trading Account Book Type Classification

Claim Amount Population for Country Risk

Immediate Counterparty Classification for Country Risk
Claim Sector Reclassification for Country Risk

Risk Sector Reclassification for Country Risk

Cross Border Claim Reclassification for Country Risk
Guarantee Amount Population for Country Risk

The additional transformations that are performed are:

Remaining Time to Maturity Band
Next Repricing Date Band
Regulatory Delinquency Band
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Within reclassification rules, few rules where source is customer specific values. In such cases, these
rules must be validated and updated as required by end user because Out of Box rule may differ from
what end user has. Such rules are very few and restricted to:

1. Standard Product Type Reclassification

2. Standard Party Type Reclassification

3. Regulatory Loan Purpose Classification

Refer to Business Metadata for details of these reclassifications.

3.1.7 Data Flow from Staging to Processing Area

The staging area of the FSDF serves as a container for analytical processing from sourcing to
consumption. Such processing is usually delivered in the form of discrete units called analytical
applications, spanning different analytical use cases ranging from Finance to Risk to Compliance.

These applications consist of custom-built computational engines and numerical libraries, and can
execute processes on the data that range from simple aggregations to complex, multi-step stochastic
processes such as Monte-Carlo simulation.

Hence, analytical applications place varying demands on the data infrastructure in terms of volumes and
speed, and hence place different demands on the data architecture. In practice, the normalized (3NF)
design favored for enterprise data warehouses often fails to be efficient or performant when it comes to
analytical processing across a wide range of use cases.

Therefore, the OFSDF recognizes the need for distinct application-specific working stores, separate from
the staging and reporting area. For example, the OFSAA Asset and Liability Management (ALM)
application has a distinct set of ALM-specific tables, as does the Market Risk solution.

Note: The structure of these processing area stores is decided by the actual analytical application and
engine used. The OFSAA suite of applications is organized this way, with each application managing a
specific set of tables/schemas within the processing area.

The processing area tables/schemas are not part of the OFSDF. This is because OFSDF is intended to
be an open platform. Other analytical applications and engines can equally provision data out of OFSDF
by mapping their input requirements appropriately to the OFSDF staging area model.

3.1.8 Data Flow from Processing to Results Area

This step is similar to Data Flow from Staging to Results Area. It involves either pass through data from
processing to results or loading directly to results (refer Section 3.1.8). This is mostly due to processing
measures such as Fair Value, Risk Weighted Assets, and so on.
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3.1.9 Guidelines for Data Loading to Result Area Tables in Data Foundation for
Regulatory Reporting Implementations

Regulatory reports make use of data available across several fact tables in the OFSAA data foundation
model and these result tables are either loaded from the raw data sourced from source systems via out of
the box T2T’s or processed data output from various OFSAA applications.

For example, Fact LRM Account Summary (FCT_LRM_ACCOUNT_SUMMARY) which stores the liquidity
risk related attributes and metrics computed by OFSAA LRM application, Fact Loan Loss Forecasting and
Provision Account Summary (FCT_LLFP_ACCOUNT_SUMMARY) which stores the attributes and
measures computed by OFSAA LLFP application. However, there can be several implementation use
cases in the regulatory reporting space where customer may not have licensed any of OFSAA application
and hence must put additional custom effort to design an ETL process to load the required data elements
into the respective fact tables referenced by the report. The following section highlight some of the
guidelines that the customer can consider when designing a data flow for such a use case.

o Consistent Usage of Run Identifier

Most of the fact tables used in regulatory reporting are run enabled and have a composite primary
key inclusive of run identifier that enables same snapshot of data to be loaded multiple times into
the target fact table for any given execution date. All the out of the box processes that impact
data used in regulatory reports are executed as part of an integrated run to ensure that run
identifier is consistent across fact tables. Since the reporting is done on an integrated schema, it
is imperative for the custom data flow design to keep this integrity intact. This essentially means
that the custom ETL processes designed to load the data directly into the fact tables must be able
to leverage the run identifier generated by the run engine during execution. Run Identifier
information is available in DIM_RUN table.

e Correct Dimensional Lookup Configuration

Dimensional identifiers are typically part of referential integrity constraints with the fact table so
the custom ETL processes must ensure that lookups retrieve a valid surrogate keys for a given
value of business key. The intermediate staging structure must ensure all the business keys are
persisted correctly and the lookup condition is designed on the correct dimension table.

For example, FCT_LRM_ACCOUNT_SUMMARY.n_asset_level_skey >
DIM_ASSET_LEVEL.n_asset_level_skey. The business key (v_asset_level_code) must be
sourced and persisted to ensure correct values are populated in the target column, that is,
FCT_LRM_ACCOUNT_SUMMARY.n_asset_level_skey.

From OFSAA technical infrastructure standpoint, the mentioned options are available to the customer to
design and implement the custom ETL process explained above. OFSAA strongly recommends the below
options to maintain consistency in terms of data lineage in Metadata browser as the configured metadata
can be made available in meta model via MDB publish:

1) Data Integration Hub (DIH) Connectors
2) Data Mapping (T2T) option in Application Infrastructure
3) Data File Mapping (F2T) option in Application Infrastructure
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3.1.9.1 DIH Connectors

For customer’s that have licensed DIH to source data from external systems into OFSAA , this probably is
the easiest approach to load data into the result area table. Source data could either reside in relational
structure or in a file structure. Mappings maintained in DIH are logical in nature while physical
implementation is managed internally. Dimensional lookups work seamlessly without the need for any
additional configuration in the connector mapping as this too is managed internally by DIH. Refer to DIH
user for details on how to load data into a result area table.

/2 Connector Definition - Internet Explorer

‘ Connectors

Connectors > Connectors (Definiion Mode) >
& Connector Flow Diagram

9 Deriniton 3 source =% Target [3 wapping Ef Properties &7 summary

What are the objectives of this connector?

Which operation should this c onnector perform on OFSAA?

®)Insert data Extract data

On w hich OFSAA module should this operation be performed?

®) Staging Results

For w hich appiications (if any) shouid this connector be mapped?

v

For w hich External Data Stores (if any) should this connet tor be mapped?

v

3.1.9.2 Data Mapping (T2T)

Data Mapping refers to the process of retrieving unstructured data from data sources for further data
processing, storage, or migration. This feature is commonly known as RDBMS source to RDBMS
target(T2T) framework in the OFSAA world and can be leveraged when source data is available in Oracle
database. Dimensional lookups must be handled via the T2T’s join condition and expressions. Refer to
OFS AAI User Guide for more details on configuring a T2T.

3.1.9.3 Data File Mapping (Flat File to RDBMS Target - F2T)

If the source data is available in file structures, OFSAA F2T component can be used to bring the data in
the OFSAA eco system. As lookups cannot be configured in a F2T, this component must be used in
conjunction with T2T component, that is, data is first loaded from the file to an interim staging structure
using the F2T component followed by data load to the target result area table using the T2T component.
This is least recommended approach as there is need for interim table structure in data model and
involves multiple data hops which add to the overhead.

Refer to the OFS AAI User Guide for more details on configuring a F2T.
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3.1.10 FSDF Entity Information

3.1.10.1 Dimension Tables/Entities

Table 10: Dimension Tables/Entities

Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions

No. Logical Names

1 DIM_ACCRUAL_STATUS Accrual Status This table stores the loan accrual status.

Dimension Values expected are :
0 = Accrual
1 = Non-Accrual
2 = Serviced for Others/Securitized

2 DIM_BANDS Bands This setup table contains the list of band

Dimension dimensions. Information on the table
name, columns containing the band codes,
upper and lower bound values are stored
in the setup table and a generic code is
executed to populate the band codes in the
respective fact tables.

3 DIM_CHANNEL Acquisition This table stores the master list of all

Channel unigue codes that denote channels
Dimension through which customers can be acquired.
4 DIM_CREDIT_LINE Credit Facility This table stores the credit facility
Dimension definition. Credit facility is committed line of
credit given to a customer who can have
multiple draws / exposures out of a given
credit line.
5 DIM_CUSTOMER_TYPE Customer Type This entity stores the master list of
Dimension customer types: OUR/ OTH.

6 DIM_DATES Date Dimension | This table stores the List of Dates
generated between any two dates typically
covering extraction dates and cash flow
dates.
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Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
No. Logical Names
7 DIM_DELQCY_WORKOUT_PROGRAM Delinquency This table stores the loss / delinquency
Workout workout program associated with loans.
Program Workout program is defined generally as: if
Dimension particular program is deferment,
forbearance, term changes, rate changes,
and so on. This is a seeded Dimension
and list of values are pre-populated by the
installer.
8 DIM_EDUCATION Education This table stores the customer's education
Dimension master information.
9 DIM_FISCAL_PERIODS Fiscal Periods This table stores the fiscal information for
Dimension each calendar based on the convention
followed in the particular jurisdiction.
10 DIM_FORECLOSURE_STATUS Foreclosure This table stores the foreclosure process
Status status. Values expected are:
Dimension 0 = Not in foreclosure
1 = In foreclosure, pre-sale
2 = Post-sale foreclosure, Redemption,
non-REO (if available, otherwise REO)
3=REO
11 DIM_INTEREST_TYPE Interest Type This table stores the Interest Type.
Dimension
12 | DIM_LOAN_MODIFICATION_TYPE Loan This table is used for any loan that is
Modification currently operating under modified terms

Type Dimension

and identifies the specific terms that were
altered through loss mitigation efforts.

The information in this table is independent
of investor and speaks only to the nature of
the program. For example, a FNMA loan
can be modified under either a FDIC or
proprietary modification program — in these
cases, this information is populated with
the FDIC or proprietary codes while the
Investor field identifies the modification as
being performed on a FNMA loan.

0 = Loan has not been modified

6 = ASF Streamline

8 = FHFA Streamline (Specific to program
announced 12/15/08)
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Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
No. Logical Names
9 = FDIC Streamline (“Mod in a Box”)
10 = Proprietary Systematic Program
11 = Proprietary Other
12 = Home Affordable Modification
and:
0 = Not Modified
7 =2MP
8 = Proprietary Systematic
9 = Proprietary Other
10 = HAMP
13 DIM_ORG_STRUCTURE Organization This entity stores the Organization
Structure Structure of the Financial Institution.
Dimension
14 DIM_PRODUCT Product This entity stores the details of all the
Dimension products (existing/stopped) offered by the
Financial Institution.
15 DIM_PRODUCT_TYPE Product Type This table stores the loan product type
Dimension information.
16 DIM_REG_PRODUCT_TYPE Regulatory This table stores the regulatory product
Product Type types. This is used for regulatory reporting
Dimension purpose and contains values like Auto
Loans, Credit Cards, other consumer
loans, and so on.
17 DIM_REG_REGION Regulatory This entity stores the borrower’s current
Region place of residency must be used to define
Dimension the region.
18 DIM_RUN Run Dimension The Run Master Dimension entity stores all
Dimension the baseline and simulation runs.
19 DIM_VEHICLE_TYPE Vehicle Type This table stores the vehicle types. For
Dimension example: SUV, Car, Truck, and so on.
20 DIM_WRITE_OFF_REASONS Write-Off This table stores the master list of reasons
Reasons based on which the contracts are written-
Dimension off from the books.
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Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
No. Logical Names
21 DIM_AGENCY_TYPE Agency Type This table stores details of Agency type
Dimension which issues and guarantees loans like US
Government Agency, US Government
Sponsored Agency.
22 DIM_COUNTRY Country This table stores the master list of
Dimension countries.
23 DIM_CR_LN_VALUATION_TYPE Credit Line This entity stores the method used to
Valuation Type account the credit line. The credit line can
Dimension account for under the fair value option or is
held for sale and carried at the lower-of-
cost-or-market (LOCOM).
24 DIM_CREDIT_RATING Credit Rating This table stores the master list of credit
Dimension rating and rating issuers.
25 DIM_CUSTOMER Customer This entity stores the list of the
Dimension organization's customers and
counterparties and their attributes.
26 DIM_FRY9C_LINES FR Y-9C Lines This table stores the FR Y-9C reports
Dimension codes. The FR Y-9C report is a highly

analytical report submitted to the regulator
for the purpose of analyzing health of
banking institution.

Report the integer code (Additional
Instructions for FR Y 9C for descriptions).
Only enter designated descriptions
corresponding to the line number on the
FR Y-9C, HC-C, in which the outstanding
balance is recorded or, in the case of an
unused commitment, the line number in
which the credit facility would be recorded
if it were drawn.

Refer to following FR Y-9C instructions for

definitions of HC-C line item categories:

1. bhck1292 (U.S. Banks and other U.S.
Depository Institutions)

2. bhck1296 (Foreign Banks)

3. bhck1590 (loans to finance agricultural
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Sl. List of Seeded Tables
No.

Table/Entity
Logical Names

Table/Entity Descriptions

production and other loans to farmers)

4. bhck1763 (Commercial and Industrial
loans to U.S. addressees. Exclude
loans that are scored but not graded)

5. bhck1764 (Commercial and Industrial
loans to non-U.S. addresses. Exclude
loans that are scored but not graded)

6. bhck2081 (Loans to foreign
governments and official institutions)

7. bhckJ454 (Loans to non depository
financial institutions)

8. bhckJ451 (All other loans, excludes
consumer loans)

9. bhckF163 (All other leases, excludes
consumer leases)

10. bhckF160 (nonfarm,nonres, owner

occupied)

11. nonfarm, nonres, owner occupied

originated in non-domestic offices as
reported within bhck1410

27 DIM_INDUSTRY Industry This table stores the industry information.
Dimension

28 DIM_LIEN_POSITION Lien Position This table stores the list of lien positions
Dimension that can be on the collateral.

29 DIM_LOB Line Of This entity stores the unique list of Line of
Business Bussiness and the details of each Line of
Dimension Bussiness.

30 DIM_MITIGANT Mitigant This entity stores information on various
Dimension risk mitigants like collateral, guarantee,

nettable liabilities, and so on.

31 DIM_PARTY

Party Dimension

This table stores the history of a party.
Party here can be customer, issuer and

guarantor, and so on.
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Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
No. Logical Names
32 DIM_REG_INDEX Regulaory Index | This table stores list of indices which are
Information designed to store the regulatory based
Dimension index code as designated by the regulator.
For example: LIBOR, PRIME, Treasury
Index, and so on.
33 DIM_REG_INTEREST_TYPE Regulaory This table stores the list of indices which
Interest Type are designed to store the regulatory based
Dimenison interest type code as designated by the
regulator for an account at account level or
group of accounts at a credit line level. For
example: FIXED, FLOATING, MIXED, and
so on.
34 DIM_STD_CREDIT_LINE_PURPOSE Standard Credit | This table stores the regulator specified

Facility Purpose
Dimension

purpose of the said credit facility. This is
the list of values which are unique to US
Banking system. Only Number is expected
here. This is also synch up with Shared
National Credit data codes.

0= OTHER

1= ACQUISITION AND/OR MERGER
FINANCING

2= ASSET SECURITIZATION
FINANCING

3 = CAPITAL EXPENDITURES
EXCLUDING REAL ESTATE

4 = COMMERCIAL PAPER BACK-UP

5= INDUSTRIAL REVENUE BOND
BACK-UP

6 = MORTGAGE WAREHOUSING
7 = TRADE FINANCING
8 = PERFORMANCE GUARANTEE

9 = WORKING CAPITAL - SHORT
TERM/SEASONAL

10 = WORKING CAPITAL —
PERMANENT

11 = GENERAL CORPORATE
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Sl.

No.

List of Seeded Tables

Table/Entity
Logical Names

Table/Entity Descriptions

20 =

21 =

22 =

PURPOSES

DEBT
REFINANCE/CONSOLIDATION

ESOP FINANCING

AGRICULTURE AND/OR
LIVESTOCK PRODUCTION

AGRICULTURE AND/OR
RANCHING REAL ESTATE

STOCK BUYBACK

PORTFOLIO ACQUISITION
INCLUDING NOTE PURCHASE
AGREEMENTS

REAL ESTATE
ACQUISITION/DEVELOPMENT/CO
NSTRUCTION — LAND

REAL ESTATE
ACQUISITION/DEVELOPMENT/CO
NSTRUCTION — RESIDENTIAL

REAL ESTATE
ACQUISITION/DEVELOPMENT/CO
NSTRUCTION - COMML & INDL

REAL ESTATE
INVESTMENT/PERMANENT
FINANCING — RESIDENTIAL

REAL ESTATE
INVESTMENT/PERMANENT
FINANCING - COMMERCIAL AND
INDUSTRIAL

BUSINESS
RECAPITALIZATION/DIVIDENDS

NEW PRODUCT DEVELOPMENT
PROJECT FINANCING
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Sl. List of Seeded Tables
No.

Table/Entity
Logical Names

Table/Entity Descriptions

35 | DIM_STD_CREDIT_LINE_TYPE

Standard Credit
Facility Type
Dimension

This table stores the regulator specified
credit facility types. For example:

1= REVOLVING CREDIT

2= REVOLVING CREDIT CONVERTING
TO TERM LOAN

3 = REVOLVING CREDIT - ASSET
BASED

4 = REVOLVING CREDIT - DIP
5 = NON-REVOLVING LINE OF CREDIT

6 = NON-REVOLVING LINE OF CREDIT
CONVERTING TO TERM LOAN

7= TERM LOAN

8 = TERM LOAN - A

9 = TERM LOAN - B

10 = TERM LOAN -C

11 = TERM LOAN - BRIDGE

12 = TERM LOAN - ASSET BASED
13 = TERM LOAN - DIP

14 = CAPITALIZED LEASE OBLIGATION
15 = STANDBY LETTER OF CREDIT
16 = OTHER REAL ESTATE OWNED
17 = OTHER ASSET

36 | DIM_STD_MITIGANT_TYPE

Standard
Mitigant Type
Dimension

This entity stores the standard mitigant
type.

37 DIM_ACCOUNT

Account

Dimension

This table stores the list of identifiers which
uniquely identify every single financial
arrangement between customer and
reporting bank.

38 DIM_COLL_VALUE_BASIS

Collateral
Vaulation Basis
Dimension

This table stores the valuation basis of the
Collateral Valuation. The allowed values

are “as is”, “as stabilized”, or “as

completed”.
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Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
No. Logical Names
39 DIM_HOLDING_TYPE Holding Type This table stores the Holding Type of the
Dimension security.
40 DIM_LOCATION Location This table stores the location dimension.
Dimension
41 DIM_PROPERTY_TYPE Property Type This table stores the property types
Dimension associated.
42 DIM_REG_LOAN_PURPOSE Regulatory Loan | This table stores the description for the
Purpose regulatory loan purpose / utilization of loan
Dimension amount. Values expected are:
1 = Purchase
4 = Rate / Term Refinance
5 = Cash-Out Refinance
6 = Other Refinance
7 = Home Improvement
8 = Debt Consolidation
9 = Education
A = Medical
Y = Other
U = Unknown
43 DIM_CREDIT_STATUS Credit Status This entity stores the credit status codes
Dimension for the customer account along with the
descriptions for each status code. For
example: current, delinquent, foreclosed.
44 DIM_GEOGRAPHY Geography This table stores the distinct list of all
Dimension geographical locations, where any of the
transaction channels of the Bank are
located.
45 DIM_REG_PRODUCT_CLASSIFICATION Regulatory This tables stores the classification of
Product loans underlying Mortgage Servicing

Classification

Dimension

Rights into Regulatory classes as required
for reports. For example: FHLMC/ FNMA,
FHA loans, and so on.
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Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
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46 DIM_ASSET_LEVEL Liquidity Asset This table stores the various Asset Levels
Level Dimension | that can be assigned to the account. Under
Basel Accord, an account can be either
Level 1 Asset or Level 2 Asset or Other
Asset.
a7 DIM_BROKER_DEPOSIT_TYPE Broker Deposit This table stores the standard list of broker
Type Dimension | deposit types that are required in the
regulatory document. A broker is an
individual or party (brokerage firm) that
arranges transactions between a buyer
and a seller for a commission when the
deal is executed. There are several kinds
of brokers, each of whom deals in specific
types of transactions. Each type of broker
provides different levels or type of service.
The list of values for this table is
Reciprocal, Sweep, and Other.
48 DIM_COLL_RELEASE_REASON Collateral This entity stores the reason due to which
Release Reason | the Collateral is released. Values expected
Dimension are Excess, Due, and so on.
49 DIM_CURRENCY Currency This table stores the currency information.
Dimension
50 DIM_ENCUMBRANCE_STATUS Dimension This entity stores the list of encumbrance
Encumbarance status. The list fo values are Fully
Status Encumbered, Partially Encumbered, and
Dimension Not Encumbered.
51 DIM_INSTRUMENT_CONTRACT Instruments This entity stores the contracts and
Contracts instruments in the Market and their details
Dimension like Effective Date, Maturity Date, Face
Value, Day Convention, Strike, and so on.
52 DIM_INSTRUMENT_TYPE Instrument Type | This entity stores the details of all the

Dimension

Instrument Types which Reveleus Market
Risk solution supports.
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53 DIM_INSURANCE_SCHEME Dimension This entity stores the details of insurance
Insurance scheme.
Scheme
54 DIM_IR_STRUCTURED_INSTRS Structured This table stores details of Structured
Security Type Security Type like Pass Through
Dimension Certificates and mortgage-backed
securities.
55 DIM_MITIGANT_TYPE Mitigant Types This entity stores the master list of mitigant
Dimension types given by the customers against their
exposures. Possible types include
Collateral, Guarantee, and so on.
56 DIM_NETTING_AGREEMENT Netting This table stores the details of Netting
Agreement Agreement. Netting agreement happens
Dimension between a bank and a counterparty for
OTC derivative and SFT transactions. For
example: ISDA, FOA, EEI, and so on.
57 DIM_PARTY_TYPE Party Type This table stores the history of a party for
Dimension party type. Party here could be customer,
issuer and guarantor, and so on.
58 DIM_REG_COLLATERAL_STOCK_TYPE Regulatory This table stores the regulatory collateral

Collateral Stock

Type Dimension

stock type and acts as a reclassified
dimension which refers to the stock of
collateral held or posted by the entity
related to certain transactions like
derivatives. Expected values are:

¢ Rehypothecatable — Unencumbered
(and Treasury Controlled)

e Rehypothecatable — Encumbered (or

not Treasury Controlled)
¢ Non-Rehypothecatable
e Segregated Cash

¢ Non-Segregated Cash
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59 DIM_REG_COVER_TXN_TYPE Regulatory This table stores the regulatory covered
Covered transaction types.
Transaction
Type Dimension
60 DIM_REG_DEPOSIT_TYPE Regulatory This table stores the details of various
Deposit Type deposit types like Demand deposits and
Dimension Negotiable Order of Withdrawal (NOW)
accounts.
61 DIM_STD_GL_TYPE Standard This table stores the standard general
General Ledger | ledger types.
Type Dimension
62 DIM_UNDRLYNG_ASST_POOL_TYPE Underlying This table stores the underlying asset pool
Asset Pool Type | type for derivative instruments. For
Dimension example, Student Loan ABS means an
asset backed security backed by student
loans. In this case, this table stores the
Student Loan.
63 DIM_REG_INSTR_CLASSIFICATION Regulatory This table stores data for different
Instrument Instrument Classification defined by the
Classification Regulators.
Dimension
64 DIM_STANDARD_PARTY_TYPE Standard Party This table stores the standard party type.
Type Dimension | Party here can be customer, issuer and
guarantor, and so on.
65 DIM_STANDARD_PRODUCT_TYPE Standard This table stores the list of all product
Product Type types specified by regulator for risk
Dimension computations.
66 DIM_REG_PARTY_TYPE Regulatory Party | This entity stores the regualtor specfic
Type Dimension | party types.
67 DIM_REG_LIQ REPORTING_GROUP Regulatory This is a reclassififed dimension storing
Liquidity various PIDs/Product reported in Liquidity

Reporting Group
Dimension

reporting.
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68 DIM_STANDARD_CENTRAL_BANKS Standard This table stores the names of various
Central Banks central banks across the world.
Dimension
69 DIM_REG_INSURER Regulatory This is a reclassified dimension which
Insurer stores the deposit insurers as specified by
Dimension the regulator. Values Expected are FDIC,
OTHERS, and UNINSURED.
70 DIM_RESULT_BUCKET Result Bucket This table stores the result buckets
Dimension associated with each process.
71 DIM_SETTLEMENT_TYPE Settlement Type | This table is used to identify the settlement
Dimension mechanisms used for Secured and Foreign
Exchange products.
Following Secured products are identified
using the table:
TRIPARTY: secured financing transactions
settled on the US-based tri-party platform,
OTHER: secured financing transactions
settled on other (for example, non-US)
third-party platforms,
BILATERAL: secured financing
transactions settled bilaterally.
Following Foreign Exchange products are
identified using the table:
CLS: FX transactions centrally cleared via
CLS,
OTHER: FX transactions settled via other
(non-CLS) central clearinghouses,
BILATERAL: FX transactions settled
bilaterally.
72 DIM_RISK_SCENARIO Risk Scenario This table stores the Operation Risk
Dimension Scenarios.
73 DIM_REG_TRADING_POSITION_CLASS Regulatory This table stores the regulatory trading
Trading Position | position class values.
Class
Dimension
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74 | DIM_REG_LIQ_CASHFLOW_GROUP

Regulatory
Liguid Cashflow
Group
Dimension

This table store the cash flow groups used
for liquidity reporting like FR 2052a. This
serves as a reclassified dimension in

regulatory reporting.

75 DIM_FIXED_ASSETS

Fixed Assets
Dimension

This table stores the data related to fixed
assets. Fixed assets are physical assets
such as Buildings, Land, Machinary,
Automobiles, Gold bullion, and so on. They
can be sold and appropriate profit/loss can
be recognized based on appropriate
accounting principles.

76 DIM_ISSUER

Issuer

Dimension

This entity is used as an issuer of
marketable collaterals.

77 | DIM_REP_LINE

Reporting Line

This table stores list of all computed

Dimension reporting line items.

78 DIM_SECURITIZED_PRODUCTS Securitized This table stores details of Securitized
Products products like Residential pass-through
Dimension securities and Residential mortgage-

backed securities.

79 | DIM_TRADING_ACCT BOOK_TYPE

Trading Account
Book Type
Dimension

This table helps to identify trading assets
and liabilities. Along with Holding type as
held for trading, at times the regulator has
an additional criteria like positive fair value
for identification of trading assets and
negative fair value for trading liabilities.

80 DIM_CONSOLIDATION

Consolidation

This entity stores details of various kinds of

Dimension values to be analyzed like actual or
budget.
81 DIM_ACCOUNT_PORTFOLIO Account This table is planned for deprecation.
Portfolio
Dimension
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82 DIM_ACCT_PORTFOLIO Account This table stores the master list of all the
Portfolio portfolios of the Institution. Portfolios are
Dimension user-defined group of accounts. For
example, auto loan porfolio is a group of
auto loans.
83 DIM_ACCT_STATUS Account Status This table stores a set of unique codes that
Dimension denote the status of an account.
84 DIM_APR_RESET_TYPE Apr Reset Type | This table stores the frequency of reset for
Dimension the APRs as applicable to the card
account.
85 DIM_BANKRUPTCY_CHAPTER Bankruptcy This table stores the code of the
Chapter bankruptcy chapter filed by customer of the
Dimension said account. The list of values are pre-
populated by the installer.
86 DIM_CARD_FEE_PAY_TYPE Card Fee Pay This table stores the fee pay types
Type Dimension | associated with card account. Expected
values are:
0 = No fee
1 = Annual
2 = Monthly
3 = Other
87 DIM_CENTRAL_AUTHORITY Central Authority | This table stores the list of all the central
Dimension authorities like Group Supervisor, and so
on, for an entity.
88 DIM_CREDIT_CARD_CO_BRAND_TYPE Credit Card Co This table stores the co-branding type /
Brand Type association code linked to the said credit
Dimension card. The list of values are pre-populated
by the installer.
89 DIM_CREDIT_CARD_LENDING_TYPE Credit Card This table stores the credit card type code.
Lending Type The list of values are pre-populated by the
Dimension installer.
90 DIM_CREDIT_CARD_NETWORK Credit Card This table stores the credit card networks
Network associated.
Dimension
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91 DIM_CREDIT_CARD_REWARD_TYPE Credit Card This table stores the credit card reward
Reward Type type code. The list of values are pre-
Dimension populated by the installer.
92 DIM_CREDIT_CARD_TYPE Credit Card This table stores the codes of the credit
Type Dimension | card usage. The list of values are pre-
populated by the installer.
93 DIM_CREDIT_CLASS_TYPE Credit Class This table stores the credit class type
Type Dimension | description assigned to the given account.
The list of values are pre-populated by the
installer.
94 DIM_CREDIT_LINE_CHANGE_TYPE Credit Line This table stores the code of the credit line
Change Type change type initiated by bank as applicable
Dimension to the said account. The list of values are
pre-populated by the installer.
95 DIM_CREDIT_SCORE_TYPE Credit Score This table stores the credit score type
Type Dimension | codes to be used for reporting for
regulatory purposes code. The list of
values are pre-populated by the installer.
96 DIM_DELQCY_WORKOUT_PROG_STATUS | Delinquency This table stores code of status of the work
Workout out programs. The list of values are pre-
Program Status | populated by the installer.
Dimension
97 DIM_DELQCY_WORKOUT_PROG_TYPE Delinquency This table stores the workout program type
Workout code associated with said account. The list
Program Type of values are pre-populated by the
Dimension installer.
98 DIM_ENTITY_TYPE Entity Type This table stores list of all types of entities
Dimension in the organization structure.
99 DIM_INCOME_DOCUMENTATION_PROG Income This table stores the code of the income
Documentation documentation related to particular
Program account / customer. The list of values are
Dimension pre-populated by the installer.
100 | DIM_INCOME_SOURCE_TYPE Income Source This table stores the income sources. The

Type Dimension

list of values are pre-populated by the
installer.
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101 | DIM_INDEX Index This table stores list of indices which are
Information designed to measure price changes of an
Dimension overall market, such as the stock market or
the bond market. For example, Vanguard's
Total Bond Market Index, Dow Jones
Industrial Average, Tokyo Stock
Exchange(Nikkei 225), and so on.
102 | DIM_INTEREST_TYPE_CONVERSION Interest Type This table stores the interest type change
Conversion code for a given loan. Indicates whether
Dimension the interest type was converted from ARM
to Fixed through loss mitigation, and the
duration of the fixed rate period. The list of
values are pre-populated by the installer.
103 | DIM_LIEN_PERFORMANCE Lien This table stores the performance
Performance description of the lien associated with the
Dimension loan account. It includes First and Junior
lien performance. The list of values are
pre-populated by the installer.
104 | DIM_LIQUIDATION_STATUS Liguidation This table stores the code of liquidation
Status status to convey the way account was
Dimension liquidated. The list of values are pre-
populated by the installer.
105 | DIM_LOAN_REPURCHASE_STATUS Loan This table stores the loan repurchase
Repurchase process status associated with the said
Status account. The list of values are pre-
Dimension populated by the installer.
106 | DIM_LOAN_SOURCE_TYPE Loan Source This table stores the source by which the

Type Dimension

servicer originated or otherwise acquired
the mortgage. At the servicer's discretion,
acquired servicing can be reported as
retail, broker, or correspondent originations
to the extent the information is available.

¢ Retail — Report all mortgages
originated through the reporting
institution’s retail, including branch or
internet, production channel.
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Wholesale (Broker) - Report all
mortgages originated through the
reporting institution's
wholesale/broker production channel.
Report as broker originated all third-
party originated loans where the bank
cannot distinguish between broker
and correspondent originated.

Correspondent - Mortgages acquired
through the reporting institution's
correspondent production channel.
This includes all mortgage whole
loans purchased on a recurring basis
(flow) from another correspondent
institution, eligible for securitization
into the secondary markets or
portfolio retention on the bank'’s
balance sheet. Report as broker
originated all third-party originated
loans when the bank cannot
distinguish between broker and

correspondent originated.

Bulk Purchase — Pools of mortgage
whole loans purchased from a third
party originator for the right to
securitize or retention in the bank-
owned portfolio. Residential
Mortgages acquired for the Servicing
Portfolio in this manner are typically
negotiated as one-time transactions
between a Mortgage Institution and
an independent third party originator
(Mortgage Company or
Correspondent). Report all bulk
acquisitions and correspondent flow
acquisitions as correspondent
originated when the institution cannot
distinguish between these categories.
Do not label bank acquisitions as
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Bulk Purchases.

e Servicing Rights Purchased - Refers
to a separately negotiated purchase
of mortgage servicing rights (PMSR)
from a third party. When the servicer
cannot distinguish between bulk
whole loan and bulk servicing
acquisitions, the servicer must report
all of these acquisitions consistently
in the category that represents the
majority of the servicer's acquisitions.

Note: This reporting category applies
exclusively to the Servicing Portfolio.

e Wealth Management/Private Banking
— report all loans originated through a
servicer’s private wealth
management or private banking
division. This is a seeded Dimension
and list of values are pre-populated
by the installer.

107 | DIM_LOSS_SHARE_AGREEMENT

Loss Share
Agreement
Dimension

This table stores specific loss sharing
agreements. A unique ID must be
generated for each active sharing
agreement. The specific ID must be
consistent over time for as long as the
agreement remains active without a
relevant change in the terms of the loss
sharing agreement.

The institution must also provide a written
summary of the relevant terms of each loss
sharing agreement along with the
corresponding Loss Share ID number.
Additional supporting documentation may
be requested if necessary.

Report blank if the account is not
associated with a loss sharing agreement.
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108 | DIM_MORT_INVESTOR_TYPE Mortgage This table stores the mortgage investor

Investor Type type or insurance company code which

Dimension logically owns the mortgage till debt is
cleared off. The list of values are pre-
populated by the installer.

109 | DIM_MORTGAGE_OCCUPANCY Mortgage This table stores the code of mortgage

Occupancy occupancy for a given loan /account. The

Dimension list of values are pre-populated by the
installer.

110 | DIM_PROG_ACTIVITY_STATUS Program Activity | This table stores the program activity

Status status code. The list of values are pre-

Dimension populated by the installer.

111 | DIM_REPAYMENT_STATUS Repayment This table stores the loan repayment plan

Status status code.

Dimension Repayment Performance Status — This
field tracks the performance of repayment
and step-to-mod plans. If a repayment plan
or step-to-mod was completed successfully
during the month, it must be coded as such
in the work-out type completed field). This
field is only to be populated for repayment
plans that were active as of the end of the
month or broken during the month. Broken
plans must only be reported in the month
the plan breaks. The list of values are pre-
populated by the installer.

112 | DIM_VALUATION_METHOD Valuation This table stores list of all methods used

Method for valuation purposes.

Dimension

113 | DIM_RISK_SECTOR Risk Sector This table stores the reporting risk sectors
which are determined based on the legal
entity of the counterparty.

114 | DIM_LOAN_SERVICE_TYPE Loan Service This table stores the details of loan service

Type Dimension

type which details whether the loan is
Extended, Guaranteed, Serviced, or
Insured by the Holding Company
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115 | DIM_PLEDGED_STATUS Pledged Status This entity stores the Pledged Status
Dimension information.
116 | DIM_SECURITIZATION_TYPE Securitisation This table stores the different securitization
Type Dimension | types as defined by Basel.
117 | DIM_MARKET_RISK_POSITION Dimension This entity stores a master list of different
Market Risk positions a Financial Institution can have
Position on different marketable instruments. For
example: Long Position, Short Cash Long
Call, Long Put, and so on.
118 | DIM_BASEL_BANK_ROLE Basel Bank This table stores the Bank Role type as
Roles defined by Basel Accord.
119 | DIM_BASEL_PRODUCT_TYPE Basel Product This table stores the details of product type
Types as defined by Basel.
Dimension
120 | DIM_BASEL_CONSL_OPTION_TYPE Basel This entity stores the Basel Consolidation
Consolidation Option Type (Solo / Consolidation).
Option
Dimension
121 | DIM_EXPOSURE_UNDERLYING_TYPE Exposure This table stores the various underlying
Underlying Type | type for the exposure.
122 | DIM_BEHAVIOUR_TYPE Behaviour Type | This table represents account behaviour /
performance. Expected Values are Core,
Volatile, Substandard, Doubtful, Loss,
Sight Devolvement, Sight Recovery,
Usance Devolvement, and Usance
Recovery.
123 | DIM_REG_RISK_CLASS Regulatory Risk | This table stores the regulatory risk class
Classification like High / Medium and so on.
124 | DIM_BASEL_POOL_TYPE Dimension This table stores the various securitization
Basel Pool Type | pool types.
125 | DIM_BASEL_ASSET CLASS Basel Asset This table stores the Basel defined
Class exposure types.
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126 | DIM_RISK_TYPE Risk Type This Master table stores the risk ttypes.

Dimension For example: Price Risk, Volatility Risk,
and so on.

127 | DIM_BASEL_METHODOLOGY Basel This table stores the approach
Methodology methodology as defined by Basel.
Dimension

128 | DIM_CAPITAL_COMP_GROUP Capital This table stores the dimensions of Capital
Computation Computation Group.
Group
Dimension

129 | DIM_BANK_BASE_ROLE Bank Base This table stores the Bank Role type as
Roles defined by Basel.
Dimension

130 | DIM_FIDUCIARY_SERVICE_TYPE Fiduciary This entity stores the details of various

Service Type

types of fiduciary service.

Dimension
131 | DIM_FIDUCIARY_SERVICE_ROLE Fiduciary This entity stores the details of various
Service Role roles played by a fiduciary service
Dimension provider.
132 | DIM_MR_ASSET CLASS Market Risk This entity stores the list of Ratings like
Asset Class AAA, EQ & custom Equities, XS and COM,
Dimension which are used to identify the Interest Rate
Risk Factor, Equity Risk Factor, Currency
Risk Factor, and Commodity Risk Factors
respectively.
133 | DIM_FUND_TYPE Fund Type This table stores list of all applicable types
Dimension of fund.

134 | DIM_FUND

Fund Dimension

This table stores list of all funds used by
the entity.

135 | DIM_CAP_INSTRUMENT_TXN_TYPE

Capital
Instrument
Transaction
Type Dimension

This table stores the capital instrument

transaction type.
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136 | DIM_CONSTRUCTION_LOAN_TYPE Construction This table stores details of Construction
Loan Type Loan Type like 1-4 Family residential,
Dimension construction, town houses, duplex for the
construction loans issued by Holding
company.
137 | DIM_ISSUER_TYPE Issuer Type This entity stores the issuer yypes.
Dimension
138 | DIM_ACCOUNT_TYPE Dimension This table stores the details of the account
Account Type type.

139 | DIM_SALE_TYPE Sale Type This table stores the loan sale types.
Organization can sell the loans as whole
loan, through securitization, or pass
through certificates.

140 | DIM_REG_EQ_INVST_CLASSFCTN Regulatory This table stores the regulator defined

Equity classifications of equity investment as used
Investment in regulatory reports. Expected Values are

Classification

Direct Public Investment, Direct Nonpublic

Dimension Investment, Indirect Investment.

141 | DIM_REG_EQ_TXN_GROUP Regulatory This table stores the regulator defined
Equity types of equity transactions as used in
Transaction regulatory reports. Expected Values are
Group Purchase, Return of Capital, Net Valuation
Dimension Changes, and others.

142 | DIM_SCENARIO Scenario This entity stores the details of various
Dimension kinds of values to be analyzed like actual

or budgeted.

143 | DIM_REG_VINTAGE Regulatory This table stores the vintage definitions
Vintage used in building Vintage dimensions in
Dimension CRR. Vintage codes are "Year" + "Month"

combination.
Additional Comment is:

Vintage dimension was built on fact table.
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144 | DIM_ACCT_SOLD_EXEMPT_STATUS Account Sold This table stores the status of exemption
Exemption for sold accounts. Loans sold have liability
Status on bank on legal terms. This dimension
Dimension helps to identify if particular loan is
exempted from reporting as it is already
repurchased or settlement is completed.
145 | DIM_STANDARD_ACCT_HEAD Standard This dimension lists the various standard
Accounting accounting heads (Equity, Reserves and
Head Dimension | Surplus, and so on.) under which a bank
classifies its GL sources of accounting
capital.
146 | DIM_INSTRUMENT_CATEGORY Instrument This table stores instrument category -
Category Assets/Liabilities/Others/Services.
Dimension
147 | DIM_EXPOSURE Exposure This table stores the account wise
Dimension summary for product processor.
148 | DIM_OPRISK_LOSS_DATA_CATEGORY Operational Risk | This tables stores the operational loss data
Loss Data category. Expected Values are Internal,
Category External, Model Input, and Scenario.
Dimension
149 | DIM_VARIABLE Variable This table stores the variables to be
Definition consumed by Enterprise Stress Testing or
Dimension any other similar usage.
150 | DIM_ACCRUAL_STATUS Accrual Status This table stores the loan accrual status.
Dimension Values expected are:[]
0 = Accruall
1 = Non-Accruall
2 = Serviced for Others/Securitized
151 | DIM_CREDIT_SCORE_MODEL Credit Score This table stores the list of credit score

Model

Dimension

models used in arriving at the credit score.
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152 | DIM_PRODUCT_INT_TERM_GROUP Product Interest | This table stores the Interest and Term

Term Group Group together.

Dimension For example, few US loans are
categorized as Fixed 30 which means fixed
interest and 30 years maturity and are
reported with name Fixed 30.

153 | DIM_REG_ACCT_SOURCING_CATEGORY | Regulatory This table stores the list of regulatory

Account account sourcing categories that a bank

Sourcing follows to acquire a customer.

Category

Dimension

154 | DIM_REG_AMORTIZATION_TYPE Regulatory This table stores the information regarding

Amortization various regualtory amortization types.

Type Dimension

155 | DIM_REG_ATTRITION_REASON Regulatory This table stores the various attrition

Attrition Reason | reasons of a loan as prescribed by the

Dimension regulator.

156 | DIM_REG_CREDIT_LIMIT_TYPE Regulatory This reclassified table stores the list of

Credit Limit credit limit types.

Type Dimension

157 | DIM_REG_INS_LOAN_TYPE Regulatory This tables stores the regulatory loan types

Mortgage based on the mortgage issurance issuers.

Insurance Loan

Type Dimension

158 | DIM_REG_LOAN_DELQ _ STATUS Regulatory Loan | This table stores the various deliquency

Delinquency status of a loan as prescribed by the

Status regulator.

Dimension

159 | DIM_REG_LOAN_SEGMENT Regulatory Loan | This tables stores the regulatory portfolios

Segment
Dimension

of loans segmented based on regulatory

requirements.
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160 | DIM_REG_MORT_INS_ISSUER Regulatory This tables stores the regulatory mortgage
Mortgage insurance issuer values as required by the
Insurance Issuer | regulator.
Dimension

161 | DIM_REG_VALUATION_METHOD Regulatory This table stores the regulatory valuation
Valuation method used to calculate the mitigant
Method value.
Dimension

162 | DIM_SERVICED_LOAN_ACCOUNT

Serviced Loan

This table stores account summary.

Account However only for those accounts which
Dimension bank holds for servicing purpose only.
These account may or may not be
originated by bank.
163 | DIM_STANDARD_IRC Standard This entity stores the standard interest rate

Interest Rates

curve definitions.

Dimension

164 | DIM_STD_BALANCE_CATEGORY Standard This dimension entity stores the list of
Balance regulatory categories that a balance can
Category have.
Dimension

165 | DIM_STD_CENTRAL_AUTHORITY Standard This tables stores the central authorities

Central Authority
Dimension

like FRB, FDIC and so on.

3.1.11 Fact Tables/Entities

For all tables with data flow type tagged as a Processing, it is recommended that end users map data
directly to result area if processing application is not part of OFSAA product suite. For example, Basel
computations, RWA Numbers, and Capital Ratio are taken from processing area which is populated by

OFSAA or other Basel application.

For processed tables, you can look for the following options:

e OFSAA Data Integration Hub (DIH) product

e Flat File

e Table-to-Table Transformation with source being processing application
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1 FCT_ACCOUNT_MITIGANT_MAP | Fact Account Mitigant | This entity stores the account to Staging

Map mitigant mapping. It supports
more than one mitigant to be
mapped to an account.
2 FCT_ACCT_RECOVERY_DETAIL | Fact Account This entity stores the details of Staging
S Recovery Details recoveries for each account.
3 FCT_ACCT_WRITE_OFF_DETAI | Fact Account Write This entity stores the details of Staging
LS Off Details write-off for each account.

4 FCT_CARDS_SUMMARY Fact Cards Summary | This table stores the contract Staging,
summary of all active card Results
accounts.

5 FCT_COMMON_ACCOUNT_SUM | Fact Common This table stores common account | Staging

MARY Account Summary level information that usually
comes as an input through
staging.

6 FCT_CREDIT_LINE Fact Credit Facility This table stores the credit facility | Staging,
data. Credit facility is committed Results
line of credit given to a customer
who can have multiple draws /
exposures out of a given credit
line.

7 FCT_LOAN_ACCOUNT_SUMMA | Fact Loan Summary This table stores the details of Staging,

RY loans. This table includes Results
mortgage and vehicle loans.

8 FCT_MITIGANTS Fact Mitigants This entity stores all the Mitigants | Staging
and their details.

9 FCT_RECOVERY Fact Recovery This table stores the recovery Staging
details for all delinquent accounts.

10 FCT_REG_CAP_ACCOUNT_SU Fact Regulatory This table stores the regulatory Results

MMARY

Capital Account

Summary

capital for each account. Typically,
this table is an input from Basel
application.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
11 FCT_PARTY_FINANCIAL_DETAI | Fact Party Financial This entity stores the financial Staging
L Detail information (Balance-Sheet, Profit
and Loss statement, and Ratios)
in base and reporting currency of
the parties like Customer and
Guarantor.
12 FCT_PARTY_FINANCIALS Fact Party Financials | This entity stores the financial Staging
information (Balance-Sheet, Profit
and Loss statement, and Ratios)
of the parties like Customer and
Guarantor. Balance sheet is
prepared as of a particular date
(Balance sheet creation date).
13 FCT_PARTY_RATING_DETAILS Fact Party Rating This table stores the party rating Staging
Details details of the customer, guarantor,
counterparty, and so on.
14 FCT_IFRS_ACCOUNT_SUMMAR | Fact IFRS Account This table stores the measures Processed
Y Summary related to account that are
computed by IFRS application.
15 FCT_ACCOUNT_POSTION_PAIR | Fact Account Position | This table defines position Staging
Pair pairings that relate a primary
position and its offsetting position.
The position pairs can be held in
any manner (for example, cash or
margin). It contains only active
customer account positions.
16 FCT_ACCT_CUST_DETAILS Fact LRM Account This entity stores the derived Staging
Customer attribute at account and customer
Relationship Details granularity (includes joint
accounts).
17 FCT_ACCT_PLACED_COLL_MA | Fact Account Placed This table stores the account to Staging

P

Collateral Map

placed collateral mapping. It is an
intersection table to denote a
placed collateral can be used in
multiple account and an account
contains multiple collateral.
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Sl.

No.

List of Seeded Tables

Table/Entity Logical
Names

Table/Entity Descriptions

Data Flow
Type

18

FCT_COLL_PORTFOLIO_MTM_
DETAILS

Fact MTM Collateral
Details

This table stores the MTM impact
on derivative positions on a day-
to-day basis.

Processed

19

FCT_COLL_PORTFOLIO_MTM_S
UMMARY

Fact MTM Collateral
Summary

This table stores the MTM impact
on derivative positions at a
cumulative level.

Processed

20

FCT_DEPOSITS_BORROWINGS

Deposits And
Borrowings

This table stores all the deposit
and other borrowings accounts of
bank.

Staging,
Results

21

FCT_IFRS_MITIGANTS_SUMMA
RY

Fact IFRS Mitigants
Summary

This table stores the valuation of
Mitigants as per IFRS
requirements. Mitigant definitions
happen in DIM MITIGANT and
this table serves as additional set
of attributes for FACT
MITIGANTS.

Processed

22

FCT_IFRS_PLACED_COLLATER
AL

Fact IFRS Placed
Collateral

This table stores the valuation of
placed Collateral as per IFRS
requirements. Placed Collateral
definitions happen in DIM
PLACED COLLATERAL and this
table serves as additional set of
attributes for FACT PLACED
COLLATERAL.

Processed

23

FCT_LRM_ACCOUNT_SUMMAR
Y

Fact LRM Account

Summary

This table stores the details of the
Account Derived in Liquidity Risk
Management Solution.

Processed

24

FCT_LRM_PLACED_COLLATER
AL

Fact LRM Placed
Collateral

This table stores the liquidity
specific procedded attributes for
placed Collateral as per Liquidity
Risk regulations. Placed Collateral
definitions happen in DIM
PLACED COLLATERAL and this
table serves as additional set of
attributes for FACT PLACED
COLLATERAL.

Processed
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
25 FCT_MGMT_REPORTING Fact Management This table stores the management | Processed
Reporting reporting data related to
organization and product
profitability/income
statement/balance sheet.
26 FCT_PLACED_COLLATERAL Fact Placed Collateral | This table stores the details of Staging
collateral which are placed against
an account.
27 FCT_RATING_DWNGRD_COLL_ | Fact Rating This entity stores the details Processed
SUMMARY Downgrade Collateral | regarding loss of Rehypothecation
Summary Rights due to a downgrade for a
placed collateral.
28 FCT_RATING_DWNGRD_MTGN Fact Rating This entity stores the details Processed
T_SUMM Downgrade Mitigant regarding loss of Rehypothecation
Summary Rights due to a downgrade for a
mitigant.
29 FCT_REG_ACCOUNT_SUMMAR | Fact Regulatory This table stores the regulatory Results
Y Account Summary reclassifications and other
information as required for
regulatory reporting.
30 FCT_LEGAL_ENTITY_DETAILS Fact Legal Entity This table stores the details of the | Staging
Details legal entity.
31 FCT_REG_AGG_CASH_FLOWS Fact Regulatory This entity stores the aggregated Results
Aggregated cashflows for regulatory reporting
Cashflows purposes.
32 FCT_REG_CUSTOMER_SUMMA | Fact Regulatory This table stores the details at a Results
RY Customer Summary customer level.
33 FCT_REG_GL_CASH_FLOWS Fact Regulatory This table stores the cashflow Results
General Ledger details of general ledger accounts
Cashflows for regulatory reporting
requirements.
34 FCT_REG_MITIGANTS_SUMMA Fact Regulatory This table stores the cashflow Results
RY Mitigants Summary groups required for FR2052 a
reporting.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
35 FCT_REG_PLACED_COLLATER | Fact Regulatory This table stores the cashflow Results
AL Placed Collateral groups required for FR2052 a
reporting.
36 FCT_REG_RUN_LEGAL_ENTITY | Fact Regulatory Legal | This table stores the reporting Results
_MAP Entity Run Map entity identifier for every
regulatory reporting run.
37 FCT_SUBST_PLACED_COLLATE | Fact Substitutable This entity stores the details of a Processed
RAL Collateral collateral which has to be
substituted.
38 FCT_SUBSTITUTABLE_MITIGAN | Fact Substitutable This entity stores the details of a Processed
TS Mitigants mitigant which has to be
substituted.
39 FCT_TRANSACTION_SUMMARY | Fact Transaction This table stores the transaction Results
Summary summary.
40 FCT_TRD_ACCOUNT_TXN_SUM | Fact Trading Account | This entity stores all Fact Trading Results
MARY Transaction Summary | Account Transaction details.
41 FCT_FIXED_ASSETS Fact Fixed Assets This fact table stores measures Staging
pertaining to assets. Fixed assets
are physical assets such as
Buildings, Land, Machinary,
Automobiles, Gold bullion, and so
on. They can be sold and
appropriate profit/loss can be
recognized based on appropriate
accounting principles.
42 FCT_LLFP_ACCOUNT_SUMMAR | Fact Loan Loss This entity stores loan loss Processed
Y Forecasting And forecasting and provision account
Provision Account summary. Typically this table is an
Summary input from loan loss forecasting
and provision (llfp) application.
43 FCT_REG_ACCT_MITIGANT_MA | Fact Regulatory This table stores the account Results

PPING

Account Mitigant
Mapping

mitigant mapping information.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
44 FCT_CR_CUSTOMER_SUMMAR | Fact Credit Risk This entity stores the details of Staging
Y Customer Summary various measures pertaining to
the customer.
45 FCT_ASSETS_SOLD Fact Assets Sold This table stores the data of Staging
assets sold over a period of time.
For example, banks sells loans to
other parties.
46 FCT_ENTITY_INFO Fact Entity This entity stores the information Staging
Information about the various entities in the
Oraganization Structure of the
Financial Institution.
47 FCT_FIDUCIARY_SERV_INVST_ | Fact Fiduciary This entity stores the details of Staging’
SUMM Services Investmnet investments done through a
Summary fiduciary account.
48 FCT_MERCHANT_BANKING Fact Merchant This entity stores the details of Staging
Banking issues associated with a fiduciary
account.
49 FCT_MITIGANT_REG_CAPITAL Fact Mitigant This table stores the regulatory Processed
Regulatory Capital capital information related to
mitigants.
50 FCT_REG_TRANSACTION_SUM | Fact Regulatory This table stores the summary of Results
MARY Transaction Summary | regulatory transactions. For
example, amount of securities
sold or transferred from HTM to
AFS.
51 FCT_SECURITIZATION_POOL Fact Securitisation This table stores the information Processed
Pool on the securitization pool.
52 FCT_SEC_EXPOSURES Fact Securitisation This entity stores all the Processed
Exposures Securitisation Exposures for Basel
Il processing.
54 FCT_INSTR_PROPOSED_TXNS Fact Instrument This table stores the proposed set | Staging

Proposed
Transactions

of instruments that are transacted

by the Financial Institution.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
55 FCT_NON_SEC_EXPOSURES Fact Non This entity stores all the Processed
Securitisation Securitisation Exposures.
Exposures
56 FCT_NETTABLE_POOL Fact Nettable Pool This entity stores all Pools created | Processed
for Netting.
57 FCT_PAYMENTS_SUMMARY Fact Payment This entity stores the payment Results
Summary value, Receipt or inward value
and Netted (payment and
receipts) value aggregated at
currency level in natural currency
and reporting currency.
58 FCT_CAP_INSTR_POSITIONS Fact Capital This entity stores the regulatory Staging
Instrument Positions position of capital instruments and
details of treatment to capital
instrument under Basel | and IlI
regulations.
59 FCT_REG_EXP_MITIGANT_MAP | Fact Regulatory This table is planned for Processed
PING Exposure Mitigant deprecation.
Mapping
60 FCT_CP_CREDIT_QUALITY_SU Fact Counterparty This table stores the output of Processed
MMARY Credit Quality CVA calculation done for a given
Summary counterparty.
61 FCT_MORT_SERV_RIGHTS Fact Mortgage This tables stores the Mortgage Processed

Servicing Rights

Servicing Rights valuation
information. Mortgage Servicing
Rights values are typically book
value, fair value, and so on.
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Sl.

No.

List of Seeded Tables

Table/Entity Logical
Names

Table/Entity Descriptions

Data Flow
Type

62

FCT_REG_LE_CAPITAL_SUMMA
RY

Fact Regulatory Legal
Entity Capital
Summary

This table stores the regulatory
capital related information for the
legal entity. This table stores all
information from the GL related to
the capital structure processing
and the various levels of capital
computations processed and
computed by the application. This
stores information at the
granularity of the capital line item,
for each capital component group.
Some of the line items stored are
Tier 1 Capital, Tier 2 Capital, Total
Capital, and Capital Ratio.

Results

63

FCT_REG_CP_CAPITAL_SUMM
ARY

Fact Regulatory
Counterparty Capital
Summary

This table stores all the regulatory
capital related information of a
counterparty. Some of the risk
parameters in this table are
probability of default and internal
and external rating for the
counterparty. This table is
generally used for CVA
calculations and default fund

calculations.

Processed

64

FCT_REG_CAP_PLCD_COLL_S
UMMARY

Fact Regulatory
Capital Placed

Collateral Summary

This table stores the information
of all exposures to a bank which
are placed collateral. The placed
collateral by the bank is for default
fund contribution or for other OTC
transactions, with a central
counterparty. It is generally used
for cleared transactions and
default fund contributions.

Processed
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
65 FCT_REG_CAP_POOL_SUMMA Fact Regulatory This table stores the information Processed
RY Capital Pool of all exposures to a bank, which
Summary are at a pool level. Some of the
pool identified for this table are
OTC nettable pool and retail
pools. This table stores the
regulatory capital information
related to these pools.
66 FCT_LOANS_SERVICED Fact Loans Serviced This table stores the details of Staging
loans serviced by bank. They may
or may not be originated by the
bank.
67 FCT_FUND_CIS_COMPOSITION | Fact Fund CIS This entity stores the composition | Staging
Composition of the Investment funds.
68 FCT_CAP_INSTR_TXNS Fact Capital This entity stores the transactions | Staging
Instrument on the capital instruments.
Transactions
69 FCT_CREDITRISK_ACCOUNT_S | Fact Credit Risk This entity stores the different Processed
UMMARY Account Summary measures of exposures pertaining
to Credit Risk Analytics.
70 FCT_LIQUIDITY_REPORTING Fact Liquidity This entity stores the measure to Processed

Reporting

be reported for each of the
Liquidity Reporting line. Reporting
Measures are the amounts
displayed in standard template
prescribed by supervisor. For
example, Reporting lines and
measures mentioned in QIS
Reporting Template reporting
lines, reporting lines and
measures mentioned in
"Instructions for completing and
submitting the Liquidity Monitoring
Tool (4-G) template".
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
71 FCT_LIQUIDITY_REP_LINE_CO Fact Liquidity This entity stores the comments Processed
MMENT Reporting Line for each of the Liquidity Reporting
Comments line. Reporting Lines are the
standard template reporting lines
prescribed by supervisor. For
example, Reporting lines
mentioned in QIS Reporting
Template reporting lines, reporting
lines mentioned in "Instructions for
completing and submitting the
Liquidity Monitoring Tool (4-G)
template"”.
72 FCT_REG_EQ_INV_SUMMARY Regulatory Equity This table stores the summary of Results
Investmnet Summary | equity investments done by entity
as per regulatory equity
investment types.
73 FCT_OTTI_FV_PROJECTIONS Fact Other Than This table store the assumptions Processed
Temporary to determination criteria and value
Impairment Fair for Other-than-temporary
Value Projections impairment for product
investment.
74 FCT_OPSRISK_LOSS_PROJECT | Fact Operational Risk | This table stores the projection of | Processed
ION Loss Projection operational losses across required
measurement units and period for
a given operational loss data
category.
75 FCT_OTTI_FV_ASSUMPTIONS Fact Other Than This table stores the assumptions | Processed
Temporary to determination criteria and value
Impairment Fair for Other-than-temporary
Value Assumptions impairment for product
investment.
76 FCT_SCEN_VARIABLE _PROJEC | Fact Scenario This table stores the projection of Processed

TION

Variable Summary

various variables for Enterprise
Stress Testing or any other similar

usage.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
77 FCT_CAP_INSTR_PROPOSED _ Fact Capital This entity stores the proposed set | Staging
REDEEM Instrument Proposed | of capital instruments that are
Redemption redeemed or converted by the
Financial Institution.
78 FCT_CAP_INSTR_PROPOSED_| | Fact Capital This entity stores the proposed set | Staging
SSUES Instrument Proposed | of capital instruments that are
Issues issued by the Financial Institution.
79 FCT_REGULATORY_PLANNED_ | Fact Regulatory This table stores the impact of Processed
ACTION Planned Actions Planed Actions on various
measures like capital, RWA,
exposure, and so on that are
required for Basel Ill and Dodd-
Frank schedule. Financial
Institutions must capture all
material planned actions,
including, but not limited to, the
roll-off or sale of an existing
portfolio, the issuance of
regulatory capital instruments and
other strategic corporate actions.
80 FCT_REPORTING_GROUP_OUT | Fact Reporting Group | This entity stores the outputs at Processed
PUT Output Reporting Group Level.
81 FCT_STANDARD_ACCT_HEAD Fact Standard This table stores the data as per Processed
Accounting Head the standard accouning heads.
82 FCT_CARDS_BALANCE_SUMMA | Fact Cards Balance This table stores the cards Staging
RY Summary summary details of cards like eop
bal, interest rate, current payment,
and others against card balance
category.
83 FCT_PFT_ACCOUNT_SUMMAR Fact PFT Account This table stores the account level | Processed

Y

Summary

measures computed by the PFT

application.
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3.2 Mapping of Results to Reporting Requirements of Lombard Risk

Figure 24 explains the flow of data between OFSAA and AgileREPORTER:
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Figure 24: Data Flow between OFSAA and AgileREPORTER

OFSAA provides the data to AgileREPORTER in the form of derived entities. Derived entity is an existing
OFSAA higher order metadata object and can be physicalized as a materialized view in the database.
Derived entities store aggregated data from base fact entities specified in the dataset and have the
necessary dimensions and measures. Dimensional and measure combination stored within the derived
entity is mapped to cells within the report. This mapping is maintained within the ‘Dimensional mapping’
template. ‘Decision Process’ within AgileREPORTER reads the derived entities and dimension mapping
information to derive the data for reporting. Derived entities are created based on measures, hierarchies,
and datasets.

Decision Agile
Process REPORTER

Figure 25: Decision Process in AgileREPORTER

Some cells in the schedule can be derived as per the logic provided by the regulator. Derivation can be
an expression built using values from other cells. Examples of derivation are ratio, node-level rollup,
direct reference to cells in other schedules within the report. These derivations are performed within the
AgileREPORTER. OFSAA provides data only for the cells that are not derived.
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Note: Metadata for data transformation is available as part of the data ware house configuration pack
provided Out-of-Box / pre-configured from OFSAA. You need not perform any mapping for the reports.
However, this information can be useful for maintainance or extensions when Out-of-Box pack is not
available.

3.3 AgileREPORTER: Submission

The AgileREPORTER is a web-based regulatory reporting tool provided by Lombard Risk. It provides
necessary features to address e-filing workflow, validation and submission process, and supports reports
(called as forms/returns) for various jurisdictions. AgileREPORTER provides a reliable and efficient
infrastructure to compile, generate, and submit regulatory reports.
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4 OFSAA Features

This chapter provides an understanding of the AAI components used in the solution and dimensional
mapping. It includes:

e OFSAA Infrastructure

e Business Metadata

e Derived Entity
¢ Rules Run Framework Features

¢ Dimension Mapping

Regulatory Reporting (REG REP) Solution configures the data hand off structure to Lombard using
metadata. The following sections provide details on datasets, measures, hierarchies and Derived Entities.
Multiple derived entities are linked to a specific regulatory schedule. You can modify the configuration
using OFSAA infrastructure. Additionally, metadata route provides traceability from reporting elements to
the data elements used.

4.1 OFSAA Infrastructure

OFSAA Infrastructure includes the facilities for creating and maintaining dimensional reference data,
interest rate and currency exchange rate data, and process tuning data. Additionally, OFSAA
Infrastructure includes functionality for building and maintaining rules that can be used by any Oracle
Financial Services Analytical Application. These common rule objects include:

e Expressions

e Hierarchies

o Filters
The analytical applications that you see on the Left Hand Side (LHS) of the Financial Services

Applications home page depends on your logon privileges and on the OFSAA modules that are installed
for your environment.
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Figure 26: Landing Page

4.2 Business Metadata

In addition to Derived Entity, REG REP uses the following OFSAA features to create the business
metadata. For details on the features, refer to OFS Analytical Applications Infrastructure User Guide in
OHC documentation library.

e Hierarchies: Some OFSAA dimensions support hierarchies. Hierarchies can be used to provide
sophisticated stratification for either processing or reporting purposes. For example, an
organizational hierarchy can start with a Division level containing Western Region, Eastern
Region, and Southern Region; the next level down within the hierarchy can be state or county. A
product hierarchy can begin with branches for Asset vs.Liability vs. Service products; under the
Asset branch, you can define additional branches for Mortgage Lending, Commercial Lending,
Consumer Lending, and so on.

e Measures: Business Measure refers to a uniquely named data element of relevance which can
be used to define views within the data warehouse. It typically implies aggregated information as
opposed to information at a detailed granular level that is available before adequate
transformations.

e Business Processor: It refers to a uniquely named data element of relevance which can be used
to define views within the data warehouse. It typically implies aggregated information as opposed
to information at a detailed granular level that is available before adequate transformations.

o Datasets: It refers to a group of tables whose inter-relationship is defined by specifying a join

condition between the various tables. It is a basic building block to create a query and execute on
a data warehouse for a large number of functions and to generate reports.
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4.3 Derived Entity

It is the primary component of OFSAA used for OFSDF Interface with Lombard Risk for US FED.
Regulatory Reporting (REG REP) Solution uses Derived Entity to create physical materialized view which
is then queried by Lombard using pre-set data hand-off templates. An Entity refers to a table in which
data is stored. Derived Entity within the infrastructure system facilitates you to define entities which are
populated through a series of data transformation processes resulting from an existing Data Set or a
Source Application. An Entity can be used to define other Business Metadata such as measures,
hierarchies, dimensions, data sets, and cubes.

Derived Entities comprise the following:
e Measures
e Hierarchies
e Datasets

Ensure to define the above components within OFSAA before configuring the derived entity, and select
Materialized View property in Derived Entity. This property creates the derived entity as materialized

views.
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Figure 27: Derived Entity User Interface

Derived Entities must have AS_OF _DATE and LEGAL_ENTITY as the mandatory dimensions. Rest of
the structure of the derived entity can vary depending on the dimensions present. A metadata
configuration table is present in AgileREPORTER to link the name of the column in the derived entity and
dimension that is referred in dimension mapping process.
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Derived entities have data for the ‘Final Reporting Run’ only, which is reported to the Regulatory, and are
refreshed for the latest hand-off date.

A metadata configuration table is maintained within AgileREPORTER to capture the derived entities that
supply data for each schedule.

4.3.1 Creation of Derived Entity

Refer to OFS Analytical Applications Infrastructure User Guide in (OHC) documentation library for
detailed steps on creating a derived entity.

4.3.2 User Roles

Following are the user roles for derived entity:

e Reporting Analyst: This user can create, modify, and delete a derived entity.

e Data Analyst: This user can view the derived entities.

4.4 Rules Run Framework Features

OFSDF Interface with Lombard Risk for US FED uses the following Rules Run Framework of OFSAA. For
details on the features refer to OFS Analytical Applications Infrastructure User Guide in OHC
documentation library.

e Rules: Financial institutions require constant monitoring and measurement of risk in order to
conform to prevalent regulatory and supervisory standards. Such measurement often entails
significant computations and validations with an organization’s data. Data must be transformed to
support such measurements and calculations. The data transformation is achieved through a set
of defined Rules.

REG REP uses Rules for reclassification of dimensions.

e Process: A set of Rules collectively form a Process. A Process definition is represented as a
Process Tree. The Process option in the Rules Run Framework provides a framework that
facilitates the definition and maintenance of a Process. By defining a Process, you can logically
group a collection of Rules that pertain to a functional process.

e Run: The Run feature in the Rules Run Framework helps you to combine various components
and/or processes together and execute them with different underlying approaches. Further, run
conditions and/or job conditions can be specified while defining a run.

4.5 Dimension Mapping

Each cell reference is mapped to a set of dimensions and measures. This mapping is documented in
excel and then converted to a Decision table through an offline utility provided by AgileREPORTER.
Decision table is a metadata object within AgileREPORTER that stores the criteria for deriving value for
each cell reference. The metadata is packaged for regulatory report as part of the OFS Risk Regulatory
Solution. Decision table process within AgileREPORTER reads the metadata and derived entity published
by OFSAA to populate data required for returns for the specified date and legal entity.
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The following table is an example of dimension mapping. Each cell reference is mapped to a set of
dimension members and measure. If a dimension is left empty for a cell reference, it indicates that it is not
participating in the mapping process. If there are multiple mappings for a cell reference, then the value of
this cell can come from any of these criteria.

Decision mapping table is processed against the contents of derived entity to reporting data. Each record
of the derived entity is matched against the criteria specified in the decision table to identify the cell
reference and derive return data (such as, cell reference and cell value).

Table 11: Dimension Mapping Example 1

Cell . Branch

?
References Is Derived? Product Type Customer Type Country Measure
BHCK1234 No Real Estate Individuals us Amortized Cost

Loans

BHCK1235 No Eg:rl]SEstate Individuals Non-US Amortized Cost
BHCK9088 Yes
BHCK1598 No Credit Cards Individuals Amortized Cost
BHCK7075 No Foreign Banks Non-US Amortized Cost
BHCK7075 No Sovereign Non-US Amortized Cost

The following table is derived after converting the dimension member and measure names into
corresponding dimension member codes (not surrogate keys) and measure codes. This decision table
mapping is provided for each decision table in excel format as per template. AgileREPORTER converts
the decision table mapping present in excel into configuration entries within their schema.

Table 12: Dimension Mapping Example 2

gz:‘lerences Is Derived? Product Type Customer Type (B:E)?Jnnctrr]y Measure
BHCK1234 No RELO IND us MREGO0001
BHCK1235 No RELO IND Non-US MREGO0001
BHCK9088 Yes

BHCK1598 No cC IND MREGO0001
BHCK7075 No FB Non-US MREGO0001
BHCK7075 No SOV Non-US MREGO0001
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Note: All the dimension member codes that are used in the decision table are preseeded by OFSAA and
cannot be modified. Therefore, if you have other member codes in the dimension, then you must
re-classify them by using re-classification rule post load, or value-code mapping during load.

Decision tables must be prepared closer to the report submission period. In some cases, reclassification
of multiple dimensions which result in a single unified reporting dimension must be performed in order to
address the complexity of decision table. Reclassification rule is defined in OFSAA and packaged as part
of OFSAA Risk Regulatory Reporting (REG REP) Solution.

In some cases, certain sections of the schedule or the entire schedule can be a list of data rows without
any mapping to fixed set of dimension members. For example, Top 20 counterparties, List of Available for
Sale (AFS) - securities. In such cases, since there are no cell references, decision table mapping
specifies the names of dimensions and measures of derived entities in ‘sheet’ column or ‘row’ column of
the template.

Note: As a part of the solution, metadata exists as out of box / pre-configured with installer.
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5 Executing Run through Run Management

Starting from FSDF 8.0.3.1.0 release, we are packaging two out of the box Runs for data loading. Same
can be executed through the Run Management screen. The following are the two runs that are packaged
as part of Installer.

e Financial Services Data Foundation Sourced Run: This Run can be executed once per day for
Data Movement from Staging Area to Results Area for Non-RUN SKEY tables.

e Financial Services Data Foundation Execution Run: This Run can be executed any number of

times per day with each unique RUN SKEY for Data Movement in Run enabled tables.

5.1 Summary and Details Page

Upon initially navigating to Run Management - Run Management, a summary page is displayed showing
all the defined Runs. By selecting a Run or by using search criteria, you can control the set of Runs that
are displayed. This page displays the list of runs defined in the Run Rule Framework (RRF) except those
with Immediate Execution Option Yes in the grid.

5.2 Navigation within the Summary Page

When you first navigate to the Run Management summary page, the Runs defined in the RRF are
presented in a summary grid. The Run Management summary page has two sections:

e Search

e List of Runs

5.2.1 Search Section

Among other properties, each Run possesses a segment, a Run Name, and a Run Type. You may
search on any of these properties in the Search section.

. By X v | usexsny | orsow
ORACLE Financial Services Analytical Applications
ol Iration t jer mer

2 Search | B &

FSDFSEG v Run Name

Figure 28: Search Section
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5.2.2 List of Runs Section

The List of Runs section presents a grid containing all of the Runs that meet your search criteria. This
summary grid offers several icons that allow you to perform different functions when a Run is selected.

To select a Run, click the check box in the first column of the grid.

5221

View: Selecting a single row out of the grid enables the View icon. Clicking the View icon allows
you to view the detailed definition of a Run on a read-only basis. The View icon is only enabled
when a single Run has been selected.

Run Default Parameters: Selecting a single row out of the grid enables you to define the default
parameters of a Run.

Run Execution Parameters: Selecting a single row out of the grid enables you to define the
execution parameters of a Run.

Run Execution Summary: Selecting a single row out of the grid enables you to view the status
of the Run executed in the Run Execution parameters window.

List of Runs Summary Grid

The following columns categorize each Run in the summary grid:

Run Name: Displays the short name of the Run.

Run Type: Displays the type of Run, Simulation or Baseline Run.
Created By: Displays the name of the User who defined the Run.
Creation Date: Displays the date on which the Run was created.

Last Modified By: Displays the name of the user who has performed any modifications to the
Original Run details.

Last Modified Date: Displays the date on which the Original Run details were modified.

5.2.3 Navigation within Run Default Parameters Window

Click Run Default Parameters icon on the navigation bar of the Run Management Summary Window to
input the Run level parameters. The Run Parameters Window is displayed.

ancial Services Data Foundation

2 Search

Segment

> Run Management > Run Management

Run Management Summary

===

Run Type Created By Created Date Last Modified By Last Modified Date
BASELINE RUN | SYSADMN 12/09/2016 OFSAD 12/09/2016

BASELINE RUN | SYSADMN 121092016

Figure 29: Run Management Summary
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NOTE: To modify or view the parameters, the Modify Run Parameters role should be mapped to that
relevant user profile.

This window consists of two sections Run Details and Run Execution Parameters.

5.2.3.1 Run Details Section

This section displays the name of the Run which is a read-only value.

5.2.3.2 Run Execution Parameters Section

In this section, you can update the following:

e Reporting Currency: Reporting Currency Code parameter is used for calculation of amounts in
Reporting Currency during Data Population.

e Legal Entity: Legal Entity Code parameter is used for identifying the legal entity, which is used
for the Run.

2 o Run Details

Run Name Financial Services Data Foundation Execution
Run

=+ Run Execution Parameters

Reporting Currency * =

Legal Entity ‘M‘ I
| save | [ cose |

! |

Figure 30: Run Parameters Window

Before proceeding further, to ensure that you do not lose the updated data, click Save.

NOTE: To get the values for Reporting Currency parameter and Legal Entity parameter, you need to
save the following hierarchies under Save Metadata screen:

e Legal Entity Code for Run (HFSDFO001)

e Reporting Currency Code for Run (HFSDF002)

NOTE: For further details on Save Hierarchy, refer to Oracle Financial Services Advanced Analytical
Applications Infrastructure Application Pack 8.0.3.0.0 on OHC.
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The values selected for reporting currency and Legal entity for the selected Run is shown as the default
selected value in the Run Execution Parameters screen.

5.2.4 Navigation within Run Execution Parameters Window

Click Run Execution Parameters icon on the navigation bar of the Run Management Summary window.
The Run Execution Parameter window allows you to enter and save the Run execution parameters.

2 =k Run Details
Financial Services Data Foundation Sourced
Run Name
Run
# == Run Execution Parameters
Reporting Currency * fisesy]
Legal Entity -
FIC MIS Date * , i
Run Execution Description Source Run
l Save l | Execute ] l Close ‘|
A Audit Panel
Created By SYSADMN Created Date 12/09/2016
Last Modified By - Last Modified Date -

Figure 31: Run Execution Parameters Window

The Run Execution Parameters window consists of two sections Run Details and Run Execution
Parameters.

5.2.4.1 Run Details Section

This section displays the name of the Run which is a read only value.

# == Run Details

Reconciliation Difference Calculation
Run Name

Figure 32: Run Details
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524.2

Run Execution Parameters Section

The following Run execution parameters can be updated:

Reporting Currency: Reporting Currency Code parameter is used for calculation of amounts in
Reporting Currency during Data Population.

Legal Entity: Legal Entity Code parameter is used for identifying the legal entity, which is used
for the Run.

FIC MIS Date: Enter the extraction date in this field.

Run Execution Description: Enter a longer description of the Run.

NOTE: To get the values for Reporting Currency parameter and Legal Entity parameter, you need to

save the following hierarchies under Save Metadata screen:
Legal Entity Code for Run (HFSDF001)
Reporting Currency Code for Run (HFSDF002)

By clicking the Save button; a batch with the defined Run execution parameters is created. The batch

created

can be executed from the Batch Execution screen.

By clicking the Execute button, a batch with the defined Run execution parameters is created and
executed immediately. Status of the executed run can be seen in Batch Monitor screen or Run Execution
Summary page.

NOTE: For further details on Save Hierarchy and Batch Execution, refer to Oracle Financial Services

Advanced Analytical Applications Infrastructure Application Pack 8.0.3.0.0 on OHC. To execute
a Run, the execute run role should be mapped to your user profile. Currently, the users

mapped under FSDF Admin or FSDF Operator User Groups automatically have this role.

5.2.5 Navigation within Run Execution Summary Page

Perform the following to view the Run Execution Summary.

Select a Run from the Run Management Summary page and click Run Execution Summary icon.

Financial Services Data Foundation > Run Management > Run Manag
Run Management Summary
2 Search | & |

Segment [UsFEDSEG v] Run Name

Run Type BASELINE RUN v]

2 List of Runs | B =% F1to10f1
Run Name Run Type Created By Created Date Last Modi Last Modified Date

[~} US FED Run BASELINE RUN OFSAD 04/12/2017 OFSAD 04/12/2017

Figure 33: Run Management Summary
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The Run Execution Summary page is displayed with the following sections.

Run Execution Summar, v

Figure 34: Run Execution Summary

This section consists of the two sections Run Execution Summary and Run Execution Details.

5.2.5.1 Run Execution Summary Section

The Run Execution Summary displays the following details:
¢ Run Name: Displays the name of the Run.
e Run Type: Displays the type of Run, Baseline or Simulation.

¢ Run ID: Displays the Run Execution ID.

5.2.5.2 Run Execution Details Section

The Run Execution Details section presents a grid containing all of the executions of Run and status of a
particular execution of the Run. The menu bar in this grid offers several icons that allow you to perform
different functions when a Run Execution is selected. To select a Run Execution, click the check box in
the first column of the grid. More than one Run Execution can be selected at a time but this will cause

some of the icons to become disabled.

e Parameter details: Click this icon to view the Run execution and Run default parameter details in

read-only mode.

e Copy: Click Copy icon, to copy the parameters as defined in the Run Execution Parameter

window to create a new batch.

e Execute: Click Execute icon to trigger the batch which has been created from the Run Execution
Parameter window. The status of the triggered batch is displayed. In the Execution Summary

page, multiple selections of the execution IDs are available to trigger a batch.

e Request Report Flag: To request for a Report Flag, select a Run Execution ID in the Run
Execution Summary page and click Request for Reporting Execution icon. A dialog box

appears to input your comments.
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Click Submit and the status of this Run is displayed in the Report Flag section. Only a successful
execution can be requested for reporting. For the selected Run and Execution date, there can be
only one reporting flag.

Override Report Flag: Any reporting execution can be overwritten with another execution. Select
a successfully triggered batch in the Run Execution Summary page. The Override Report Flag
icon is enabled, if an execution is already marked as a Report Flag. You can override the
execution by updating your comments. This should be approved by the approver and the
procedure is similar to the procedure detailed in the Approve Report Flag section.

Approve Report Flag: After submitting the Reporting Run in the earlier section, the Approve
Report Flag icon is enabled. After clicking the icon, a dialog box with the User Comments and
Approver Comments is displayed. The Approver can update the comments in the Approver
Comments field and then click Approve or Reject button accordingly.

th

GENE
Reporting flag [ Approve Report flag i:tiu:un
- BASEL RRR TEST1

Figure 35: Approve Report Flag

5.2.5.3 Run Execution Grid

The Run Execution Details displays the following details:

Run Skey: Displays the Run skey of an individual execution.

Run Execution ID: Displays the execution ID of the Run.

FIC MIS DATE: Enter the extraction date in this field.

Execution Status: Displays the status of the execution which is failed or complete.
Execution Date: Displays the date when the Run was executed.

Time of Execution: Displays the time when the Run was executed.
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6 Integrating OFSAA Processing Applications with OFS REG REP
USFED

Regulatory Reporting uses processing output of each application. Customers who have licenses for the

OFSAA

applications can use the out-of-the-box integration to load the results area designed in OFS Data

Foundation for each application output.

6.1 BASEL USFED Integration for Report Submission in OFS REG REP USFED

For Basel USFED integration, you must have OFSDF Basel and REG REP USFED installesd on the
same INFODOM. Also, you must ensure that OFSDF and Basel are running the same version.

There are two ways to integrate Basel and OFS REG REP USFED:

1.

Creating Integrated Run at Implementation Site

During implementation, you can merge the tasks of both BASEL and REG REP USFED and
create an integrated Run to execute each time. The processes inside Run should be ordered as
Basel first, then REG REP USFED, and finally the Basel REG REP USFED Integration process.
In this Run, the Basel processing area and the FSDF results area tables must have the same
Run SKEY across all tables.

NOTE:

For BASEL-USFED Integration Run, please use the FSDF Run Management screen as the
Request Report Flag, Override Report Flag, and Approve Report Flag options are not
available in the Basel Run Management Screen to enable the Reporting Flag.

Using approved Basel Run Execution ID in USFED Run

In this case, you can use the out-of-the-box Basel Run as is for execution. After the execution, if
the values are correct, you can execute the out-of-the-box REG REP USFED Run by selecting
the required Basel Run SKEY from Run Management screen. In this case, Basel processing area
has one RUN SKEY and for the same data, REG REP USFED has a diffferent RUN SKEY in
FSDF results area tables, where the data is getting reported.

Sample report generation is as follows:

a. Login to Oracle Financial Services Analytical Applications interface with your credentails.
b. Navigate to Applications - Financial Services Data Foundation = Run
Management - Run Management
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ORACLE Financial Services Analytical Applications

Applcat

Select Apphc

B2

B Ak | sl
R Type Createa by Created Oste Last Mocites by LovtModites Dste

CESSSOD

Figure 36: Run Management

c. Selectthe Run and click Run Execution Summary icon.

d. The Run Details and Run Exectution Parameters Window is displayed.

4 S Run Details

Run Name US FED Run

4 s Run Execution Parameters
Reporting Currency * UsD [n]

Legal Entity fiic]

Consolidation Type C v‘

Consolidation Hi Default Org Structure Hierarchy [ene]

| Basel Run Execution identiier | R
I~

FIC MIS Date * =

Run Execution Description

save | | Execute | | Close
luGite,

# Audit Panel
Created By OFSAD Created Date 0411212017
Last Modified By OFSAD Last Modified Date 04/12/2017

Figure 37: Run Name and Run Execution Description

e. Enter the Run Name and Run Execution Description. The Basel Run Execution
Identifier and FIC MIS Date is auto-populated from the Basel Run report used.
f. Click Execute.

NOTE: Resave Heirarchy HFSDF004 after Basel execution for getting values in this
Basel Run Execution Identifier.
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4« Search

Vx Hierarchy

Hierarchical

Available Hierarchies Selected Hierarchies

[£}-Basel Run Execution Identifier for Run

r-Financial Services Data Foundation Execution

T Run

r¥-Financial Services Data Foundation Sourced

T Run

(L.US FED Run P
[-US FED Run

;USA - US Il - Capital Calculation - FRB S

P
=homAxdvanced

[ Basel Hun - BASEL US STD Non ADV Bank
for Run Skey : 2
{ _Basel Run run for Run

Skey : 1

{_Basel Run : BASEL US test 12042017 test3
for Run Skey : 8

{Basel Run : US 04112017 test1 for Run
Skey : 4

| _Basel Run : US 11042017 test2 for Run
Skey: 5

i _Basel Run : US RUN 11042017 for Run
Skey:3

[ox]

Figure 38: Basel Run Details

g. Select only one Basel Run from the Available Heirarchies for the execution and click

OK.
The Run Management Summary Window is displayed.

Financial Services Data Foundation > Run Management > Run Management

Run Management Summary

4 Search

Segment USFEDSEG v Run Name

Run Type | BASELINE RUN v

» List of Runs | B S orgp | sitoiori
Run Name Run Type Created By Created Date Last Modifie

] US FED Run BASELINE RUN OFSAD 04122017 OFSAD

Figure 39: Run Management Summary

| BB |

Last Modified Date V.
041222017
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7 Metadata Export Utility

The Metadata Export Utility helps the user to export OFSAA metadata into Excel Sheet. This feature
helps to get a view of OFSAA metadata and its dependencies. It is a template based approach where-in
user creates templates and selects Metadata Objects that need to be extracted. The extraction process is
supported only for Excel Sheet. While defining the template, user is expected to have prior knowledge of
the OFSAA Metadata objects that are relevant from his application point of view.

7.1

Prerequisites

The following executions must be performed before using the Metadata Export Utility:

1.

MDB Publish: Execute the batch, INFODOM_MDB
Logs: MDB logs are generated under deployed area /Context_Name/logs/MDB_XXXX.log

Data Elements Wrapper Execution: After MDB Publish is completed succesfully with message
“Metadata publishing is finished.” in the /Context_Name/logs/MDB_XXXX.log, you must execute
the Data Elements Utility with the following seeded batch to get the Data Lineage for each
Metadata in OFSAA:

<INFODOM>_POP_DATA_ELEMENTS_USFED
Parameters used in DATA_ELEMENTS Batch

The batch can be executed in different modes according to each requirement. The following are
the parameters used for executing the batch.

NOTE: This execution requires adequate tablespace. Ensure that your Atomic Schema is
having enough tablespace in TEMP and USERS.

You can edit the parameters by accessing the Batch Maintainance screen.

h. Login to Oracle Financial Services Analytical Applications interface with your credentails.
i. Navigate to Applications - Financial Services Data Foundation = Operations >

Batch Maintenance

vices Data Fol ion > Operation atch Maintenance

Batch Maintenance

Search B

Batch ID Like FSDFINFO_ Batch Description Like

] And

Module [ v Last Modification Date Between = =

»Batch Name | mE¥W®E | = 71-80/138
[ Bateh 1o 4 Batch EditNon Edit

[] FSDFINFO_PARTY_FINANCIAL_DATA_POP £

[] FSDFINFO_PA ATA_POP_EC

[] FSDFINFO_POP_HIERAR
[] FSDFINFO_POP_KEY_DIMENSION_S{
[] FSDFINFO_PRODUCT_PROCESSORS
[] FSDFINFO_RATES

mimimm|m|m|{mmm

»Task Details | BER® | s
| TaskiD & Task Description Metadata Value Component ID ‘Pvecedence
M Taskt Populates Data Elements for USFED Fn_Data_Elements_Wrapper TRANSFORM DATA

Figure 40: Batch Maintenance
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j. Select Batch Name (<INFODOM> POP_DATA_ELEMENTS_USFED)
k. Select Taskl and click the Edit button. The Task Definiton Window is displayed.

»Task Definition

Task Definition

Last modified by

Populates Data Elements for USFED

Last Modification Date

Task ID Task1 Description
Components [TRANSFORM DATA V]
»Dynamic Parameters List
Property [ value
Datastore Type [EDW v|
Datastore Name ‘ FSDFINFO v‘
IP Address [10.184.135.172 v
Rule Name [Fn_Data_Elements_Wrapper v|
Parameter List Y.V 'N''N''FSDFINFO''USFEDSEG''OFS_R
Save ‘ j Close
» Audit Panel
Created By OFSAD Creation Date 24 mar 2017 15 :29 :37

24 mar 2017 15 :29 :37

Figure 41: Task Definition

I.  Modify the Parameter List field as applicable.

NOTE: The values must be in single quotes and comma separated for each value.
Follow the same order as in this table.

SI. No. | Parameter Description List of Values Default Value
1 P_METADATA FLAG Metadata Parser Flag | Y/N Y’
2 P_REPORT_FLAG Report Parser Flag YIN Y’
3 P_MDR_USAGE_FLAG | Usage Parser Flag Y/N ‘N’
Metadata to DataFlow
4 P_MDR_MD_DF_FLAG YIN ‘N’
Flag
<Value of the
Infodom where
USFED is
5 P_INFODOM_NAME Infodom Name ##INFODOM## |
installed>.
For example:
‘USFEDINFO’
<Value of
Segment Code
6 P_SEGMENT_CODE Segment Code #HSEGMENT## g
which is used
while installing
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Sl. No.

Parameter

Description

List of Values

Default Value

USFED>.

For example:.
‘USFEDSEG’

P_REG_APP_ID

Application Identifier

#HAPPID##

Application ID
for US FED.

For example:
‘OFS_REG_R
EP_USFED’

e Metadata Parser Flag (P_METADATA_FLAG): By enabling this flag, the data
elements utility parses all the Business Metadata like Business Hierarchies, Business
Measures, Business Processes, Derived Entities, Datasets, Aliases and its lineage
between them. It also parses Data Flow Metadata like T2Ts, SCDs, Rules, and the
lineage between them.

e Report Parser Flag (P_REPORT_FLAG): By enabling this flag, the data elements
utility parses all the Dashboards, Reports, Schedules, Views, and join these outputs
with the Metadata which are already parsed through the Metadata Parser Flag
(P_METADATA_FLAG).

NOTE:

Even if this flag is enabled, the Dashboards which get parsed depend on

the FSI_DE_POP_REPORT_LIST table in Atomic Schema. By default, all
Dashboards are enabled and if you wish to parse particular Dashboards,
modify the FSI_DE_POP_REPORT_LIST table by enabling / disabling the
“Include Report Column”. The following are the default Dashboards

packaged.
DASHBOARD ID JURISDICTION CODE REPORT CODE INCLUDE REPORT
1 USFED FRY-9C Y
2 USFED FRY-9LP Y
3 USFED FFIEC-009 Y
4 USFED FFIEC-009a Y
5 USFED FRY-15 Y
6 USFED FRY-20 Y
7 USFED FRY-12 Y
8 USFED FRY-11 Y
9 USFED FRY-11s Y
10 USFED FR-2314 Y
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DASHBOARD ID JURISDICTION CODE REPORT CODE INCLUDE REPORT
11 USFED FR-2314s Y
12 USFED FR-2052A Y
13 USFED FR-2052B Y
14 USFED FRY-14Q Y
15 USFED FRY-14A Y
16 USFED FFIEC-031 Y
17 USFED FR-2886B Y
18 USFED FFIEC-041 Y
19 USFED FRY7N Y
20 USFED FFIEC101 Y
21 USFED FR-2900 Y
22 USFED FDIC-8020 Y
23 USFED FRY-14M Y
24 USFED FR-2644 Y

NOTE: After the Metadata Parsing is completed and if there are no further
changes in Business Metadata and Data Flow Metadata, you can execute
the batch by disabling the Metadata Parser Flag (P_METADATA_FLAG).
Now the Metadata is not parsed again, but the Report newly enabled
through FSI_DE_POP_REPORT_LIST table is parsed.

If there is a change in Business Metadata and Data Flow Metadata, you
need to enable the Metadata Parser Flag (P_METADATA_FLAG) and
parse once again.

e Usage Parser Flag (P_MDR_USAGE_FLAG): By enabling this flag, the data
elements utility parses all the Entities and joins these outputs with the Metadata
which are already parsed through Metadata Parser Flag (P_ METADATA_FLAG).

e Metadata to DataFlow Flag (P_MDR_MD_DF_FLAG): By enabling this flag, the
data elements utility joins all the Business Metadata parsed output with Data Flow
parsed output for all applications.

e Infodom Name (P_INFODOM_NAME): This is the value of the Infodom where
OFS_REG_REP_USFED is installed. No need to modify this value.

e Segment Code (P_SEGMENT_CODE): This is the value of the Segment Code
which is used while installing OFS_REG_REP_USFED. No need to modify this value.

e Application Identifier (P_REG_APP_ID): This is the application identifier of the
product (OFS_REG_REP_USFED). No need to modify this value.
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Verifying Logs

Data Elements logs are generated in Atomic Schema under the FSI_MESSAGE_LOGS table.

Flag

Batch Run ID

Indication

P_METADATA_FLAG

METADATA_ELEMENTS

Processes Business Metadata.

The message “Completed Over ALL
Metadata” indicates that the Business
Metadata parsing is complete.

P_METADATA_FLAG

ULTIMATE_METADATA_ELEME
NTS

Calculates Ultimate Table/Column for
Business Metadata.

The message “Completed
ULTIMATE_METADATA_ELEMENTS”
indicates that the Business Metadata
Ultimate elements parsing is complete.

P_METADATA_FLAG

DATA_FLOW_ELEMENTS

Processes Data Flow Metadata.

The message “Completed Elements for
DATA_FLOW_ELEMENTS” indicates
that the Data Flow Metadata parsing is

complete.

P_METADATA_FLAG

ULTIMATE_DATA_FLOW_ELEM
ENTS

Calculates Ultimate Source
Table/Column for Data Flow Metadata.

The message “Completed
ULTIMATE_DATA_FLOW_ELEMENTS
” indicates that the Data Flow Metadata
Ultimate elements parsing is complete.

P_METADATA FLAG

POP_MDR_LINEAGE_METADAT
A

Links Data Flow Metadata Lineage with
Metadata Browser.

The message “Completed
MDR_METADATA Data Flow” indicates
that the Metadata Lineage parsing is

complete.

Oracle Financial Services Software

106




OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack

User Guide, Release 8.0.3.1.0

Flag

Batch Run ID

Indication

P_REPORT FLAG

REPORT_ELEMENTS_OFS_RE
G_REP_USFED

Processes Dashboard Elements from
FSI_M_CELL_DIM_VAL and
FSI_M_CELL_DEFN.

The message “Completed
REPORT_ELEMENTS for
OFS_REG_REP_USFED’ indicates
that the Dashboard Metadata parsing is
complete.

P_REPORT_FLAG

REPORT_TO_TARGET _MAP_O
FS_REG_REP_USFED

Processes Dasbboard with Processed
Business Metadata.

The message “Completed
REPORT_TO_TARGET_MAP for
OFS_REG_REP_USFED” indicates
that the Dashoboard to Business
Metadata parsing is complete.

P_REPORT_FLAG

REPORT_TO_SOURCE_MAP_O
FS_REG_REP_USFED

Processes Dasbboard with Processed
MDR Lineage.

The message “Completed
REPORT_TO_SOURCE_MAP for
OFS_REG_REP_USFED” indicates
that the Dashboard to Data Flow

Metadata parsing is complete.

P_REPORT_FLAG

POP_FINAL_ELEMENTS_OFS_
REG_REP_USFED

Processes Final Data Elements for
USFED.

The message “Completed
POP_FINAL_ELEMENTS for
OFS_REG_REP_USFED’ indicates
that all the Dashboard related Metadata

parsing is complete.

P_MDR_USAGE_FLAG

DATA_FLOW_USAGE

Processes Data Flow Usage.

The message “Completed Elements for
DATA_FLOW_USAGE” indicates that
the Data Flow Usage Metadata parsing
is complete.
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Flag

Batch Run ID

Indication

P_MDR_USAGE_FLAG

ULTIMATE_DATA_FLOW_USAG
E

Calculates Ultimate Table/Column
Usage for Data Flow Metadata.

The message “Completed
ULTIMATE_DATA_FLOW_USAGFE”
indicates that the Data Flow Ultimate

Usage Metadata parsing is complete.

P_MDR_USAGE_FLAG

POP_MDR_LINEAGE_METADAT

A

Links Data Flow Usage Lineage with
Metadata Browser.

The message “Completed
MDR_METADATA Data Flow” indicates
that the Data Flow Usage MDB
Metadata parsing is complete.

P_MDR_MD_DF_FLAG

METADATA_TO_DATAFLOW

Processes Parsed Business Metadata
joined with Parsed Data Flow Metadata.

The message “Completed
METADATA_TO_DATAFLOW”
indicates that the Business Metadata to
Data Flow Metadata parsing is
complete.

Validating Lineage Outputs

In Atomic Schema, you must verify that data is present in the following tables and ensure that the

table is populated:

e MDR_LINEAGE_METADATA
e FSI DE_REPORT_SOURCE_DETL_MAP
¢ MDR_USAGE_METADATA (Optional, data is populated only if P MDR_USAGE_FLAG

is enabled.)

e FSI_DE_METADATA_SOURCE_DETAILS (Optional, data is populated only if
P_MDR_MD_DF_FLAG is enabled.)

7.2

Create and Export Metadata Report Templates

Perform the following steps to create and export the Metadata Report Templates:

1. Navigate to Object Administration - Utilities > Metadata Report.
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ORACLE Financial Services Analytical Applications

Applications | Object Administration  System Configuration & Identity Management
Select Information Domain Financial Services Analytical Appicat ort
FSDFINFO Search and Filler  ©) Go < Cleal
P S T e E | e Tegs
4 8 Object Administration —
Template List (1) 74 Ada
T — Temoiate ams Temciats Dssergoon m—— m——
4 G usies <l b
B Metadata Difference
o Metadata Authorization
2. Click Add icon, in Summary screen, to create a new Metadata Report Template.
Financial Services Analytical Apy re > Object Administration > Utilittes > Metadata Report
+ Search and Filter ) Go ) Clear ) Refresh
Template \ | Template | \
D Name
¥ Template List (
Template D ¥ Templaie Name Template Description Created Date Created By
[] 223483 sample 04-01-2017 OFSAD
< I >
3. Provide the Name and Description for the new template in Template Definition page.
Template Definition
< Back L] Next >
Definition Choose Object type Filter Objects Revie
Definition
Basic Details
Name NDfTest x
Description Tester
@ Save ¥ Return
4. Select the desired object from the Object Type dropdown to be exported.

Individual report generates only the basic properties of the object selected, that is, name and

description. Relational report

generates detailed information up to the Entities level, if
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Dependencies is chosen; and up to the Staging Columns level, if Data Lineage is selected along
with Dependencies.

Dependencies: Metadata object is dependent on several other metadata objects. Metadata
object is also used (that is, consumed) in several other metadata objects. Dependency or usage
tree can be of any depth. For example, a rule can be dependent on a hierarchy, business
processor, and dataset. Further, each of these metadata objects can be dependent on other
metadata objects. Metadata Export Utility exports all the dependent or used metadata objects for
all paths in the dependency or usage tree, if this option is selected.

Lineage: Data is loaded from source systems to staging and then moved across to processing /
reporting. Lineage traces the data element as it moves across different layers of OFSAA: staging,
processing, and reporting. Metadata Export Utility exports the lineage of each of the reporting
area data element that is identified by dependencies.

For Individual: In the Export Options, do not select Dependencies or Data Lineage.

Financial Services Analytical Applications Infrastructure > Object Administration > Utiities > Metadata Report

Template Definition

Back O L4 L Next
Definition Choose Object ty Filter Objects
Choose Object type

Object Types

Choose  pashboard

Export Options

Dependencies

Data Lineage

& Save Return

The exported sample report for Individual is as follows:

A B c D E F
1 [CLASSIFICATION RULE DEF ICLASSIFICATION_RULE_NAME CLASSIFICATION_RULE_DESC
2 1465916940587 RRDF - 14Q FRY 9C Line Re- Classification RRDF - 14Q FRY 4C Line Re- Classification
3
4
5
6
7
8
9
10
11 -
4 4 b | Classification Rule %] [ m 0.
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For Relational: In the Export Options, select Dependencies.

Financial Services Analytical Applicat Infrastr re > Object Admini: > Utilities > Metadata Report
Template Definition
< Back ) L4 % Next >
Definition Choose Object ty... Filter Objects
Choose Object type
Object Types
Choose | Dashboard X
Export Options
Dependencies (:l
Data Lineage
@& Save P Retun
The exported sample report for Relational is as follows:

A B c D E E G H Kl
1 [Path Name IDependency =~
2 Path1 Dashboard = Report > View > Hierarchy = Entities =
3 Path2 Dashboard » Report > View > Derived Entity > Measure > Entities >
4 Path3 Dashboard > Report = View = Derived Entity > Hierarchy > Entities >
5 Pathd Dashboard = Report > View > Derived Entity > Dataset > Alias > Entities >
6 PathS Dashboard > Report > View = Derived Entity > Dataset > Entities >
7 Pathé Dashboard » Report > View > Derived Entity > Business Processor > Measure » Entities >
g Path? Dashboard > Report > View = Derived Entity > Business Processor > Dataset > Alias > Entities >
9 Pathg Dashboard » Report > View > Derived Entity > Business Processor > Dataset » Entities >
10 Pathd Dashboard > Report > View = Reporting Element > Measure > Entities = |
11 |Path10 Dashboard = Report = View > Reporting Element > Hierarchy > Entities = 1
12 Path11 Dashboard = Report > View > Reporting Element > Derived Entity > Measure = Entities >
13 |Path12 Dashboard = Report = View > Reporting Element > Derived Entity > Hierarchy > Entities =
14 Path13 Dashboard » Report > View > Reporting Element = Derived Entity > Dataset > Alias > Entities >
15 Path14 Dashboard > Report = View > Reporting Element > Derived Entity > Dataset > Entities >
16 Path1s Dashboard » Report > View > Reporting Element = Derived Entity > Business Processor > Measure > Entities =
17 Path16 Dashboard = Report = View > Reporting Element > Derived Entity > Business Processor = Dataset > Alias = Entities >
18 Path17 Dashboard » Report > View > Reporting Element = Derived Entity > Business Processor > Dataset » Entities >
19 Path1g Dashboard > Report > View > Reporting Element > Business Processor > Measure > Entities >
20 Path19 Dashboard > Report > View > Reporting Element > Business Processor > Dataset > Alias > Entities » W
21 Path20 Dashboard > Report > View = Reporting Element > Business Processor > Dataset > Entities >
22 |
4 v w| paths /Pathl  Patha , Patha  Pathd  Paths . Pathe . Path7  Pathe . Pachi Il Im ] 0.z

The first sheet shows the different Paths and their Dependencies upto the Entities level. Select
the required Path sheet at the bottom to view the dependencies.

Each path tells how the dependency/usage is derived from dashboard to entity or vice versa
involving various OFSAA object types like Derived Entity, Hierarchies, Datasets, Measures, and

SO on.

These paths are generated by the system using data already published in MDB dependency
tables as part of OFSAA MDB object publish.

For every dependent object type displayed in each path sheet, the following columns are
displayed:
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e Object type name

e Object type description

e One or many Object specific properties (optional)
For example: In Pathl, Dashboard is the first Object type, the dependencies generated are
Dashboard Name, Dashboard Description, and Dashboard properties: Dashboard Country,
Dashboard Regulator and so on. Similarly, Report is the next Object type in Pathl and the
dependencies generated are Report Name, Report Description, Views Name, Views Description,
View Display Format and so on. Then followed by Hierarchy Objects name, description and
properties up to the Entities level.

A B C D 2 F G H ] J .
1 _NAME _DESC _COUNTRY _REGULATOR REPORT | _DESC VIEWS_NAME VIEWS_DESC VIEW_DISPLAY_FORMAT HIERARCHY_NAME i]
2 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resene [8S [Schedule BS?Balance Sheet FRY-11BS  FRY-118S  Tabular IFRS - Reported at fair Value Flag 1
3 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Foderal Reserve |BSM Schadule BS-M7Memoranda FRY-11.8SM FRY-11.85M Tabular Reg delinquency band Hierarchy
4 FRY-11 Financial Statements of U.S. USA Board of Govemars of the Federal Reserve [BSM Schedule 8S-MMemoranda FRY-11-8SM FRY-11.8SM Tabular Sale type code Hierarchy
5 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Faderal Reseve [BS [Schedule BS7Balance Shest FRY-11-8S  FRY-11.85  Tabular IFRS - Fair Value RCY Hierarchy
6 [FRY-11 Financial Statements of US_ USA Board of Gavemors of the Federal Reserve [iS [Schedule IS7income Stateme FRY-114S  FRY-1145  Tabular Consolidation Code
7 [FRY-11 Financial Statements of U'S. USA Board of Gavemors of the Federal Resenve [IS-8 [Schedule IS-B7Changes in Al FRY-114S-8  FRY-114S-8  Tabular Reporting Line Cade
B_FRY-11 Financial Statements of US. USA Board of Gavemors of the Federal Resee [BS-M [Schedule BS-M7Memoranda FRY-11BSM FRY-11.8SM Tabular Bands hisrarchy
9 FRY-11 Financial Statements of U.S. USA Board of Govermors of the Federal Resene [8S [Schodule 8S7Balance Sheat FRY-11.8S  FRY-11.85  Tabular Oerwvative Type Code Hierarchy
10 [FRY-11 Financial Statements of U S. USA Board of Govemors of the Faderal Resee [BS-M Schedule BS-MMemoranda FRY-118SM FRY-11.8SM Tabular Standard Party Type Hierarchy
11 FRY-1 Financial Statements of U.S. USA Board of Gavemors of the Federal Resee [BS Schedule BS7Balance Sheet FRY-118S  FRY-118S  Tabular Balance Shest Category Hierarchy
12 FRY-11 Financial Statements of US USA Board of Governors of the Federal Reserve |BS [Schedule BS?Balance Sheet FRY-11.8S FRY-118S  Tabular Trading Account Book Type Code H
13 |FRY-11 Financial Statements of U'S. USA Board of Gavemors of the Federal Resenve [IS-A [Schedule IS-A?Changes in ECFRY-111S-A  FRY-114S-A  Tabular Capital Instrument Transaction Typ
14 FRY-11 Financial Statements of US_ USA Board of Gavemors of the Federal Resene [BS [Schedule BS?Balance Shest FRY-11-BS  FRY-11.85  Tabular Non Interest bearing deposit Hisrard
15 | FRY-11 Financial Statements of U'S. USA Board of Gavemors of the Federal Resene [8S-4 [Schedule BS-MMemoranda FRY-11.8S:M FRY-11.85M Tabular Accrual Status Code Hierarchy
16 |FRY-11 Financial Statements of U.SUSA Board of Gavemors of the Federal Resene [BS Schedule BS7Balance Shest FRY-118S  FRY-118S  Tabular Reporting Line Code
17 FRY-11 Financial Statements of U.S. USA Board of Goverors of the Federal Resenve [IS-A [Schedule IS-A?Changes in ECFRY-114S-A  FRY-114S-A  Tabular Iinstrument type Hierarchy
18 |FRY-11 Financial Statements of U S. USA Board of Gavemors of the Federal Reserve [BS-M [Schedule BS-MMemoranda FRY-11.BSM FRY-11.85M Tabular Regulatory Product Classification H|
19 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resenve [BS-A Schedule BS-A7Loans and LeFRY-11-BS-A  FRY-11-85-A Tabular Reg delinquency band Hierarchy
20 FRY-11 Financial Statements of US. USA Board of Gavernors of the Federal Resenve [BS-M FRY-11.85M Tabular Balance Shest Category Hierarchy
21 FRY-11 Financial Statements of US_USA Board of Govemors of the Federal Resenve [BS-M FRY-11.85M Tabular Consolidation Code
22 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Reseve [BS-M FRY-11.8SM Tabular Holding Type Code Hirarchy
23 FRY-11 Financial Statements of U.S. USA Board of Gavernors of the Federal Reserve [8S FRY-1185  Tabular Bands hierarchy
24 FRY-11 Financial Statements of US USA Board of Gavemors of the Federal Resene [8S FRY-118S  Tabular Instrument type Hierarchy
25 [FRY-11 Financial Statements of US_ USA Board of Gavemors of the Federal Resene [BS Schedule BS7Balance Sheet FRY-11-8S  FRY-11.85  Tabular Buy or Sell Indicator Hierarchy
26 FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Reserve [BS-A [Schedule BS-A?Loans and LeFRY-11.8S-A  FRY-1185-A  Tabular Troubled Debt Restructure Flag Hie
27 FRY-11 Financial Statements of U'S_ USA Board of Gavemors of the Federal Resee [8S Schedule BS7Balance Sheet FRY-11.8S  FRY-11.85  Tabular Other Real Estate Owned Flag Hier
28 FRY-11 Financial Statements of U S. USA Board of Gavemors of the Faderal Resenve JIS-8 [Schedule IS-B?Changes in Al FRY-114S-B  FRY-11458  Tabular Consolidation Code
25 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Faderal Reserve [BSM Schedule BS-M?Memoranda FRY-11.BS:M FRY-11.85M Tabular Reg Instrument Classification Hiera
30 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal Reserve [BS-M Schedule BS-MMemoranda FRY-118S-M FRY-118SM Tabular nstrument type Hierarchy
31 FRY-11 Financial Statements of US. USA Board of Gavemors of the Federal Reserve [BS-4 Schedule BS-M7Memoranda FRY-11-BSM FRY-11.85M Tabular Risk Factor type code Hierarchy
32 FRY-1 Financial Statements of US. USA Board of Gaverors of the Federal Reserve [IS-A [Schedule IS-A7Changes in ECFRY-111S:A  FRY-114S-A  Tabular Consolidation for Aggregation
33 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resene [BS-A [Schedule BS-A7Loans and LeFRY-11-BS-A  FRY-11.85:A Tabular Negative Amortization Flag Hierarct
34 FRY-11 Financial Statements of US. USA Board of Gavemors of the Federal Resene [BS-41 [Schedule BS-M7Memoranda FRY-11BSM FRY-11-85M Tabular Customer Country Hierarchy
35 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Faderal Reserve [BS-A Schedule BS-A7Loans and LeFRY-11.8SA  FRY-118SA Tabular Accrual Status Code Flag Hierarchy
3 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve |IS [Schedule IS7ncome Stateme FRY-111S  FRY-114S  Tabular Reparting Line Code
37 FRY-1 Financial Statements of U.S. USA Board of Gavemors of the Faderal Reseve [BS-4 Schedule BS-M7Memoranda FRY-11-BSM FRY-11.85M Tabular Reporting Line Cade
e D e T T T B e s i

A B c D E F G H | J
1 [Path Name lusage
2 Path1 Columns > Hierarchy > View > Report >Dashboard >
3 |Path2 Columns > Measure > Derived Entity > View > Report ~Dashboard >
4 |Path3 Columns = Hierarchy = Derived Entity > View = Report >Dashboard »
5 |Pathd Columns > Measure > Business Processor > Derived Entity > View > Report >Dashboard =
6 Paths Columns > Measure > Reporting Element > View > Report =Dashboard >
7 |Pathé Columns = Hierarchy > Reporting Element > View > Report >Dashboard >
4 Path7 Columns > Measure > Derived Entity > Reporting Element > View > Report >=Dashboard >
9 Pathg Columns = Hierarchy > Derived Entity > Reporting Element > View > Report »Dashboard >
10 Pathd Columns = Measure > Business Processor > Derived Entity > Reporting Element > View > Report >Dashboard >
11 Path10 Columns > Measure > Business Processor > Reporting Element > View > Report >=Dashboard >
12
13
14
15
4 4 » v paths - Pathl . Path2 ~ Path3 - Path4 - PathS . Path6  Path? - Paths - Path{ [Nl m

The first sheet shows the different Paths and their Usage upto the Dashboard level. Select the
required Path sheet at the bottom to view the Usage.
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B C ) E
|COLUMNS_DESC COLUMNS_PHYSICAL_COL ID  HIERARCHY_NAME HIERARCHY_DESC

Transaction Account Flag __ Indicates if saxd account is conside FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account FlagBi
Repurchased Or Indemified Flagindicates if the said account is Rep FCT_LOAN_ACCOUNT_SUMMARY. Repurchased or indermnied Flag Repurchased of Indemnified FlagBi
Impairment Amount Under Asc 3 This column stores the impaiment FCT_L LOAN_/ AECOUNT SUMMARY  Impasr asc31030 Amount Check Impair asc31030 Amount Check BI
Troubled Debt Restructure FlagThis colum indicates if saxd loan isFCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag }Troubled Debt Restructure Flag tBI
Negative Amortization Flag This column stores if loan has nege FCT_LOAN_ACCOUNT_SUMMARY . Negatie Amortization Flag Hiera Negative Amortization Flag HieraBl
Martgage Broker Surrogate Key This stores unique identifer for the FCT_LOAN_ACCOUNT_SUMMARY Broker Skey Hierarchy Broker Skey Hierarchy 8
Cleared Transaction Flag This columas stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hiecarc Cleared Transaction Flag Hierarc 81
Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81
Mark To Market Value In Report This stores the mark to market valuFCT_REG_ACCOUNT_SUMMARY \Mtm Value-FRAS Herarchy Hierarchy Mtm Value-FRAS -]
Broker Surrogate key This stores unique identies for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borowi Broker Hierarchy Deposit Borow 81
Callable Deposit Indicator Indicates if said deposit can be call FCT_DEPOSITS_BORROWINGS F_Deposit Option Indicator Hierarct Deposit Option Indicator Hierarct BI
Impairment Amount Under Asc 3 This column stores the impament FCT_LOAN_ACCOUNT_SUMMARY Impas asc31030 Amount Check Impair asc31030 Amount Check B
Troubled Dett Restructure Flag This column indicates if sad loan is FCT_LOAN_ACCOUNT_SUMMARY . Troubled Debt Restructure Flag F Troubled Debk Restructure Flag 61
Troubled Debt Restructure Flag This column indicates if said loan iFCT_LOAN_ACCOUNT_SUMMARY Troubled Debt Restructure Flag HTroubled Debt Restructure Flag #81
Troubled Debt Restructure Flag This column indicates if said loan icFCT_LOAN_ACCOUNT_SUMMARY. Troutled Debt Restructure Flag t Troubled Debt Restructure Flag 81
Negative Amortization Flag This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY Negative Amortization Flag Hiera Negative Amortization Flag Heera BI
Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81
Mark To Market Value In Reporti This stores the mark to market valuFCT_REG_ACCOUNT_SUMMARY \Mtm Value-FRAS Hierarchy Hierarchy Mtm Value-FRAS Bl
Broker Surrogate key This stores unique identder for the FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Borows Broker Hierarchy Deposit Borow BI
Troubled Dett Restructure Flag This column indicates if said loan i FCT_LOAN_ACCOUNT_SUMMARY Troubled Debt Restructure Flag t Troubled Debt Restructure Flag t 81
Martgage Broker Surogate Key This stores unique identier for the FCT_LOAN_ACCOUNT_SUMMARY . Broker Skey Hierarchy Broker Skey Hierarchy 8l
Mortgage Broker Surrogate Key This stores unique identier for the FCT_LOAN_ACCOUNT_SUMMARY . Broker Skey Hierarchy Broker Skey Hierarchy 8l
Claim Local Currency Code  Refers to the Local currency code f FCT_REG_ACCOUNT_SUMMARY v Currency Code Comparison Hier: Currency Code Comparison HieriB1
Cross Border Claim indicator  Indicates if said claim is cross brod FCT_REG_ACCOUNT_SUMMARY F Cross Border Claim Hierarchy  Cross Border Claim Hierarchy 81
Transaction Account Flag Indicates if said account is conside FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account FlagBl
27 Deposit Call Exercised indicator This Column Stores the Deposit CaFCT_DEPOSITS_BORROWINGS F_ Next Option Flag Deposit Bomow Next Option Flag Depost Borrow 81
28  Troubled Debt Restructure Flag This column indicates i sad loan it FCT_LOAN_ACCOUNT_SUMMARY  Troubled Debt Restructure Flag t Troubled Debt Restructure Flag 61
29 Troubled Debt Restructure Flag This column indicates if sad loan HFCT LOAN_/ ACCOUHT SUMMARY  Troubled Debt Restructure Flag F Troubled Debt Restructure Flag ¢ BI
30 Negative Amortization Flag This column stores if loan has nege FCT_LOAN_ACCOUNT_SUMMARY_ Negatwe Amortization Flag Hiera Negative Amortization Flag Hiera Bl
31 Recourse to General Credit  This stores the recourse to general FCT_REG_ACCOUNT_SUMMARY F Recourse To General Cred Indic Recourse To General Credit Ind B1
32 Contractual Maturity in Days  This column stores the orignal mati FCT_REG_ACCOUNT_SUMMARY N Contractual Maturity Term Hierar Contractual Maturity Term Hieras 1
33 Nettable Pool Sumogate Key  This colum stores the reference taFCT_REG_ACCOUNT_SUMMARY N Nettabie Pool Surrogate Key Hie Nettable Pool Sumogate Key Hie 81
34 Broker Sumogate key This stores unique identier for the FCT_DEPOSITS & N_Br wchy Deposit Hierarchy Deposit Borow Bl
35 Broker Surogate key This stores unique identéier for the FCT_DEPOSITS_BORROWINGS.N_Broker Hisrarchy Deposit Borow: Broker Hierarchy Deposit Borowi B1
3 Deposit Call Exercised Indicator This Column Stores the Deposit CaFCT_DEPOSITS_BORROWINGS F_ Next Option Flag Deposit Borrow Next Option Flag Deposit Boro 81
Deposit Listing Senvice Provider : This Column Stores the un-que lﬂey FL'.T DEPOSI'TS BORROWINGS. N Dgpﬂsn List Skey Hierarchy Deposit List Skey Hierarchy Bl

z;a:a;::::swm~mmuu~-

BN

|
MIER TYPE NIER uuul Dlu PROPERTY MIER l'OTAL _REQD VIEWS_NAME i

FFIEC-031-RC-E
REGuLAR V's FFIEC031-RCP
REGULAR Yes FRY-9C-HC-C
REGULAR Yes FFIEC-041-RC-0
REGULAR Yes FFIEC-031-RC-C
REGULAR Yes FFIEC-031-RCP
REGULAR Yes FFIEC-031-RCR Pant I
REGULAR Yes FRY-15:0
REGULAR Yos FRY-156
REGULAR Yes FFIEC-031-RC-E
REGULAR Yes FFIEC-031-RCE |
REGULAR Yes FFIEC031-RC-C
REGULAR Yes FRY-9C-HC-N
REGULAR Yes FFIEC-041-RC-C
REGULAR Yes FFIEC-031-RC-0
REGULAR Yes FFIEC-041-RC-C
REGULAR Yes FFIEC-041-RC-R Pant I
REGULAR Yes FRY-15-F
REGULAR Yes FFIEC-041-RC-E
REGULAR Yos FRY-9C-HC-C
REGULAR Yes FFIEC-041-RC-P
REGULAR Yes FRY-9C-HC-P
REGULAR Yes FFIEC-009-C, Part Il
REGULAR Yes FFIEC-009-C, Patt Il
REGULAR Yes FRY-9C-HC-E
REGULAR Yes FFIEC-031-RCE
REGULAR Yes FRYTN-BS-A
REGULAR Yes FR2314-BS-A
REGULAR Yes FRY-11-8S-A
REGULAR Yes FFIEC-041-RCV
REGULAR Yes FFIEC-041-RC-R Pant I
REGULAR Yes FRY-9C-HC-M
REGULAR Yes FRY-9C-HC-E
REGULAR Yos FFIEC-031-RC-0
REGULAR Yes FFIEC-041-RCE
REGULAR

Yes FFIEC-041-RCE

Faths | Path1 _patha  $ath3 _ Pathd L Baths L Pathe . pathi . Pathe . pathd - phi0 L ¥3

Select Data Lineage in Template Definition - Choose Object Type to export the lineage

details up to the Staging Columns level.

NOTE: Data Lineage can be selected only if Dependencies is opted.

Financial Services Analytical > Object Administration > Utilities > Metadsta Report

Template Definition
< Back O [ ] @)
Definition Choose Objectty... Filter Objects
Choose Object type
Object Types

Choose  pashboard %

Export Options

Dependencies ()
Data Lineage D

@ Save 7 Retum

Next >

NOTE:

Data Lineage is generated as a separate sheet in the generated Relational report along

with the Dependencies. Select the Lineage sheet to view the Data Lineage (up to

Staging column level).
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2 [HCE FRY-9C-HC-E BHOD6648 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
3 HCE FRY-SC-HC-E BHCB6648 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
4 [HCE FRY-9C-HC-E BHOD6648 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
5 HCE FRY-SC-HC-E BHOD2388 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
6 HCE FRY-9C-HC-E BHOD2604 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
7 HCE FRY-SC-HC-E BHOD238% DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
8 HCE FRY-9C-HC-E BHOD6648 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
9 HCE FRY-SC-HC-E BHCB2389 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
10 HC-E FRY-9C-HC-E BHCB2210 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
11 HC-E FRY-SC-HC-E BHDMA164 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
12 HCE FRY-9C-HC-E BHCB2389 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
13 HC-E FRY-SC-HC-E BHOD238% DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
14 HCE FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
15 HC-E FRY-SC-HC-E BHCB6648 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
16 HC-E FRY-9C-HC-E BHDMA242 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
17 HC-E FRY-SC-HC-E BHFNA245 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
18 HC-E FRY-9C-HC-E BHOD2604 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
19 HC-E FRY-SC-HC-E BHDMA242 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
20 HCE FRY-9C-HC-E BHFNA245 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
21 HCE FRY-SC-HC-E BHCB6648 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
22 HCE FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
23 HCE FRY-SC-HC-E BHDMA242 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
24 HCE FRY-9C-HC-E BHCB2210 DERHCE03 DSRHCEQ3 FCT_LEGAL_ENTITY_DETAILS N_ENTITY_TYPE_SKEY
25 HCE FRY-SC-HC-E BHCB6648 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN REG DEPOSIT TYPE_SK
26 HCE FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
27 HCE FRY-SC-HC-E BHOD238% DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
28 HCE FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
29 HCE FRY-SC-HC-E BHODG643 DERHCE03 DSRHCEQ3 FCT REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
30 HCF FRY-SC-HC-F HHanwi_I DFRHCFO3 NSRHCEN3 FCT RFG_ACCOUNT SUMMAEN RFG DFPOSIT TYPF S|
M A » ¥ paths - Pathl - Path2 - Path3 - Path4 - PathS -~ Path6 - Path Lineage § ¥ 1] m
Reay et [EEETEYe 5]

5. Select Filter Objects to see the selected objects.

Financial Services Analytical Appli e > Object > Utilifies > Metadsata Report
Template Definition
< Back Q O L]
Definition Choose Object type Filter Objects
Filter Objects
Dashboard
@ Save ¥ Retun

Next »
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. . . . . > .
6. Select one Filter Object from the Available Objects and Click to add a Selected Object.

. . . . £ .
Select one Selected Object from the Available Objects and click to remove a Filter
Object.

Dashboard

Available Objects Selected Objects

EFR-2314
EFR-2314s
BiFR 20524
BFR 20520
EFRY-14Q
BFRY-14A
B FFIEC-031
i FR-28268
EFFIEC-041
BFRYTN
EFRY-SLP
B FFIEC101

EFRY-9C

Search...

When the object list is huge, use the Search option as shown above. Type first three letters of the
Filter Object name and the relevant Filter Objects is displayed.

NOTE: You can type the complete Filter Object name to select and add to the Selected Objects.

Dashboard

Available Objects Selected Objects

EFRY7N EFRY-9C
EFRY-GLP 2
EFRY-14M £
EFRY-15
EFRY-20
EFRY-12
EFRY-11
EFRY-11s
B FRY-14Q
EFRY-14A

FRY]| X o OK
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7. Review the Template Definition once and click Save.

. A
Template Definition
< Back @) @) @) [ ] Next >
Definition Choose Object ty. Filter Objects Review
Review
Object Identifier Object Name Object Type
0 1482629198163 FRY-9C Dashboard
< >
Page 1 of1(10f1items)
@ Save | ¥ Retum v
8. Click Return to go to the Summary page.
Finangial Services Analytical Applicat Infrastr re > Object Administration > Utilities > Metadata Repart

¢ Search and Filter G Go < Clear ) Refresh
Template Template

D Name
% Template List (2) [§ Add @ Delete B View £ Em Download

Tempiate ID .4 Tempiate Name Template Description Created Date Created By

223484 NDTest Tester 05-01-2017 OFSAD

[0 223483 sample 04-01-2017 OFSAD
< \ >

9. Select a Template in the Template List in Summary screen and click Generate to export the
desired objects in Excel Sheet format.

NOTE: MDB Publish must be triggered before executing the Generate option.

10. The Report Generation function is an asynchronous action and to check the status of the export
function, use the Refresh option in Summary screen.

Financial Services Analytical Applicationgeed > Object Administration > Utlities > Metadata Report
¥ Search and Filter ©> Go Jclea‘ ) Refresh I
Template ID Template Name

= Template List (2) [§ Add

ale Name Template Description Created Date Created By Status
Tester 05-01-2017 OFSAD Mot Started
04-01-2017 OFSAD Not Started

< I 1>

For Excel Export, the following are the Status values:

e Not Started: The Report Generation is yet to start, but the function has triggered the
action in the background.

e Ongoing: The Report Generation is started and in process.

e Completed: The Report Generation is completed and ready to view or download.
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o Failed/Partially Completed: The Report Generation encountered an issue and the
process is partially completed or failed.

NOTE: The exportlogs are generated and placed in the path
/Context_Name/logs/MDB_XXXX.log.
Log files give the following information:
a) All Paths query
b) Query for each path and if data present for this path
c) Lineage query
d) Status of excel output creation
e) Exceptions and errors, if any

11. Select a Template in the Template List in Summary screen and click Download to save a copy
of the generated Metadata Report Templates excel sheet, after the export status shows as
completed.

Financial Services Analytical licat Infr re » Object Administration > Utilities > Metadata Report
¥ Search and Filter G Go 4> Clear 20 Refresh

Template Template
D Name

v Template List (2) (& Add @ Delete 1 View £ Edit [3] Generat

TemplatelD ¥ Template Name Template Description Created Dale Created By
223484 NDTest Tester 05-01-2017 OFSAD
O 223483 sample 04-01-2017 OFSAD

< I >

User Access:

The following user groups are pre-seeded in the component that helps user to get access to the
Metadata Report Extract screen.

= MDR View Group: Helps users to see Metadata Report Extract with View permissions.
= MDR Owner Group: Helps users to create templates in Metadata Report Extract.

7.3 View Metadata Report Templates

Perform the following steps to view the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click View icon to view the generated Metadata Report Templates excel report (after the export
status shows as completed).

Financial Services Analytical Applicat Infr ture > Object Administration > Utiities > Meladata Report
+ Search and Filter 5’ Go < Clear %) Refresh

Template Template
D Name

= Template List (2).[& Add onem ’ Edit [2€] Generate 7., Download

TemplatelD ¥ Template Name Template Description Created Dale Created By
M 22344 NDTest Tester 05-01-2017 OFSAD
O 223483 sample 04-01-2017 OFSAD
< I >

NOTE: The Metadata Report Templates excel report is opened in view-only mode.
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7.4 Modify/Edit Metadata Report Templates

Perform the following steps to edit or modify the Metadata Report Templates:

1. Select a Template in the Template List in Summary screen.

2. Click Edit icon to modify the generated Metadata Report Templates excel report (after the export

status shows as completed).

Financial Services Analytical licat Infrastructure > Object Administration > Utiities > Metadata Report
+ Search and Filter 5> Go < Clear ) Refresh
Template Template
D Name
» Template List (2).[4 Add @ Delete BVie Generate 2., Download
TemplatelD ¥ Template Name Template Descriplion Created Dale Created By
223484 NDTest Tester 05-01-2017 OFSAD
O 223 sample 04-01-2017 OFSAD
< |
7.5 Delete Metadata Report Templates
Perform the following steps to delete the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.
2. Click Delete icon to delete the Metadata Report Templates.
Financial Services Analytical Applications Infrastructure > Object Administration > Utilties > Metadata Report
* Search and Filter T Go 3 Clear %1 Refresh
Template Template
ID Name
¥ Template List (2) ?Ann@ view £ Edit [3] Generate [0 Download
Template ID v Tempiate Name Template Description Created Date Created By
M 223484 NDTest Tester 05-01-2017 OFSAD
[] 223483 sample 04-01-2017 OFSAD

<|
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8 Report Submission

This chapter provides an understanding of the report submission process. It includes:
e Report Submission: AgileREPORTER to Reqgulator
e Edit Checks/ Validity Check/ Quality Checks
e Report Templates to be used in AgileREPORTER

8.1 Report Submission: AgileREPORTER to Regulator

After OFSAA has prepared and hands off the data as required to Lombard Risk, the subsequent activities
are performed within the AgileREPORTER.

Lombard takes care of the report format as per the regulatory requirement which may be eXtensible
Business Reporting Language (XBRL)/ XML/ Excel / .Data/ XML and so on.

8.2 Edit Checks/ Validity Check/ Quality Checks

The AgileREPORTER carries out the report level / submission check comprising Edit Chceks / Validity
Checks / Quality Checks as provided by the regulator.

Note: Refer to the AgileREPORTER user documentation provided by Lombard Risk, for details of
activities within the AgileREPORTER.

8.3 Report Templates to be used in AgileREPORTER

The report templates to be used in AgileREPORTER are listed as follows:

a. FFIEC 009A -- FFIEC009A V1

b. FFIEC 009 -- FFIEC009_V1

c. FR2052B -- FR2052B_V1

d. FR2314S -- FR2314S_V2

e. FR2314 -- FR2314_V2

f. FRY-11S - FRY11S_V2

g. FRY-11 - FRY11_V2

h. FRY-12 - FRY12_V2

i. FRY-14A OR -- FRY14A0OR_V2

ji. FRY-14ARCI -- FRY14ARCI_V1

k. FRY-14ARCT -- FRY14ARCT V2

. FRY-14A SCENR -- FRY14ASCENR_V1
m. FR Y-14A SUMM -- FRY14ASUMM_V3
n. FRY-15 - FRY15_V3

0. FRY-20 -- FRY20_V2
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—

N < X g <

aa.
bb.
cc.
dd.

ee.

ff.

gg9.
hh.

FR Y-9C

FR Y-9LP

FFIEC 101

FFIEC 031

FFIEC 041

FR Y-7N

FR 2900

FR 2052a

FR 2644

FDIC 8020

FR Y-14Q FVO/HFS
FR Y-14Q CIL

FR Y-14Q CRE

FR Y-14Q Balances
FR Y-14Q PPNR

-- FRY9C_V5

-- FRY9LP_V1

-- FFIEC101_V2

-- FFIEC031_V7

-- FFIEC041_V7

-- FRY7N_V1

-- FR2900_V3

-- Data schedule (No template)
-- FR2644 V2

-- FDIC8020_V1

— FRY14QFVOHFS_V2
- FRY14QCIL_V1

- FRY14QCRE_V1

-- FRY14QBAL_V2

-- FRY14QPPNR_V2

FR Y-14Q Supplemental -- FRY14QSUPMNT_V2

FR Y-14Q Retail

FR Y-14Q Wholesale

FR Y-14M

-- FRY14QRETAIL_V1
-- Data schedule (No template)

-- Data schedule (No template)

8.4 Supported Report Template Version and Activation Date

The AgileREPORTER contains the details of the Report template version and the activation date of the
same. This can be accessed by selecting the Entity setup option in the Settings Menu which enables the
user to Add, Modify, and Delete Entitites. Click on a created Entity to access report templates according
to version and the activation date, and assign the necessary privilages as required.
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Lombard Risk |/Bashboard

Job Manager 2] XBRL Checker  ~ hi rpadmin & 0O

Entity and Return Administration

Refer to the OFS AgileReporter Application User Guide for more details.

Can be used for reporting?

EditEntty | Assign Retums

v| FFIEC031v4

FFIEC041 v1

FFIEC041 v2

Figure 42: AgileREPORTER Entity Setup

Variable

06/14/2016

06/14/2016

FFIECO0SA v2 0611412018 Assign privileges
FFIEC030 v3 06/14/2016 Assign privileges
FFIECO31 vi 0611412016 Assign privileges
FFIEC031 v2 06/14/2016 Assign povileges
FFIEC031v3 06/14/2016 Assign privileges

Assign privileges

FFIEC031 v5 Assign privileges
FFIEC031 v6 06/1412016 Assign privileges

Assian privileges

Assign privileges V'

= =3

ed Entities
Hi Show
5l import $YExpont
Entity Setup Add new entity €
Entiy. US =
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9 Maintenance

This chapter provides an understanding of the maintainence process for the regulatory templates.

Changes to regulatory template is one of the most common and continuous activity. The following steps
help to assess the impact (You can replace the measure, dimension for existing dataware housing
configuration pack using the below process):

1. Choosing different execution as a final. After report verification, if requirement is to change the
execution, then you must visit Marking Run as Final section. After making these changes you
must refresh Derived Entities (Executing Batch to Resave Derived Entities). Then
AgileREPORTER also needs to retrieve returns so that revised data is reflected on
AgileREPORTER.

2. If Executing Batch to Resave Derived Entities is not working, you can look for Batch Operation
Log files. For file path, refer to OFS Analytical Applications Infrstructure Installation Manual in
OHC documentation library and search for ficdb/log.

3. To apply revised patch, refer to the ReadMe file for instructions to be followed.
4. To update revised data warehouse configuration pack, perform the following instructions.

i. Click Settings - Administration - Data Warehouse Integration.

Lombard Risk | Dashboard Job Manager XBRL Checker v hirpadmin | 3k @

Shouw Deleted Retums Delete Return Log K create New 5 mportadjustments ~ ExportTo Regulator Format | USers
Regulator WORKFLOW STATUS

ENTITY RETURNS &  VERSION ¢  REFERENGEDATE ¢  JOBSTATUS UPDATE  APPROVAL EDITIONS  TRANSMISSI{ User Groups

Privilege Groups
US FED Ressive M LVXAE }

us EFIEC031 4 200002013 Q0 ¢y Undate  NO ATTESTATION NEEDED

s S Us EFIEC041 4 300082013 ®0 ) Undate  NO ATTESTATION NEEDED

us ERYOC 2 300002013 ®0 ) Undate  NO ATTESTATION NEEDED

m
1 15 v ]
Al v

Figure 43: Data Warehouse Integration
ii. Click Add to add a contextual button.
iii. Enter details of the contextual button.
Name: It is the text that needs to be displayed in the contextual button.

URL Pattern: Replace <<OFSAA HOST>>, <<OFSAA PORT>> and
<<OFSAA CONTEXT>> with host, port and web context of the environment where OFSAA
is installed. Replace <<OFSAA HOST>> with the name of information domain.

http://[<<OFSAA HOST>>:<<OFSAA PORT>>/<<OFSAA CONTEXT>>/OFSAADrilldow
n/drilldownreport.jsp?cellid=${cellld}&infodom=<<INFODOM>>&leqgalentity=${entityCode}
&run=${run}&date=${referenceDate}
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Example:
http://127.0.0.1:8080/ofsaa/OFSAADrilldown/drilldown.jsp?cellid=${cellld}&infodom=0FS
FSDFINFO&legalentity=${entityCodel&run=${runl&date=${referenceDate}

i. Use http or https depending on the protocol configured for OFSAA.
ii. Pick anicon.

iv. Click Add to save the details.

Lombard Risk | Dashboard ] XBRLChecker ~ hiadmin | %% @

Data Warehouse Integration
OFSAA Contextual Buttons
! N &
EDIT [ ———— " DESCRIPTION IcoN

no Data Lineage 2

URL Pattem:

Builtin Variable:

S{cellidy

S{¥_ordinate} = 5{Z_ordinate}

o

+ 32+ 2
[ roa ] [ canca |

Figure 44: Adding Contextual Button

5. After the data ware configuration pack is updated, Lombard Configuration pack must reflect this.

Note: Refer to AgileREPORTER user documentation for details.

9.1 Data Schedules Views Creation

Source view required for generation of certain data schedule based returns like FR2052A and FR Y-14M
must be created manually after all the dependent derived entities are saved successfully through batch
framework. The views are ported as metadata in a future release after the dependent enhancements to
BMM framework is confirmed. For now, the views must be executed manually by the DBA in the atomic
schema.
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9.1.1 FR 2052A

The command <<Infodom>> USFED_FRY2052A_ RESAVEDE must be executed to save all the derived
entities required by FR 2052A. Post successful execution, the following views must be executed manually
in the atomic schema. The scripts can be found within the Post_Scripts folder in the 8.0.3.1.0 installer
kit.

FR2052A_ASSET_INFLOW.sq|l

FR2052A DEPOSITS OUTFLOW.sql

FR2052A_FX_SUPPLEMENTAL.sql

FR2052A INFO_SUPPLEMENTAL.sq|

FR2052A_ OTHER_INFLOW.sq|

FR2052A_ OTHER_OUTFLOW.sq|

FR2052A_SECURED_INFLOW.sql

FR2052A_UNSECURED_INFLOW.sql

FR2052A_WHOLESALE_OUTFLOW.sql

9.1.2 FRY-14M

The command <<Infodom>>_USFED_FRY14M_RESAVEDE must be executed to save all the derived
entities required by FR Y-14M. Post successful execution, the following views must be executed manually
in the atomic schema. The scripts can be found within the Post_Scripts folder in the 8.0.3.1.0 installer
kit.

FRY14M_Al1_LOAN_LEVEL_DD_V.sql

FRY14M_A2 PORTFOLIO_LEVEL DD_V.sql

FRY14M_B1_HOME_EQUITY_V.sql

FRY14M_B2_HOME_EQUITY_V.sql

FRY14M_C1_LOAN_LEVEL_DD_V.sql

FRY14M_D1_LOAN_LEVEL_V.sql

FRY14M_D2_PORTFOLIO_LEVEL_V.sql
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10 Troubleshooting Guidelines

This section covers troubleshooting guidelines for user of Oracle Financial Services Regulatory Reporting
Integration with AgileREPORTER, hereafter called as Integration.

Integration users provide the data inputs through the OFSDF where data is loaded, processed and results
are made available for reporting purposes. Integration package then makes this data available in required
formats to AgileREPORTER. In AgileREPORTER, this data is then aggregated according to the reporting
requirements and end users view this from AgileREPORTER User Interfaces designed for the Viewing /
Editing of this aggregated data.

This section provides detailed guidelines on how to troubleshoot the data issues tracing back the data
flow from AgileREPORTER.

10.1 Prerequisites

It is assumed that user can login and see following menus and respective reports in AgileREPORTER.

Lombard Risk | Dashboard ]  XBRLChecker ~ hipadmn =3 @

Show Deleted Retums Delete Return Log k3 Create New 4l import adjustments - Export To Regulator Format 1 Expont @) Retrieve Retum

Regulator WORKFLOW STATUS
ENTTY RETURNS ¢  VERSION & REFERENCEDATE ¢  JOBSTATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION ~ MODIFIED & MODIFIED BY &
US FED Reserve LY RALR

12/09/2016 112159 RPADMIN

us FFIEC031 4 3010912013 ®0 () Update  NO ATTESTATION NEEDED

[ 1]

Entity

us = us EFIECO41 4 30/00/2013 Q0 {3 Update NO ATTESTATION NEEDED 14/092016 12:01:45  RPADMIN

[ 1]

us ERYSC 2 30/09/2013 R0 €y Update  NO ATTESTATION NEEDED (- 08/09/2016 11:41:04  RPADMIN

[ 1]

Form

1 15 v
All
Avallable date

All

Figure 45: AgileREPORTER

This means configurations activities for the AgileREPORTER and OFSAA are completed. Set up activities
for Entity is done and reports templates as shown above are available for viewing. Report Names shown
in the figure are for illustration purpose and actual name depends on the integration pack licensed.

10.2 Troubleshooting Use Cases

10.2.1 Unable to Generate Report

If you are unable to generate reports, meaning none of the derived entities referred in the report has rows
for the LE/date combination, then you must refer to Installation Manuals of AgileREPORTER or OFSAA
Integration pack for further instructions and steps to be followed.

If the process mentioned in Installation Manual is correctly followed and still report list is not available
then you are requested to login the bug / service request with Lombard Risk.

10.2.2 Data Unavailable in AgileREPORTER

This is a use case where you are logged in to AgileREPORTER, and selected particular regulatory report
for appropriate entity and As of Date, but unable to generate the report.
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10.2.2.1 Fetching Null or Zero Values

AgileReporter is showing either Zero or Null values. It indicates that Derived Entities has data (however,
all required filer conditions are not matching and resulting in zero value output) or Derived Entiy does not
have data at all.

(o) A Show Import Log ~ Adjustments ~ ExportToFile  ~ Exportto RegulatorFormat g Live Validation | g7 Validate Now ~ Workflow
Editions | 03/24/2016 11:13:27 #17 - ( instances | 1 -0
Show Scale [ %] R
FRY-9C
Page 9 of 65 o
0
Schedule HI-C—Disaggregated Data on the Allowance for Loan and Lease Losses °
Wist
Schedule HI-C is to be completed by holding companies with $1 billion or more in total assets.1 o
(Column A] (Column B (Column C) (Column D} (Coumn E) (Column F) Cover
Recorded Investment | Allowance Balance: | Recorded Invesiment: | Allowance Balance: | Recorded Investment: | Allowance Balance
Individually Evaluated | Individually Evaluated | Collectively Evaluated | Collectively Evaluated Purchased Purchased Seh HI(1014)
for Impaiment for Impairment for Impairment for Impairment Creditimpaired Loans | Creditmpaired Loans
(ASC 310-10-35) (ASC 310-10-35; (ASC 450-20; (ASC 450-20; (ASC 310-30; (ASC 310-30; Szl
Dollar Amounts in Thousandsi BHCK] _ Bil | Mil | Thou [BHCK} _Bil | Mil | Thou |BHCK]__Bil | Mil| Thou |BHCK} _Bil| Mil | Thou {BHCK{ Bil | Mil | Thou {BHCK] _Bil | Mil| Thou SO
1 Real estate loans :
a G loan: wi7ig WOEE w709 ] WURE Wi 1o WIDE Wi i1 g IR 17772 UL V713 NULE 1.2 Sch HI (4 o d)
b. Commercial
real estate loans W74 WOIE 1715 WL w716 WD W77 ] HIDEE 777 ] UL V7320 WULE 1b. Sch H-A
c. Residential _
real estate loans.... WOLE w722 BUEL 77733 WL w724 WDEE 725 NULL WULE 1.c SN )
2 Commercial loans2 NULE 728 WNULL M729 MULE m730 NULE 731 NULL 1 NULL 2 Sch HHB (2 0f2)
3. Credit cards. WOLE w734 WUEE 7735 WOLE w736 UL w737 NUEE NUIE 3
4. Other consumer loans NULE 1740 NULE w731 NULE w743 NULL 723 NULL NULL 4 SchHLC
5. Unallocated. if any 745 4,500 5
& Total Notes to Income Stmt (1 of3)
(sum of items 1.a through 5)._.. | N745 WOLE w747} WL vi7as WULE 17497 0 m750] WL w751 WL ©
Notes to Income Stmt (2 of 3
S Notes to Income Stmt (3 of 3)
1.The asset size testis generally based on the total assets reported as of June 30, 2014,
2. Include all loans and leases not reported as real estate loans, credit cards, o oiher consumer loans SchHC (1073)
Sch HC (2 of 3
[E A showmporiog ~ Adjustments ~ ExportToFile  ~ ExporttoRegulatorFormat g3 Live Validation g7 Validate Now ~ Workiow
Editions  03/24/2016 11:13:27 #17 ~ Instances 1 - o
ShiowSCale a Sch HC-Q (2 0f2
Page 630165 Sch HC-R (1 0f 14)

Sch HCR (2 0f 14)

Schedule HC-V—Variable Interest Entities Sch HC-R (3 0f 14)
{Column A] (Column 8 {Calumn C) SChHCR (4 07 14)
Securitization Vehicles ABGP Conduits Other VIEs
Dollar Amounts in Thousands| BHCK| Bl Wil I Thou _|BHCK| _BIl Wil Thou _|BACK] _ BIll Wil Thou SECERE T
1.Assets of consolidated variable interest entties Sch HCR (6 o 14)
(VIES) that can be used only to sefile obligations of
Sch HCR (7 of 14)
consolidated VIES:
a. Cash and balances due from depository institutions. ... J981 0] Jg82 0] 4983 0| 1a Sch HC R (8 07 14)
b, Held-to-maturity securities J984 0] Joss 0] Joss 0] 1.
Sch HCR (9 of 14)
3 fabl le securiie J0a7 0] Joss 0] Jozg 0] 1c
d. Securities purchased under to resell 4990 0] Jg91 0] 4992 0| 14 Sch HC R (10 of 14)
e Loans and leases held for sale 4993 0] Jgog 0] Jyggs 0] 1e .
Sch HCR (11 of 14;
1 Loans and leases, net of uneamed income 1005 0] Joo7 0] Joos 0] 1r !
0. Less: Allowance for loan and lease losses 4999 0] koot 0] koo2 0| 1g Sch HC R (12 of 14)
h. Trading assets (other than K003 0] K004 0] koos 0] 1h
SchHCR (13 0f 14
i Derivative rading assets...........ocoovveeerroioceroo KOOB 0] koo7 0] koos 0f 1
i Otherreal estate owned K009 200 ko10 0| ko11 0l 1) Sch HC R (14 of 14)
k. Ofher assets K012 0] k13 0] k14 0] 1k
Sch HC-S (1 of3
2. Liabilities of conselidated VIEs for which creditors do
nothave recourse to the general credit of he Sch HC-S (2 0f3)
reporting holding company
poring g come Sch HC-S (3 0f3)
a. Securities sold under agreements to repurchase.........| K015 \ 0 \ Kuwa| o \ KUﬁl 0] 2a
b. Derivative trading liabiliies K018 | 0] ko1a | 0] kozo | 0| 2n SchHCV
¢ Commercial paper K021 | 0 k22 | 0] k23 | 0] 2c
Notes to the Bal Sheet(1 072)
d. Other borrowed money
(exclude commercial paper) K024 | 0] ko25 | 0] koz6 | 0| 24 Notes to he Bal Sheet(2 of2)
e. Other liabilitie: w027 | 0] kozs | 0] koza | 0] ze . 5

Figure 47: Fetching Zero Values

You must validate as:
1. Derived Entity has data:
a. Execute the Derived Entity / Materialized views to check if Derived Entity has data or not.
b. If Derived Entity / materialized view has data but not showing in AgileREPORTER, you
must log a Bug / Service Request with Lombard Risk.
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2. Derived Entity does not have data:

a. Execute the Derived Entity / Materialized views to check if Derived Entity has data or not.

b. If Derived Entity does not have data, then check the Business Metadata excel for a given
schedule.

c. Check Worksheet titled ‘Derived Entity’ in Business Metadata excel. Get all the derived
entities for a given schedule.

d. Get dataset for each derived entity.

e. Execute datasets in OFSAA FSDF Atomic Schema to check if data is available for a
given dataset joins.

f. If data is available in dataset queries, you must log a Bug / Service Request with
AgileREPORTER.

g. If datais not available in dataset, then check if selection of Entity, Available Date (as of
date) is appropriate and required executions are available. If Entity, As of Date and Run
executions are correct and still data is not available, then you must log a Bug / Service

Request with Oracle Support.
10.2.3 Data Available in AgileREPORTER but Not as Expected

This use case where you are able to refer data for a required cell of a schedule in AgileREPORTER,;
however, value shown differs from expected value.

Let us take following example to illustrate the steps to be followed. This refers to Schedule HC-M from FR
Y-9C report from US FED. Particular cell referred here is BHDMK169 —

6.a. Loans and leases (included in Schedule HC, items 4.a and 4.b):
(1) Loans secured by real estate in domestic offices:
(a) Construction, land development, and other land loans:

(1) 1-4 family residential construction loans

A showImport Log ~ Adjustments ~ ExportTofile  + ExporttoRegulatorFormat Y Live Validation &Y Validate Now ~ Workiow
Editions 0372412016 11:13:27 #17 ~ | (Dl rcances 1 - o
Show Scale
a HCE&F
Page 34 of 65 SchHC-G&H
Schedule HC-M—Memoranda
Sch HCA
Dollar Amounts in Thousands/BHCK] __ Bil | Wil Thou
1.Total number of holding company comman shares Number (Unrounded SenHeK
3459 0.0000 1 Seh HC-L (1 0f4)
2.Debt maturing in one year of less (included in Schedule HC, items 16 and 19.a) thatis
issued to unrelated third parties by bank i 6555 | 0] 2 SRl L@
3.Debt maturing in more than one year (included in Schedule HE, items 16 and 19.a) that s SEEL@ )
issued to unrelated third parties by bank 5556 | 0] 3
4.Other assets acquired in satisfaction of debis previously contracted 0567 | 100] 4 Seh HC-L (4 of 4
5. Securit hased und s to resell offset tsecurities sold und
5.Securities purchased under agreements to resell offset against securities sold under i TG
agreements to repurchase on Schedule HG 288 0] s
6. Assets covered by 10ss-sharing agreements with the FDIC Sen HC-M (2 of4)
a. Loans and leases fincluded in Schedule HC, items 4.3 and 4.b
(1) Loans secured by real estate in domestic offices: SCIECMELE
(a) Construction, land development, and other land loans BHO] Sen HC-M (4 0f )
(1) 1=4 family residential construction loans 159][256,608,000,000.000| 6.a.(1)(a)(1
(2) Cther construction loans and all land development and other land loans K170 |2.774.502.720,000.00 6.2.(1)(a)(2) Seh HC-N (10f5)
(b} Secured by farmiand K171 [256,608,000,000,000| &a(1)b Sch HC-N (2 of 5}
(c) Secured by 1-4 family residential properties
(1) Revolving, open-end loans secured by 1-4 family residential properties and Sen HC-N (3 0f5)
extended under lines of credit m?z\ 86.536,000,000,000 | &.a.(1)cHt S
ch HC-N (4 0f5)
(2) Closed-end loans secured by 1-4 family residential properies:
(a) Secured by firstliens K173 ] 18,817,920,000,000| 6.a.(1)cH2)a Sch HC-N (5 of 5)
(b) Secured by junior liens mm\ 18.817,920,000,000 |  6.a.(1)(cH2) b
(d) Secured by multifamily (5 or more) residential properies............... e K176 | 0] Gastid TR
(&) Secured by nonfarm nonresidential properties Seh HC-0 (1072)
(1) Loans secured by owner-occupied nonfarm nonresidential properties K178 | 0] saren
(2) Loans secured by other nonfarm nenresidential properties. SR o] KITT ‘256 608,000,000,000| #.a.(1)(e)(2) Sch HC-Q (2 0f2)

Figure 48: Schedule HC-M from FR Y-9C Report
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You can drill down for each cell to check details of data as what is included in aggregation. To drill down,
click the value of particular cell and it is shown highlighted. It shows OFSAA data lineage icon on clicking

as shown in Figure 49.

A Show Import Log

~ Adjustments

~ ExportToFile  + Exportto Regulator Format

OFSAA

&) Live Validation

Show Scale

[256608000000000)

&) Validate Now

direct cell edit

B

~ Workflow

Editions  03/24/2016 11:1327 #17

S Instances 1 -

HC-E&F

Sch HC-G & H
Seh HC-

Seh HCK

Sch HC-L (1 of 4
Sch HC-L (2 of 4.
Seh HG-L (3 074)

Sch HC-L (4 of 4

SchHCM (1 of 4)

Seh HC-M (2 of 4)
Sen HC-M (3 of 4)
Sch HC-M (4 of 4)
Seh HG-N (1 0f5)
Seh HC-N (2 0f 5)
Sch HC-N (3 of 5)
Seh HG-N (4 0f 5)
Sch HG-N (5 01 5)
Sch HC-P

Sch HG-Q (1 0f2)

Seh HC-Q (2 0f2)

Figure 49: Data Lineage

Make sure that you are logged in to OFSAA infrastructure before clicking Data Lineage icon.
If you are not already logged in, clicking here opens the OFSAA infrastructure login window. Log
in using appropriate credentials and come back to Report Portal and click the same Data
Lineage icon again.
If you are already logged in to OFSAA Infrastructure, the Data Lineage first page opens as shown
in Figure 50.

Data Lineage

Run Execution 14 7 Date 30 Sep 2013
Legal Enty uUs Reference Identiier BHDMK169

» Derived Entity : DERHCMO1 =

Holding Type C | Bands hierarchy | mnstrument Requlatory Product Classification Hierarchy | Risk Factor type code Hierarchy | Derivative Type HIREGH6 | Geography - Branch Country | Hierarch
HTM 1045 IRSPOTRER 1-4FANCONLOAN R E CORMNC  US [

HTM 1043 IRSPOTRREP 1-4FANCONLOAN R sPOT CORNG  US N

HTM 1043 IRSPOTRREP 1-4FANCONLOAN R sPOT CORNG  US N

HTM 1205 EQRCPS 1-4FANCONLOAN EY sPOT INSCOV us N

HTM 1045 CoLmes 1-4FANCONLOAN R sPOT CORNG  US N

HTM 1205 CMSPOTCIU 1-4FANCONLOAN o e INSCOV us N

HTM 1205 EQRCPS 1-4FANCONLOAN £0 sPoT INSCOV us N

HTM 1045 IRSPOTREP 1-4FANCONLOAN R sPOT CORNG  US N

HTM 1048 CoLMES 1-4FANCONLOAN R sPOT CORNG  US N

HTM 1205 CoLmes 1-4FANCONLOAN R sPoT INSCOV us N

Figure 50: AgileREPORTER

Top block of this screen shows following information which helps to connect the AgileREPORTER
aggregated data to OFSAA references.
Run Execution ID: This refers to OFSAA Execution ID chosen for a given report.
Date: This refers to AS OF DATE selected for a given report.
Legal Entity: This refers to the OFSAA Legal Entity for whom the report is generated.
Reference Identifier: This is the cell reference for which data drill down / lineage is being
checked.

1.

2.
3.
4.
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Second block displays all hierarchies with values used in a given Derived Entity and measures
aggregated for a given combination of a hierarchy values.

To refer the measure values, scroll rightwards using horizontal scroll bar at bottom of second
block. On extreme right, measures are displayed as shown in Figure 51:

Data Lineage

Run Execution Id 7 Date 30 Sep 2013

Legal Entty us Reference dentiier BHDMK 159

» Derived Entity : DERHCMO1  (30) ] 5

m failed insured dep insts - HCM | Construction loan type - HCM | Customer Country Hierarchy | Aareement Sponsorer Code Hierarchy | Entity Tupe Hierarch Accrual Status Code Flag Hierarchy | Req Prod Type Hierarchy | Amortized Cost - Common Account Summary

usA FDIC ACCRU 8.553,600.000.000.00
usa FDIC ACCRU 12.830.400,000,000.00

usa FDIC ACCRU 12.830.400,000,000.00
usA FDIC ACCRU 8.553,600.000.000.00
usa FDIC ACCRU 8,553,600,000,000.00
usa FDIC ACCRU 4.276,800,000,000.00
usA FDIC ACCRU 8.553,600.000.000.00
usa FDIC ACCRU 8,553,600,000,000.00
usa FDIC ACCRU 8,553,600,000,000.00
usA FDIC ACCRU 8.553,600.000.000.00

Figure 51: Measure Values

Only measure values are hyperlinked indicating that they can be drilled down further. On clicking
the amount, second level drill down show the lowest granularity data available for a given cell
reference.

10.2.3.1 Using Drill Down with Data Lineage View

Data Analysts/You can then compare these accounts and their respective monetary amounts with
expected values. One can check the following:

1. All required accounts are shown in aggregation

2. Unwanted accounts are not included in aggregation

3. Measures / Monetary amounts at account granularity are as expected.

Any deviation from expectations can be then checked back for:

1. If measure is stage pass through, then validate using T2T to verify if stage data is as expected or
must be corrected.

2. If measure is processed, then validate using T2T to verify processing measure is correctly moved
to result area.

3. If reclassified hierarchies are showing unexpected values, check Rules and source hierarchies of
rules. This use case needs close verification to ensure that all source hierarchies have required
values or Rule sequence which can lead to overwriting the values.

4. |If all the source data is as expected and result area is now showing unexpected output, then log a
Bug / Service Request with Oracle Support.
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10.2.3.2 Data Lineage View is Unavailable

If the second block does not show any data, then data analysts/you are advised to refer to the data set
worksheet of Business Metadata.

Data Lineage

Run Execuiion 16 1 Date 308ep 2013
Legal Entty us Reference Identiier BHCKJ456
» Derived Entity : DE - Derivatives and Off-Bal. heet Items HC-L1 (0) i)
|| party Tvpe Hierarcny | Hierarchy | Requlatory Pr lassification Hierarchy | Product Type Hierarchy | Entity Type Hierarchy | Req Prod Type Hierarchy | Undrawn Amt - Common Account Summary Hl

Figure 52: Data Lineage Unavailable

There can be few reasons why second block does not show the data:

1.

Internet connection is timed out or broken down - in this case clicking Data Lineage on
AgileREPORTER results in a blank second block. To rectify this, re-login to OFSAA infrastructure
and AgileREPORTER.

Data Lineage view works after Metadata is published using OFSAA Infrastructure. To validate if
Metadata is properly published or not.

If Metadata is properly published and second block still does not show the data, then start with
Derived Entity code shown at the beginning of second block. This Derived Entity code is available
even if data is not available.

Using this Derived Entity code data analysts are advised to refer to OFSAA Business metadata
with worksheet name as ‘Derived Entity’. Sample Business Metadata excel is shown in Figure 53:

A 8 G 0 E F G H 4 L3 |
1 Derived Entiy Codd Short Description Long Description Source Type | Aggregate [terlalised V| Dataset Code Selected Metadata [Selected Metadata Codel
148 Band Type Hierarchy HIREG116
149 Instrument type Hierarchy HIREG048
150 Regulatory Product Classification Hierarchy |HIREGOSS
151 Party Type Hierarchy HIREG07
152 Entity Type Hierarchy HIRHCPOL
153 Product Type Hierarchy HIRHCKOL
154 Undrawn Amt - Common SRACLOL
155 Calendar Date HIREGOOL
158 IDE - Derivatives and Off-Balance-Sheet |DE - Derivatives and Off-Balance-Sheet DS - Derivatives and Off-Balance-Sheet Items - HC- |Run Description HIREG00Z
157 |DERHCLOL irems HC-LL items HC-LL Damsset [N v DsRHOLL  |u Org Structure Entity Code HIREGODS
s Reg Instrument Clzssification Hierarchy __|HIREGD1L
159 Instrument type Hierarchy HIREG0E
160 Holding Type Code Hierarchy HIREGD12
161 Calendar Date HIREGOOL
162 Run Description [rirEG002
163 Org Structure Entity Code HIREG00 |
164 Buy or Sell Indicator Hierarchy HIRHCDD1
165 Fair value - IFRS Account Summary MSRHCNOS
16| DERHCLO2 DE - Derivatives and Off-Balance-sheet I|DE - Derivatives and Off-alance-shest o v DSRHCLO2 __|DS- Derivatives and Off-Balance-Sheet items - HC-L|Notional Amount RCY [msresoo1
167 Calendar Date HIREGOOL
168 Fair value RCY - Mitigants SRHOL02
162 DERHCLOS DE - Account to Mitigant Map DE - Account to Witigant Map Dataset [N v DSRHCLOS |DS - Account to Mitig [Account Skey - Account to Mitig HIRHCLO2
Calendar Date [rireGo0L
171 Fair value RCY - Mitigants MSRHCLO2
172 unt Skey - Attount to Mitig: HIRHCL02
173 DERHCLOS DE - Account to Mitigant Map with Mitiga DE - Account to Mitigant Map with Mitigant Ty Dataset [N v DSRHCLO4 |DS- Account to Mitig with Mitigant Type _[Witigant Type Hierarchy HIREGO<9
174 Net CE Amount [msrrcLos
175 Calendar Date HIREGOOL
176 Run Description HIREG002
177 Org stucwre Entity Cade HIREGOD
178 | DERHCLOT DE - Derivatives and Off-Balance-sheet I|DE - Derivatives and Off-alance-shest o v DSRHCLO7 __|DS - Derivatives and Off-Balance-Sheet items - HC-L Standard Party Type Hierarchy [rireG103
179 OE - Fair value RCY - Miigants [MSRHELID
180 Reg Instrument Ciassification Hierarchy | HIREGD1L ¥
4 4 » M| Hierarchies-BI ~ Base Measures Datasets , Business Process | Derived Entity  Reports ¥J | - »

Figure 53: Business Metadata
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5. By referring to Business Metadata, you can get complete information on Derived Entity such as
dataset, Fact tables, measusres, hierarchies defined under particular Derived Entity.

ER =N (s
D1232 - | fet_common_account_summary =B
A B C D -
1 Dataset Cote From Clause. ansi soin B
232 FCT_COMMON_ACCOUNT_SUMMARY [fct_common_account_summary
1233 [fct_reg_account_summary inner join fct_feg_account_summary on fcl_feg_account_summary.n_mis_date_skey=
1234 dim_dates, fct_common_account_summary.n_mis_date_skey
235 dim_run and fat_rez_account_sUmmMary.n_acct_skey = fet_common_account_summary.n_acct_skey
1236 dim_org_stucture inner join dim_reg_product_classification on dim_reg. product_classification.n_reg_prod_classification_skey=
237 \concion |05 - Derivatives and Oft-Salance Sheet tems - w1 | M-REG_PRODUCT CLASSIFICATION fct_reg_account_summary.n_reg_prod_classification_skey
1238 dim_entity type inner join fct_legal_entity_details on fct_legal_entity_details.n_entity_skey =
1239 FCT_LEGAL_ENTITY_DETAILS fct_common_account_summary.n_entity_skey
240 dim_reg_product type AND fet_legal_entity_details.n_mis_date_skey = fct_common_acount_summary.n_mis_date_skey
241 Dim_instrument_type inner join dim_entity_type on dim_entity_type.n_entity_type_skey = fct_legal_entity_details.n_entity_type_skey
242 dim_product_type innerjoin dim_instrument_type on dim_instrument_type.n_instr_type_skey=
243 dim_pary_type fet_rez account summary.n_instr type ske

Figure 54: Business Metadata

The Dataset ANSI Joins provide valuable information on how various entities are joined/linked together.
By executing these Joins, you can confirm if data is available for given filters and conditions. If data is
fetched using Dataset Joins and Data Lineage does not show data, you must log a Bug / Service Request
with Oracle Support.
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